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          O Level: M4-R5.1 
 

Internet of Things and its Applications 

Module Unit 
Written Marks 

(Max.) 
1. Introduction to IoT - Applications/Devices, 
Protocols and Communication Model 

10 

2. Things and Connections 10 
3. Sensors, Actuators and Microcontrollers 15 
4. Building IoT Applications 40 
5. Security and Future of IoT Ecosystem 5 
6. Soft skills-Personality Development 20 

                       CHAPTER 1 



DIGITAL RK COMPUTER ACADEMY 
website- www.drkca.in, drkca.com 

Address-Moazzampur Karari, Kaushambi 
Mobile no.-708076746, 6387249072,9026672774                                

Introduction - Overview of Internet of Things (IoT) 

पǐरचय- इंटरनेट ऑफ िथंÊस का अवलोकन(IoT) 

Internet of things is a platform where regular devices are 
connected to the internet, so they can interact, collaborate and 
exchange data with each other. The Internet of Things (IoT) is 
here to change the world we know. Smart cars, smart homes, 
smart cities, everything around us can be turned into a smart 
device with the help of the Internet of Things. IoT sure does bring 
the 'cool' factor to technology. While IoT is poised to bring the 
next big boom in the job market, lack of skill is facing the biggest 
barrier for companies looking to adopt this technology.  

इंटरनेट ऑफ िथंÊस एक  ऐसाÜलेट फॉम[ है जहाँ िनयिमत उपकरण 

इंटरनेट स े जुड़े होते हɇ, इसिलए वे एक-दसूरे के साथ डेटा काइंटरैÈट, 

कोलाबोरेट और आदान-Ĥदान कर सकते हɇ।इंटरने ऑफ िथंÊस(IoT) 

यहां दिुनया मɅ बदलाव  को जानने के िलए है। èमाट[ कार, èमाट[ होम, 

èमाट[ िसटȣज, हमारे आस पास कȧ Ĥ×येक वèतु को इंटरनेट ऑफ 
िथंÊस कȧ मदद से èमाट[ Ǒडवाइस मɅ बदला जा सकता है । IoT  

यकȧनन Ĥौƭोिगकȧ के िलए ' शांत  ' का रक है । जब IoT नौकरȣ 
बाजार मɅ बड़े बदलाव  लाने कȧ ओj अĒसर है, कौशल  कȧ कमी इस 
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तकनीक को अपनाने कȧ इÍछुक कंपिनयɉ के िलए सब से बड़ȣ बाधा 
है। 
History of IoT (IoT का इितहास) :- 
 

1. 1970: The actual idea of connected devices was 
proposed. 

 

जुड़े उपकरणɉ का वाèतǒवक ǒवचार Ĥèताǒवत Ǒकया 
गया था। 
 

2. 1990: John Romkey created a toaster which could 
be turned on/off over the Internet. 

 

जॉन रोमकȧ ने एक टोèटर बनाया ǔजसे इंटरनेट पर 
चाल/ूबंद Ǒकया जा सकता था। 
 

3. 1995: Siemens introduced the first cellular module 
built for M2M (Machine to Machine). 

 

सीमɅस ने M2M (मशीन से मशीन) के िलए िनिम[त 
पहला सेलुलर मॉÔयूल Ĥèतुत Ǒकया। 
 

4. 1999: The term "Internet of Things" was used by 
Kevin Ashton during his work at P&G which 
became widely accepted. 
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"इंटरनेट ऑफ िथंÊस” शÞद का योग केǒवन एæटन 
Ʈारा P & G मɅ अपने काम के दौरान Ǒकया गया था 
ǔजसे åयापक Ǿप से èवीकार Ǒकया गया। 

 
5. 2004: The term was mentioned in famous 

publications like the Guardian, Boston Globe, and 
Scientific American. 

 

गाǑड[यन, बोèटन Êलोब और साइंǑटǑफक अमेǐरकन 
जैसे Ĥिसƨ Ĥकाशनɉ मɅ इस शÞद का  उãलेख Ǒकया 
गया था। 

 

6. 2005: UN's International Telecommunications 
Union (ITU) published its first report on this topic. 

संयुƠ राƶ के अंतरा[ƶीय दरू संचार संघ(ITU) ने इस 

ǒवषय पर अपनी पहली ǐरपोट[ Ĥकािशत  कȧ। 
 

7. 2008: The Internet of Things was born. 
 

इंटरनेट ऑफ िथंÊस का जÛम  हुआ। 
 

8. 2011: Gartner, the market research company, 
includes "The Internet of Things" technology in 
their research. 
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माकȶ ट ǐरसच[ कंपनी   गाट[नर ने अपने शोध मɅ "इंटरनेट 

ऑफ िथंÊस" तकनीक को शािमल Ǒकया। 

 
(Advantages of IOT) 

आईओटȣकेलाभ:- 
a) Communication - 

कàयूिनकेशन 
IoT encourages the communication between devices, 
also famously known as Machine-to-Machine (M2M) 
communication. Because of this, the physical devices 
are able to stay connected and hence the total 
transparency is available with lesser inefficiencies and 
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greater quality.                                                        

 
IoT उपकरणɉ के बीच संचार को Ĥो×साǑहत करता है, ǔजसे मशीन-टू-
मशीन(एम2 एम) संचार के Ǿप मɅ भी जाना जाता है।इस वजह से, 
भौितक उपकरण जुड़े  हने मɅ स¢म हɇ और इसिलए कुल पारदिश[ता 
कम अ¢मताओ ं  और  अिधक  गुणवƣा के साथ उपलÞध  है। 

b) Access information – एÈसेस 

इनफामȶशन 
We can easily access any information sitting in any part 
of the globe in real time. This makes it very convenient 
for people to go about their work, even if they are not 
physically present. 
हम वाèतǒवक समय मɅ दिुनया के Ǒकसी भी Ǒहèसे मɅ बैठे Ǒकसी भी 
जानकारȣ  को आसानी से एÈसेस कर सकते हɇ।यह लोगɉ को अपने 
काम के बारे मɅ ने के िलए बहुत सुǒवधा जनक  बनाता है, भल ेहȣ वे 
‘kरȣǐरक Ǿप से मौजूद न हɉ। 
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c) Automation and Control – ऑटोमेशन 
और कÛĚोल 
With wireless infrastructure connecting and controlling 
digital objects digitally and centrally, there is a large 
amount of automation and control in its functioning. 
Without human intervention, machines are able to 
communicate with each other to deliver fast and timely 
output. 
वायरलेस इंĥाèĚÈचर के साथ Ǒडǔजटल वèतुओं को Ǒडǔजटल और  

सÛेĚली Ǿप से कनेÈट और िनयंǒğत करने के कारण, इसके काम 
काज मɅ बड़ȣ माğा मɅèवचालन(ऑटोमेशन) और िनयंğण होता है। 
मानव हèत¢ेप के ǒबना, मशीनɅ तेजी से और समय पर  आउटपुट देने 
के िलए एक दसूरे के साथ सवंाद करने मɅ  स¢म हɇ। 

d) Efficient and Saves Time – कुशल और समय कȧ 
बचत 
The machine-to-machine interaction provides better 
efficiency, hence; accurate results can be obtained fast. 
This results in saving valuable time. Instead of 
repeating the same tasks every day, it enables people to 
do other creative jobs. 
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मशीन-टू-मशीन इंटरैÈशन  बेहतर द¢ता Ĥदान करता है,  इसिलये 
सटȣक पǐरणाम   से ƯǑकए जा सकते हɇ।इससे  बहुमूãय समय कȧ बचत 
होती  है।हर Ǒदन समान कायɟ को दोहराने के बजाय, यह लोगɉ  को 
अÛय रचना×मक काय[ करने मɅ स¢म बनाता  है। 

e) Better Health Care and Management 

– बेहतर èवाèØय देखभाल औ   Ĥबंधन 

 
The patient monitoring can be done on a real-time basis 
without a doctor's visit. It enables them to make 
decisions as well as evidence-based treatment. 
रोगी कȧ िनगरानी ǒबना डॉÈटर के दौरे के वाèतǒवक समय के आधार पर कȧ 
जा सकती है।यह उÛहɅ िनण[य लेने के साथ-साथ साêय-आधाǐरत Ĥèताव 
उपचार के िलए  स¢म  बनाता  है। 

f) Efficient usage of electricity – ǒबजली का कुशल उपयोग 
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You can use electricity effectively because the devices 
are directly connected and communicate with controller 
devices such as mobile phones. So you don't have to 
worry about unnecessary use of electricity and 
appliances. 
आप ǒबजली का Ĥभावी ढंग स ेउपयोग कर सकते हɇ ÈयɉǑक Ǒडवाइस सीधे 
जुडȣ हुई हɇ और मोबाइल फोन जसैे िनयंğक  Ǒडवाइस  के  साथ  संवाद  करते 
हɇ।इसिलए आपको ǒबजली और उपकरणɉ के आवæयक उपयोग  के  बारे 
मɅ िचंता करने कȧ जǾरत नहȣं है। 

g) Security - सुर¢ा 
You can control your home through mobile phones. It 
provides personal protection. 
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आप मोबाइल फोन के माÚयम से अपने घर को िनयǒंğत  कर  

सकते हɇ। यह åयǒƠगत सुर¢ा Ĥदान करता है। 
Disadvantages of IOT आईओटȣकेनुकसान:- 

a) Compatibility - कàपैǑटǒबिलटȣ- Currently, there is no 
international standard of compatibility for the tagging 
and monitoring equipment. 
वत[मान मɅ, टैिगंग और िनगरानी उपकरण के िलए अनुकूलता 
(कàपैǑटबãटȣ) का कोई अंतरराƶीय èटɇडड[ नहȣं  है।  

(b)The system offers little control which leads to 
various kinds of network attacks like hackers could 
break into the network and steal the information. So, 
data encryption is very much necessary for maintaining 
the privacy of the data shared over the internet. 
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चूǑंक IoT िसèटम आपस  मɅ  जुड़े  हुए  हɇ और नेटवक[  पर संचार करते 
हɇ। िसèटम थोड़ा िनयंğण Ĥदान करता है जो  ǒविभÛन Ĥकार के 
नेटवक[  हमलɉ  का नेत×ृव करता है जैसे है कस[ नेटवक[  को तोड़ सकते 
हɇ और जानकारȣ चुरा सकते  हɇ।इसिलए, इंटरनेट पर साझा Ǒकए गए 
डेटा कȧ गोपनीयता बनाए रखने के िलए डेटा एǔÛĐÜशन बहुत 
आवæयक है। 
c) Privacy wişdent - Even without the active 
participation of the user, the IoT system provides 
substantial personal data in maximum detail. 
उपयोग कता[ पर सǑĐय भागीदारȣ के ǒबना भी, IoT िसèटम अिधकतम 
ǒवèतार मɅ पया[Ư  åयǒƠगत डेटा Ĥदान करता है। 

d)Unemployment-बेरोजगारȣ: With every task being 
automated will lead to a lower need for manpower and 
eventually loss of jobs. This will have a direct impact 
on employment. 
Ĥ×येक काय[ के èवतः होने सेजन शǒƠ कȧ कम आवæयकता और 
ततः नौकǐरयɉ का नुकसान होगा। इसका सीधा अस रोजगार पर 
पड़ेगा। 

सरल संèकरण (Simplified Version) 

यह PDF O Level कोस[ M4-R5.1 के बारे मɅ है, जो "Internet of Things 

(IoT) और उसके उपयोग" पर है। मɇने इसे आसान भाषा मɅ समझाया 
है, लǑेकन मलू अथ[ वहȣ रखा है। मूल PDF मɅ अंĒेजी और Ǒहंदȣ दोनɉ 
हɇ, इसिलए मɇ दोनɉ को सरल बनाकर दे रहा हंू। 
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मुÉय भाग (Syllabus) 

 

 

 

 

 

 

अÚयाय 1: IoT का पǐरचय - उपयोग/Ǒडवाइस, 

Ĥोटोकॉल और कàयुिनकेशन मॉडल 

IoT Èया है?  

(Introduction) 

IoT एक ऐसा िसèटम है जहां सामाÛय चीजɅ (जैसे Ǒĥज, कार) 
इंटरनेट स ेजुड़ती हɇ। व ेएक-दसूरे से बात कर सकती हɇ, डेटा शेयर 
कर सकती हɇ। इससे èमाट[ घर, èमाट[ शहर बनते हɇ। IoT तकनीक को 
'कूल' बनाती है, लǑेकन इसमɅ नौकǐरयां बढ़Ʌगी पर ǔèकãस कȧ कमी है। 

Ǒहंदȣ मɅ सरल: IoT एक Üलेटफॉम[ है जहां आम Ǒडवाइस इंटरनेट से 
जुड़ती हɇ। वे डेटा शेयर करती हɇ। इससे दिुनया बदल रहȣ है - èमाट[ 
कार, घर, शहर। IoT तकनीक को मजेदार बनाती है, लǑेकन कंपिनयɉ 
को ǔèकãड लोग नहȣं िमल रहे। 
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IoT का इितहास (History) 
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IoT के फायदे (Advantages)  

a) कàयुिनकेशन: Ǒडवाइस एक-दसूरे से बात करती हɇ (M2M), इससे 
पारदिश[ता बढ़ती है, गलितयां कम होती हɇ। 

b) जानकारȣ एÈसेस: दिुनया के Ǒकसी कोने से ǐरयल-टाइम डेटा 
िमलता है, भल ेआप वहां न हɉ। 

c) ऑटोमेशन: वायरलेस से चीजɅ खुद चलती हɇ, इंसान कȧ जǾरत 
कम, तेज काम होता है। 

 d) समय बचत: मशीनɅ कुशल काम करती हɇ, लोग ǑĐएǑटव काम कर 
सकते हɇ। 

 e) èवाèØय: मरȣज कȧ िनगरानी ǒबना डॉÈटर के ǒवǔजट के, साêय-
आधाǐरत इलाज। 
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 f) ǒबजली बचत: Ǒडवाइस मोबाइल से जुड़ȣ, फालतू इèतेमाल नहȣं 
होता। g) सुर¢ा: घर को मोबाइल से कंĚोल करो, पस[नल ĤोटेÈशन 
िमलती है। 

 

IoT के नुकसान (Disadvantages) 

a) कàपैǑटǒबिलटȣ: टैिगंग और मॉिनटǐरंग के िलए कोई अंतरराƶीय 
èटɇडड[ नहȣं। 

 b) सुर¢ा: नेटवक[  से जुड़े होने से हैकस[ चोरȣ कर सकते हɇ, डेटा 
एǔÛĐÜशन जǾरȣ। 

 c) Ĥाइवेसी: यूजर कȧ भागीदारȣ ǒबना भी पस[नल डेटा Ïयादा शेयर 
होता है। 

 d) बेरोजगारȣ: सब ऑटोमेटेड होने से नौकǐरयां कम हɉगी। 



DIGITAL RK COMPUTER ACADEMY 
website- www.drkca.in, drkca.com 

Address-Moazzampur Karari, Kaushambi 
Mobile no.-708076746, 6387249072,9026672774                                 

यह सरल संèकरण मूल सामĒी को आसान शÞदɉ मɅ समझाता है, 

लǑेकन कोई बदलाव नहȣं Ǒकया। अगर और èपƴ करने कȧ जǾरत हो, 
बताएं! 

Chapter) - 1(Class - 2 
IoT design methodology 

IoT Ǒडजाईनपƨित  

Step 1 : Purpose and Requirements Specification First step is to 
define the purpose and requirements of the system. In this step, the 
system's purpose, behavior and requirements are captured. 

 पहला कदम िसèटम के उƧेæय और आवæयकताओं को पǐरभाǒषत 
करना है।इस चरण मɅ, िसèटम के उƧेæय, åयवहार और आवæयकताओं 
को  िमल Ǒकया जाता  है 
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● Data collection requirements(डेटा संĒह 
आवæयकताएँ)  

● System management requirements(िसèटम Ĥबंधन 
आवæयकताएँ)  

● Security requirements(सुर¢ा आवæयकताएँ) 

 ● User interface requirements(उपयोगकता[ इंटरफ़ेस 
आवæयकताएँ) 

Step 2 : Process Specification The use cases of the IoT system are 
formally described based on or derived from the purpose and 
requirements specifications IoT 

 Ĥणाली  के उपयोग के मामलɉ को उƧेæय और  आवæयकताओं के 
ǒविनदȶशɉके आधार पर याउन से ĤाƯ औपचाǐरक   Ǿप से वǔण[त Ǒकया 
गया है  

Step 3 : Domain Model Specification The domain model describes 
the main concepts, entities and objects in the domain of the IoT 
system to be designed. Domain model defines the attributes of the 
objects and relationships between objects. The domain model is 
independent of any specific technology or platform. Physical Entity, 
Virtual Entity, Device, Resource, Service 

Step 4 : Information Model Specification The Information Model 
defines the structure of all the information in the IoT system.  
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सूचना मॉडल IoT Ĥणाली मɅ सभी सचूनाओ ंकȧ रचना को पǐरभाǒषत 
करता है। 

Step 5 : Service Specifications Service specifications define the 
services in the IoT system such as service types, service inputs/output, 
service endpoints, service schedules, service preconditions, and 
service effects 

 सेवाǒविनदȶशIoT Ĥणाली मɅ सेवाओ ंको पǐरभाǒषत करते हɇ जैसे सेवा 
Ĥकार, सेवा इनपुट/आउटपुट, सेवा समापन ǒबंद,ु सेवा शेÔयूल, सेवापूव[ 
शत[ और सेवाĤभाव 

Step 6: IoT Level Specification In this step define the 
IoT level for the system. Five typess of IoT deployment 
levels are used according to different conditions. 

 इस चरण मɅ िसèटम केिलए IoT  èतर को पǐरभाǒषत करɅ । ǒविभÛन 
ǔèथितयɉ के अनुसार पाँच Ĥकार के IoT पǐरिनयोजन èतरɉ का 
उपयोगǑक या जाता है। 

The Physical Design of IoT 

Physical Design of IoT refers to Things in IoT and IoT 
Protocols. Things are Node devices which have unique 
identities and can perform remote sensing, actuating, 
and monitoring capabilities. IoT Protocols help 
Communication established between things and cloud-
based servers over the Internet.  
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IoT काǑफ ǔजकल Ǒडजाइन IoT  मɅ वèतुओं और IoT Ĥोटोकॉल को 
संदिभ[त करता है।वèतु यɅ नोड Ǒडवाइस हɇ ǔजनकȧ ǒविशƴ पहचान हɇ 
और ǐरमोट  सɅिसंग, एÈटुवǑेटंग और िनगरानी कȧ ¢मताओं का  

 

Ĥदश[न कर सकती हɇ। IoT Ĥोटोकॉल इंटरनेट पर वèतुओं और Èलाउड 
आधाǐरत सव[र के बीच संचार èथाǒपत करने मɅ मदद करता है। 

1. Things in IoT : Refers to IoT devices which have 
unique identities that can perform sensing, actuating 
and monitoring capabilities. IoT Devices can be 
various types, Sensing Devices, Smart Watches, 
Smart Electronics appliances, Wearable Sensors, 
Automobiles, and industrial machines. 

2.  IoT मɅिथंÊस: IoT उपकरणɉ का सदंभ[ देता है ǔजनकȧ ǒविशƴ 
पहचान होती है जोसɅिसंग , सǑĐयण और िनगरानी कȧ ¢मताओं 
Ĥदश[न कर सकते हɇ। IoT Ǒडवाइसेस ǒविभÛन Ĥकार के हो सकते  
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हɇ, सɅिसंग Ǒडवाइसेस, èमाट[वॉचेस, èमाट[ इलÈेĚॉिनÈस उपकरण, 

वेयरेबल सɅसर, ऑटोमोबाइãस और इंडǔèĚयल मशीनɅ। 

3. IoT Protocols - IoT Ĥोटोकॉãस IoT protocols help to 
establish Communication between IoT Device 
(Node Device) and Cloud based Server over the 
Internet. It helps to send commands to IoT devices 
and receive data from an IoT device over the 
Internet.  

IoT ĤोटोकॉलइंटरनेटपरIoT Ǒडवाइस (नोडǑडवाइस) और Èलाउड 
आधाǐरत सव[र के बीच सचंार èथाǒपत करने मɅ मदद करते हɇ। यह 
IoT Ǒडवाइस को कमांड भेजने मɅ मदद करता है और इंटरनेट पर 
एक IoT Ǒडवाइस से डेटा ĤाƯ करता  है। 

Link Layer – Link layer protocols determine how data 
is sent over the network's physical layer or medium 
(wired or wireless). Link Layer determines how the 
packets are coded and signalled by the hardware device 
over the medium to which the host is attached. 

 िलंक लेयर Ĥोटोकॉल यह िनधा[ǐरत करते हɇ Ǒक नेटवक[  के Ǒफǔजकल 
लेयर या माÚयम (वायड[यावायरलेस) पर डेटा कैस ेभेजा जाता है। 
िलंक लेयर यह िनधा[ǐरत करता है Ǒक ǔजस माÚयम से मेजबान होèट 
हुआ है उस माÚयम से हाड[वेयर Ǒडवाइस Ʈारा पैकेट को कैसे कोǑडत 
और संकेितत Ǒकया जाता है 
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 एकåयापक Ǿप से उपयोग कȧ जाने वाली  वायर लेसने टवǑकɍ गतकनी 
क जो छोटȣ से मÚयम दरूȣ पर उÍचगित डेटा 

èथानांतरण को स¢म बनाती है। 

 

Bluetooth: A short−range wireless technology used for 
connecting devices in proximity. It is commonly used 
for IoT devices that require low power consumption and 
intermittent data transfer, such as wearable devices and 
home automation systems.  

एक छोटȣ दरूȣ  वायर लेस तकनीक ǔजसका उपयोग िनकटवतȸ 
उपकरणɉ को जोड़ने केिलए Ǒकया जाता है। इसका उपयोग आमतौर 
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पर IoT उपकरणɉ केिलए Ǒकया जाता है ǔजनके िलए कम ǒबजली कȧ  
खपत और ǽक-ǽककर डेटा Ěांसफर कȧ आवæयकता होती है, जैसे 
पहनने योÊय Ǒडवाइस और होम ऑटोमशेन िसèटम। 

Zigbee: A low−power, low−data−rate wireless 
communication protocol designed for applications with 
low power consumption requirements and a large 
number of devices. It is commonly used in home 
automation, smart lighting, and industrial applications. 

 एक कम-शǒƠ, कम-डेटा-दर वायरलेस संचार Ĥोटोकॉल जोकम ǒबजली 
कȧ खपत आवæयकताओं और बड़ȣ संÉया मɅ उपकरणɉ वाले 
अनĤुयोगɉ के िलए Ǒडज़ाइन Ǒकया गया है । इसका उपयोग आम तौर 
पर होम ऑटोमेशन, èमाट[ लाइǑटंग और औƭोिगक अनुĤयोगɉ मɅ 
Ǒकया जाता है। 

LPWAN (Low−Power Wide Area Network): 
LPWAN technologies, such as LoRaWAN and 
NB−IoT, offer long−range connectivity with low power 
consumption, making them suitable for IoT applications 
that require wide area coverage, such as smart city 
deployments and agricultural monitoring. 

 एलपीडÞãयूएएन ĤौƭोिगǑकयां , जैसे लोरावन  और एनबी -आईओटȣ, 
कम ǒबजली कȧ खपत के साथ लंबीदरूȣ कȧ कनेǔÈटǒवटȣ Ĥदान करती 
हɇ, जो उÛहɅ आईओटȣ अनुĤयोगɉ  के िलए उपयुƠ बनाती हɇ , ǔजनके 
िलए åयापक ¢ेğ कवरेज कȧ आवæयकता होती है, जैसे èमाट[िसटȣ 
तैनाती और कृǒषिनगरानी। 
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Wired connectivity :- Ethernet: A standard wired 
networking technology that provides reliable and high-
speed data transfer over a local area network (LAN). 
Ethernet is commonly used in industrial settings and for 
devices requiring high bandwidth and low latency. 

 

 एक  मानकवायड[ नेटवǑकɍ ग तकनीक जो èथानीय ¢ेğ नेटवक[ (LAN) 

परǒवƳस नीय और उÍचगित डेटा    èथानांतरण Ĥदान करती है । 
ईथरनेट का उपयोग आमतौर पर औƭोिगक से ǑटंÊसमɅ और उÍचबɇड 
ǒवÔथ और कमǒवलंबता कȧ आवæयकता वाले उपकरणɉ के िलए Ǒकया 
जाता है। 

 IEEE : Institute of Electrical and 
Electronics EngineersPowerline 
Communication: This technology allows data 
transmission over existing power lines, eliminating the 
need for additional wiring.  
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यह तकनीक मौजूदा ǒबजली लाइनɉ पर डेटा Ěांसिमशन कȧ अनुमित 
देती है, ǔजसस अितǐरƠ वायǐरंग कȧ आवæयकता समाƯ हो जाती है। 

Network/Internet Layer: This layer is responsible 
for sending IP datagrams from source to destination 
network. Its host identification is done using 
hierarchical IP addressing schemes such as IPV4 or 
IPV6.  

 

नेटवक[ /इंटरनेटलेयर:यह Üलेयर सोस[ से डेǔèटनेशन नेटवक[  तक 
आईपीडे टाĒाम भेजने के िलए ǐरèपॉǔÛसबल है।इसकȧ होèट पहचान  
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IPV4 याIPV6 जैसी पदानुĐिमत आईपीएĜेिसगं योजनाओं का उपयोग 
करके कȧ जाती है। 

Transport Layer - Ěांसपोट[लेयर:- This layer 

provides end-to-end message transfer capability 
independent of the underlying network. It provides 
functions such as error control, segmentation, flow 
control and congestion 
control………………………………. 

 

यह लेयर अंतिन[Ǒहत नेटवक[  से èवतंğइंड –टू –इंड संदेश हèतांतरण 
¢मता Ĥदान करती है ।यह ğुǑटिनयंğण , ǒवभाजन, Ĥवाह िनयंğण 
और भीड़ िनयंğण जैसे फंÈशÛस Ĥदान करता है। 

Difference between TCP and UDP – 
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 टȣसीपी और यूडȣपी के बीच अÛतर                               

 

1.TCP 2.UDP 

1(a)It is a connection-oriented protocol. 

 यह एक कनेÈशन –ओǐरयÛटेड Ĥोटोकॉल है। 

2(a)It is the connectionless protocol. 

 यह एक कनेÈशन लेस Ĥोटोकॉल है। 

1(b)TCP is reliable as it guarantees the delivery of 
the delivery of data to the destination router  
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टȣसीपी ǒवƳसनीय है ÈयɉǑक यह गंतåय राउटर 
को  डेटा कȧǑडलीवरȣ कȧ गारंटȣ देता है 

2(b)The delivery of data to the destination cannot 
be guaranteed in UDP. 

 UDP  मɅ गंतåयतक डेटा कȧ Ǒडलीवरȣ कȧ  गारंटȣ  
नहȣं दȣजासकती  है। 

 

1(c)TCP is slower than UDP. 

 यूडȣपी  कȧ  तुलना मɅ टȣसीपी तुलना×मक Ǿप से धीमा 
है। 
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2(c)UDP is faster, simpler, and more efficient than 
TCP. 

 UDP TCP कȧ तुलना मɅ अिधक तेज, सरल और 
अिधककुशल है। 

1(d)It does error checking and also makes error It 
performs error checking, but it discards recovery. 

 यह एर रको चेक करता  है और एररǐरकवरȣभी  करता 
है। 

2(d)It checks for error and discards the pack with error. 

 यह एर रको चेककरता है और एररवाल ेपैकेट को 
Ǒडèकाड[ करता है। 

1(e)It is heavy-weight.  

यह है ǒववेट है। 

2(e)It is lightweight. But not that reliable. 

यह लाइट वेट है ले Ǒकनǐर लाइबल नहȣ है। 

 TCP is used by HTTP, HTTPs, FTP, SMTP UDP is 
used by DNS, TFTP, SNMP, CoAP, and Telnet. 
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Application Layer -  Application layer protocols 
define how the applications interface with the lower 
layer protocols to send over the network….  

 

एÜली केशन लयेर Ĥोटोकॉल यह पǐरभाǒषत करते हɇ Ǒकनेटवक[  पर 
भेजने के िलए लोवर लेयर Ĥोटोकॉल के साथ एÜली केशनइंटर फेस 
कैसे होता है। 

MQTT (Message Queuing Telemetry Transport): A 
lightweight protocol designed for efficient communication in 
constrained networks, suitable for low−power devices and 
unreliable connections.  
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सीिमत नेटवक[  मɅ कुशल संचार के िलए Ǒडज़ाइन Ǒकया गया एक 
हãका Ĥोटोकॉल, जोकम-शǒƠवाले उपकरणɉ और अǒवƳसनीय 
कनÈेशन के िलए उपयुƠ है। 

HTTP (Hypertext Transfer Protocol): A standard 
protocol used for communication between web 
browsers and servers, also employed in IoT for 
web−based interactions and data transfer. 

 वेब Ħाउज़र और सव[र के बीच सचंार के िलए उपयोगǑक याजाने 
वाला एक मानक Ĥोटोकॉल , ǔजसे वेब-आधाǐरत इंटरैÈशन और 
डेटाĚांसफर के िलए IoT मɅ भीिनयोǔजत Ǒकया जाता है। 

CoAP (Constrained Application Protocol): 
Designed for resource−c

onstrained devices, CoAP enables efficient 
communication and is often used in IoT applications 
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that require low power and low bandwidth.

 

 संसाधन-बािधत  उपकरणɉ के िलए Ǒडज़ाइन Ǒकया गया, CoAP कुशल 
संचार स¢म बनाता है और अÈसर IoT  अनĤुयोगɉ मɅ उपयोग Ǒकया 
जाता है ǔजनके िलए कम ǒबजली और कम बɇडǒवÔथ कȧ आवæयकता 
होती है। 

AMQP (Advanced Message Queuing Protocol): 
A protocol for reliable messaging between devices and 
applications, capable of supporting complex messaging 
scenarios.  

 

उपकरणɉ और अनुĤयोगɉ के बीच ǒवƳसनीय संदेश भेजने के िलए 
एक Ĥोटोकॉल, जो जǑटल संदेश पǐरǺæयɉ  का समथ[न करने मɅ स¢म 
है। 
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WebSocket: A communication protocol that enables 
full−duplex communication over a single, long−lived 
connection, facilitating real−time data transfer between 
IoT devices and servers. 

 

 एक संचार Ĥोटोकॉल जो एक, लंबे समय तक चलने वाले कनेÈशन 
पर पूण[-डुÜलÈेस संचार को स¢म बनाता  है, ǔजससे IoT उपकरणɉ 
और सव[रɉ के बीच वाèतǒवक-समय डेटा èथानांतरण कȧ सुǒवधा 
िमलती है। 

XMPP (Extensible Messaging and Presence 
Protocol): It is a communication protocal for message-
oriented middleware based on XML (Extensible 
Markup Language). the protocol has been used also for 
publish-su systems, signaling for VoIP, video, file 
transfer, gaming, the Internet of Things (loT) 
applications such as the smart grid, and social 
networking services………………………………..  
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यह एÈसएमएल(एÈसटɅिसबल माक[  अपलɇÊवेज) आधाǐरत संदेश-
उÛमुखिमड लवेयर के िलए एक संचार Ĥोटोकॉल है ।Ĥोटोकॉल का 
उपयोग पǔÞलश-सÞसĐाइबिसèटम, वीओआईपी, वीǑडयो, फाइलĚागेिमंग,  

IoT  एǔÜलकेशन जैसे èमाट[ िĒड और सोशलनेट वǑकɍ ग सेवाओं के 
िलए भी Ǒकया जाता है। 

The Logical Design of IoT 

. Logical design of an management IoT system refers to 
an abstract representation of the entities and processes 
without going into the low-level specifics of the 
implementation. An IoT system comprises several 
functional blocks that provide the system the 
capabilities for identification, sensing, actuation, 
communication andIoT  
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िसèटम का लॉǔजकल Ǒडजाइन काया[Ûवयन के िनàन-èतरȣयबारȣ 
Ǒकयɉ मɅ जाने के ǒबना संèथाओं और  ĤǑĐयाओं के एक 
अमूत[Ĥितिनिध×व को संदिभ[त करता है।एक IoT िसèटम मɅ अनेक 
काया[×म कÞलॉक शािमल होते हɇ जो िसèटम कȧ पहचान, सǔेÛसंग, 

एÈचुवेशन, संचार और Ĥबंधन के िलए ¢मताओं को Ĥोवाइड करते हɇ। 

For understanding Logical Design of IoT, we 
consider the following terms: IoT केलॉǔजकल Ǒडजाइन को 
समझने केिलए, हम िनàनिलǔखत शÞदɉ परǒवचार करते हɇ। 

1. IoT Functional Blocks 
2. IoT Communication Models 
3. IoT Communication APIs 

IoT Functional blocks 

An IoT system comprises several functional blocks that 
provide the system capabilities of identification, 
sensing, actuation, communication, and management. 
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 एक  IoT   िसèटम  मɅ अनेक फंÈशनल Þलॉक शािमल होते हɇ जो 
पहचान, सɅिसंग, एÈचुवेशन, संचार और Ĥबंधन कȧ Ĥणाली ¢मताओं को 
Ĥदान करते हɇ। 

Device: An IoT system comprises devices that provide 
sensing, monitoring, actuation, and control functions. 

 

 एक IoT  िसèटम मɅ ऐसे Ǒडवाइस शािमल होते हɇ जोसɅिसंग, 

मॉिनटǐरंग और कंĚोल फंÈशन Ĥदान करते हɇ। 
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Communication: Handles the communication for the 
IoT system.  

 

IoT िसèटम के िलए संचार को संभालता है। 

Services: Services for device monitoring, device 
control service, data publishing services, and services 
for device discovery. 

 

 Ǒडवाइस कȧ िनगरानी के िलए सवेाएं,  Ǒडवाइस िनयंğण सेवा,   डेटा 
पǔÞलिशंग सवेाएं और Ǒडवाइस खोज कȧ सेवाएं। 

 Management: This block provides various functions to 
govern the IoT system. 
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यह Þलॉक IoT िसèटम को सचंािलत करने के िलए ǒविभÛन काय[ 
Ĥदान करता है। 

Security: This block secures the IoT system and by 
providing functions such as authentication, authorization, 
message and content integrity, and data security. 

 

 यह Þलॉक IoT  िसèटम को सरुǔ¢त करता है और authentication,  

authorization, संदेश और कंटɅट कȧ  ǒवƳसनीयता, और डेटा सरु¢ा 
जैसे काय[ Ĥदान करता है। 

Application: This is an interface that the users can use to 
control and monitor various aspects of the loT system. 
Applications also allow users to view the system status and 
view or analyze the processed data.  

यह एक इंटरफेस है ǔजसका उपयोग उपयोग कता[ IoT िसèटम के 
ǒविभÛन पहलुओं को िनयंǒğत और मॉिनटर करने के िलए कर सकते 
हɇ । एǔÜलकेशन उपयोगकता[ओं को िसèटम कȧ ǔèथित देखने और 
Ĥोसेèड  डेटा को देखने याǒवƲेषण करने कȧ अनुमित भी देते हɇ। 

Communication Models – कàयूिनकेशनमॉडल 
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Communication models are listed below कàयूिनकेशन मॉडल 
नी चेसू चीबƨ हɇ: 

(i) Request-Response Communication Model 
Request-Response is a communication model in 
which the client sends requests to the server and 
the server responds to the requests. When the 
server receives a request, it decides how to 
respond, fetches the data, retrieves resource 
representations, prepares the response, and then 
sends the response to the client. 

 ǐरÈवेèट-ǐरèपॉÛस एक संचार मॉडल है ǔजसमɅ Ēाहक सव[र को 
ǐरÈवेèट भेजता है और सव[रǐरÈवे èÒसका जवाब देता है।जब सव[र 
एक ǐरÈवेèट ĤाƯ करता है, तो यह तय करता है Ǒक कैसे 
ĤितǑĐया दȣ जाए, डेटा ĤाƯ Ǒकया जाए, ǐरसोस[ǐर ĤेसÛेटेशन को 
पुनःĤाƯ Ǒकया जाए, ĤितǑĐया तैयार कȧ जाए और Ǒफर Ēाहक को 
Ĥित ǑĐया भेजी जाए। 

Publish-Subscribe Communication Model पǔÞलश-
सÞसĐाइबकàयिूनकेशनमॉडल Publish-Subscribe is a 
communication model that involves publishers, brokers, 
and consumers.  

पǔÞलश-सÞसĐाइब एक सचंार मॉडल है ǔजस मɅ Ĥकाशक, Ħोकर और 
उपभोƠा शािमल होते हɇ। 
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Push -Pull Communication Model पुश-
पुलकàयूिनकेशनमॉडल Push-Pull is a communication 
model in which the data producers push the data to 
queues and the consumers pull the data from the 
queues. Producers do not need to be aware of the 
consumers…. 

 पुश-पुल एक कàयूिनकेशन मॉडल है ǔजसमɅ डेटा िनमा[ता डेटा को 
Èयू मɅ push करते हɇ और उपभोƠा Èयू स ेडेटा खींचते(pull) हɇ।िनमा[ता 
को उपभोƠाओं को जागǾक करने कȧ आवæयकता नहȣं है। 

a. Exclusive Pair Communication Model 

एÈसÈãयूिसवपेयरकàयूिनकेशनमॉडल Exclusive Pair is 
bidirectional, full duplex communication model that uses a 
persistent connection between the client and the server. 

 एÈसÈãयूिसव पेयर एक bidirectional, fully duplex संचार मॉडल है 
जोÈलाइंट और सव[र के बीच एक èथायी कनेÈशन का उपयोग करता 
है। 

Development Tools used in loT  

IoT मɅ उपयोग Ǒकए जाने वाल ेउपकरण 
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1. Arduino - आड[यूनो Arduino is an Italian open-source 
hardware and software company, projects and user 
community that designs and manufactures single-
board microcontrollers and microcontroller kits for 
building digital devices. 

 

 Arduino एक इतालवी ओपन-सोस[ हाड[ वेयर और सॉÝटवेयर 
कंपनी, ĤोजेÈट और उपयोगकता[ समुदा य है जो Ǒडǔजटल 
उपकरणɉ के िनमा[ण के िलए िसंगल-बोड[ माइĐो कंĚोलर और 
माइĐो कंĚोलर Ǒक Ǒडजाइन और िनमा[ण करता है। 

2. Eclipse loT - ईǔÈलÜसआईओटȣ Eclipse IoT is an 
ecosystem of entities (industry and academia) 
working together to create a foundation for IoT based 
exclusively on open source technologies. Their focus 
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remains in the areas of producing open source 
implementations of IoT standard technology. 

एǔÈलÜस IoT संèथाओं ( उƭोगऔरिश¢ाजगत ) का एक 
पाǐरǔèथित कȧ तंğ है जो ǒवशेष Ǿप स ेओपन सोस[ 
ĤौƭोिगǑकयɉ पर आधाǐरत IoT के िलए एक आधार बनाने के 
िलए िमलकर काम कर रहा है।उनका Úयान IoT मानक 
Ĥौƭोिगकȧ के खुल ेİोत काया[Ûवयन के ¢ेğ मɅ रहता है। 

3. PlatformIOT It is a cross-platform IoT development 
environment. This platform comes with a build system, 
supported by a library manager and IDE…..  

 

यह एक Đॉस-Üलेटफॉम[ IoT ǒवकास एनवायरनमɅट है। यह 
Üलेटफॉम[ एक ǒबãडिसèटम के साथ आता है, जो एकलाइĦेरȣ 
मैनेजर और आईडȣई Ʈारा समिथ[त है। 
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4. IBM Watson IBM Watson, an API that allows you 
to attach a host of cognitive computing features to 
your applications. This is an innovative tool that can 
also be used to predict the future.  

 

आईबीएम वाटसन, एक एपीआई जो आपको अपने loT 

ऐǔÜलकेशनो मɅ सं£ाना×मक कंÜयूǑटंग सǒुवधाओं के एक होèट 
को संलÊन करने कȧ अनुमित देता है।यह एक इनोवेǑटव 
उपकरण है ǔजसका उपयोग भǒवçय कȧ  भǒवçयवाणी करने के 
िलए भी Ǒकया जा सकता है। 

5. Raspbian Raspberry Pi OS is a Unix-like operating 
system based on the Debian GNU/Linux distribution 
for the Raspberry Pi family of compact single-board 
computers. First developed independently in 2012, it 
has been produced as the primary operating system 
for these boards since 2013, distributed by the 
Raspberry Pi Foundation  

राèप बेरȣ पाईओ एस एक यूिनÈस जैसा ऑपरेǑटंग िसèटम है 
जो कॉàपैÈट िसगंल-बोड[ कंÜयूटरɉ के राèपबेरȣ पाईप ǐरवार के 
िलए डेǒबयन जी एनयू/िलनÈसǒवतरण पर आधाǐरत 
है।पहलीबार 2012  मɅ èवतंğ Ǿप से ǒवकिसत Ǒकया गया था, इसे 
2013 से इन बोडɟ के िलए Ĥाथिमक ऑपरेǑटंग िसèटम के Ǿप 
मɅ उ×पाǑदत Ǒकया गया है, ǔजसे राèपबेरȣ पाई फाउंडेशन Ʈारा 
ǒवतǐरत Ǒकया गया है। 
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6. OpenSCADA (Supervisory Control And Data 
Acquisition) This tool is a part of the SCADA project by 
Eclipse IoT industry groups. It is Independent to any 
platform and is known for its security and flexibility along 
with a modern design. OpenSCADA also supports editing 
and debugging and comes with front-end applications, 
back-end applications, libraries, configuration tools and 
interface applications. Its different tools can be combined 
with the development of advanced loT applications. Unlike 
other IDEs, OpenSCADA supports various programming 
languages and consists of sub-projects like Atlantis, Utgard, 
Orilla and 0thers….  

 

यह टूल एǔÈलÜस IoT उƭोग समूहɉ Ʈारा SCADA ĤोजेÈट का 
एक Ǒहèसा है।यह Ǒकसी भी मंच के िलए èवतंğ है और 
आधुिनक Ǒडजाइन के साथ अपनी सुर¢ा और लचीलेपन के िलए 
जाना जाता है। Open SCADA संपादन और Ǒडबिगंग का भी 
समथ[न करता है और ĥंट-एंड एǔÜलकेशन, बैक-एंड एǔÜलकेशन, 

लाइĦेरȣ, कॉǔÛफ़गरेशन टूल और इंटरफ़ेस एǔÜलकेशन के साथ 
आता है।इसके ǒविभÛन उपकरणɉ को उÛनत एल ओटȣ 
अनĤुयोगɉ के ǒवकास के साथ जोड़ा जा सकता है।अÛय IDE  के 
ǒवपरȣत , Open SCADA ǒविभÛन ĤोĒािमंग भाषाओं का समथ[न 
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करता है और इसमɅ अटलांǑटस , Ut gard, Orilla और 0thers जैसी 
उप-पǐरयोजनाएँ शािमल हɇ। 

 

7. Node-RED Node-RED is a simple visual tool that is built on 
Node.js, a server-side JavaScript platform that is widely used in 
IoT projects. It is an open-source tool mainly used to connect 
devices, services, and APIs together with an integrated browser-
based flow editor. With over 60,000modules, it was developed by 
IBM with the aim of providing a user-friendly interface for Node-
RED developers allowing them to connect devices very quickly 
and easily. 

  

नोड-रेड एक सरल Ǻæय उपकरण है ǔजसे Node .js पर बनाया 
गया है, जो एक सव[र-साइड जावाǔèĐÜट Üलेटफॉम[ है जो åयापक 
Ǿप से IoT के ĤोजÈेटो मɅ उपयोग Ǒकया जाता है।यह एक 
ओपन-सोस[टूल है ǔजसका उपयोग मुÉय Ǿप से उपकरणɉ, 
सेवाओं और एपीआई को एक एकȧकृत Ħाउजर-आधाǐरत Ýलो 
एǑडटर के साथ जोड़ने के िलए Ǒकया जाता है।60,000 स ेअिधक 
मॉÔयूल के साथ, यह आईबीएम Ʈारा डेवल पस[ के िलए 
उपयोगकता[ के अनुकूलइंटरफेस Ĥदान करने के उƧेæय से 
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ǒवकिसत Ǒकया गया था, ǔजससे उÛहɅ बहुत जãदȣ और आसानी 
से Ǒडवाइस कनेÈट करने कȧ अनुमित िमलती है। 

8. Device Hive Device Hive is a free open source 
machine to machine (M2M) communication 
framework which was launched in 2012. It is a Data 
Art's Alljoyn based device and is considered one of 
the most preferred IoT app development platforms. 

 

 

Ǒडवाइस हाइव एक मुÝत ओपन सोस[ मशीन टूमशीन(M2M) 

संचार ĥेम वक[  है ǔजसे 2012 मɅ लॉÛच Ǒकया गया था।यह डेटा 
आट[ का Alljoyn आधाǐरत Ǒडवाइस है और इसे सबसे पसंदȣदा 
IoT ऐप डेवलपमɅट Üलेटफॉम[  मɅ से एक माना जाता है। 

(नोट: PDF मɅ कुछ èथानɉ पर "………………………." या Ěंकेटेड 
Ǒहèसे हɇ, जो मूल मɅ हɇ। इमेज/डायĒाम जहां हɇ, वहां मɇने नोट Ǒकया 
है ÈयɉǑक यह टेÈèट ĚांसǑĐÜशन है। PDF मɅ कई इमेज हɇ जैसे 
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डायĒाम, चाट[ आǑद, लǑेकन टेÈèट आधाǐरत उƣर मɅ उÛहɅ शािमल 
नहȣं Ǒकया।) 

 

Simplified Version 

यह PDF O Level M4 कोस[ के अÚयाय 1 (Èलास 2) का है, जो IoT 

Ǒडजाइन मेथडोलॉजी, Ǒफǔजकल Ǒडजाइन, Ĥोटोकॉãस, लॉǔजकल 
Ǒडजाइन, कàयुिनकेशन मॉडãस और डेवलपमɅट टूãस पर है। मɇने 
मǔुæकल शÞदɉ को आसान बना Ǒदया है (जैसे "actuating" को "ǑĐया 
करना", "authentication" को "पहचान स×यापन" आǑद), लǑेकन मूल 
अथ[ वहȣ रखा है। मूल मɅ अंĒेजी और Ǒहंदȣ दोनɉ हɇ, इसिलए दोनɉ को 
सरल बनाया। 

IoT Design Methodology 

IoT Ǒडजाइन मेथडोलॉजी मɅ ये èटेÜस शािमल हɇ: 

STEP 1: उƧेæय और आवæयकताएं िनधा[ǐरत करना (Purpose and 

Requirements Specification) पहला कदम िसèटम के उƧेæय और 
जǾरतɉ को पǐरभाǒषत करना है। इसमɅ िसèटम का उƧेæय, åयवहार 
और जǾरतɅ कैद कȧ जाती हɇ। 

 डेटा इकÒठा करने कȧ जǾरतɅ (Data collection requirements) 

 िसèटम Ĥबंधन कȧ जǾरतɅ (System management requirements) 

 सुर¢ा कȧ जǾरतɅ (Security requirements) 

 यूजर इंटरफेस कȧ जǾरतɅ (User interface requirements) 
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STEP 2: ĤǑĐया िनधा[रण (Process Specification) IoT िसèटम के 
उपयोग मामलɉ को उƧेæय और जǾरतɉ के आधार पर औपचाǐरक Ǿप 
से वǔण[त Ǒकया जाता है। 

STEP 3: डोमेन मॉडल िनधा[रण (Domain Model Specification) डोमेन 
मॉडल IoT िसèटम के मुÉय अवधारणाओं, संèथाओं और वèतुओं का 
वण[न करता है। यह वèतुओं कȧ ǒवशेषताएं और उनके बीच संबंध 
पǐरभाǒषत करता है। यह Ǒकसी खास तकनीक या Üलेटफॉम[ से èवतंğ 
है। (जैसे: भौितक सèंथा, आभासी सèंथा, Ǒडवाइस, संसाधन, सेवा) 

STEP 4: सूचना मॉडल िनधा[रण (Information Model 

Specification) सचूना मॉडल IoT िसèटम मɅ सभी सूचनाओं कȧ 
संरचना पǐरभाǒषत करता है। 

STEP 5: सेवा िनधा[रण (Service Specifications) सेवा िनधा[रण IoT 

िसèटम मɅ सेवाओं को पǐरभाǒषत करता है जैसे सेवा Ĥकार, 

इनपुट/आउटपुट, सेवा अंतǒबंद,ु सेवा समयसारणी, सेवा पूव[शतɏ और 
सेवा Ĥभाव। 

STEP 6: IoT èतर िनधा[रण (IoT Level Specification) इसमɅ िसèटम 
के िलए IoT èतर पǐरभाǒषत करɅ। ǒविभÛन ǔèथितयɉ के अनुसार 5 

Ĥकार के IoT पǐरिनयोजन èतर उपयोग Ǒकए जाते हɇ। 

The Physical Design of IoT 

IoT का Ǒफǔजकल Ǒडजाइन IoT मɅ वèतुओं और Ĥोटोकॉãस को 
संदिभ[त करता है। वèतुएं नोड Ǒडवाइस हɇ ǔजनकȧ ǒविशƴ पहचान 
होती है और दरू से सɅिसंग (महसूस करना), ǑĐयाकरण और िनगरानी 
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कर सकती हɇ। IoT Ĥोटोकॉल वèतुओं और Èलाउड सव[र के बीच 
इंटरनेट पर संचार èथाǒपत करने मɅ मदद करते हɇ। 

1. IoT मɅ वèतुएं (Things in IoT): IoT Ǒडवाइस ǔजनकȧ ǒविशƴ 
पहचान होती है जो सɅिसंग, ǑĐयाकरण और िनगरानी कर सकते 
हɇ। ये ǒविभÛन Ĥकार के हो सकते हɇ जैसे सɅिसंग Ǒडवाइस, 

èमाट[ वॉच, èमाट[ इलÈेĚॉिनÈस उपकरण, पहनने योÊय सɅसर, 

कारɅ और औƭोिगक मशीनɅ। 
2. IoT Ĥोटोकॉãस (IoT Protocols): ये IoT Ǒडवाइस और Èलाउड 

सव[र के बीच इंटरनेट पर संचार èथाǒपत करने मɅ मदद करते 
हɇ। ये IoT Ǒडवाइस को कमांड भेजने और डेटा ĤाƯ करने मɅ 
मदद करते हɇ 

 

िलंक लेयर (Link Layer): िलंक लेयर Ĥोटोकॉल तय करते हɇ Ǒक डेटा 
नेटवक[  के भौितक लेयर (वायड[ या वायरलेस) पर कैसे भेजा जाता है। 
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यह तय करता है Ǒक पैकेट हाड[वेयर Ǒडवाइस Ʈारा कैसे कोǑडत और 
संकेितत Ǒकए जाते हɇ। 

वायरलेस कनेǔÈटǒवटȣ (Wireless Connectivity): 

 Wi-Fi: åयापक उपयोग वाली वायरलेस नेटवǑकɍ ग तकनीक जो 
छोटȣ से मÚयम दरूȣ पर तेज डेटा Ěांसफर स¢म बनाती है। 

 Þलूटूथ (Bluetooth): छोटȣ दरूȣ कȧ वायरलेस तकनीक जो िनकट 
Ǒडवाइस जोड़ने के िलए उपयोग होती है। IoT Ǒडवाइस के िलए 
जहां कम ǒबजली और ǽक-ǽक कर डेटा Ěांसफर चाǑहए, जैसे 
पहनने योÊय Ǒडवाइस और घरेलू ऑटोमेशन। 

 ǔजगबी (Zigbee): कम शǒƠ, कम डेटा दर वाला वायरलेस संचार 
Ĥोटोकॉल जो कम ǒबजली वाली जǾरतɉ और Ïयादा Ǒडवाइस 
वाले अनुĤयोगɉ के िलए Ǒडजाइन Ǒकया गया। घरेलू ऑटोमशेन, 

èमाट[ लाइǑटंग और औƭोिगक मɅ उपयोग। 
 LPWAN (Low-Power Wide Area Network): जैसे LoRaWAN 

और NB-IoT, कम शǒƠ के साथ लंबी दरूȣ कनेǔÈटǒवटȣ देते हɇ। 
èमाट[ िसटȣ और कृǒष िनगरानी के िलए उपयुƠ। 

वायड[ कनेǔÈटǒवटȣ (Wired Connectivity): 

 ईथरनेट (Ethernet): मानक वायड[ नेटवǑकɍ ग तकनीक जो 
èथानीय नेटवक[  (LAN) पर ǒवƳसनीय और तेज डेटा Ěांसफर 
देती है। औƭोिगक सेǑटंÊस और उÍच बɇडǒवÔथ वाल ेǑडवाइस के 
िलए। 
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 पावरलाइन कàयुिनकेशन (Powerline Communication): मौजूदा 
ǒबजली लाइनɉ पर डेटा Ěांसिमशन, अितǐरƠ वायǐरंग कȧ जǾरत 
नहȣं। 

नेटवक[ /इंटरनेट लेयर (Network/Internet Layer): यह सोस[ से 
डेǔèटनेशन नेटवक[  तक IP डेटाĒाम भेजने के िलए ǔजàमेदार। होèट 
पहचान IPV4 या IPV6 जसैी पदानुĐिमत IP एĜेिसगं से होती है। 

Ěांसपोट[ लेयर (Transport Layer): यह अंतिन[Ǒहत नेटवक[  से èवतंğ 
एंड-टू-एंड संदेश Ěांसफर देता है। इसमɅ ğुǑट िनयंğण, ǒवभाजन, Ĥवाह 
िनयंğण और भीड़ िनयंğण जैसे काय[। 

TCP और UDP मɅ अंतर (Difference between TCP and UDP): 

 TCP: कनेÈशन-ओǐरएंटेड, ǒवƳसनीय, डेटा Ǒडलीवरȣ गारंटȣ, धीमा, 
ğुǑट चेक और ǐरकवरȣ, हैवीवेट। HTTP, HTTPS, FTP, SMTP, 

Telnet मɅ उपयोग। 
 UDP: कनÈेशनलेस, Ǒडलीवरȣ गारंटȣ नहȣं, तेज, सरल, कुशल, ğुǑट 

चेक लेǑकन पैकेट Ǒडèकाड[, लाइटवेट लेǑकन कम ǒवƳसनीय। 
DNS, TFTP, SNMP, CoAP मɅ उपयोग। 

एÜलीकेशन लेयर (Application Layer): एÜलीकेशन लेयर Ĥोटोकॉल तय 
करते हɇ Ǒक एÜलीकेशन लोवर लेयर Ĥोटोकॉल के साथ कैसे इंटरफेस 
करते हɇ। 

 MQTT: सीिमत नेटवक[  मɅ कुशल संचार के िलए हãका Ĥोटोकॉल, 

कम शǒƠ वाले Ǒडवाइस और अǒवƳसनीय कनेÈशन के िलए। 
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 HTTP: वेब Ħाउजर और सव[र के बीच संचार के िलए मानक, IoT 

मɅ वेब-आधाǐरत इंटरैÈशन और डेटा Ěांसफर के िलए। 
 CoAP: संसाधन-बािधत Ǒडवाइस के िलए, कुशल संचार, कम शǒƠ 

और बɇडǒवÔथ वाल ेIoT अनĤुयोगɉ मɅ। 
 AMQP: Ǒडवाइस और अनुĤयोगɉ के बीच ǒवƳसनीय संदेश, 

जǑटल संदेश पǐरǺæयɉ के िलए। 
 WebSocket: एक लंबे कनेÈशन पर पूण[-डुÜलÈेस संचार, IoT 

Ǒडवाइस और सव[र के बीच ǐरयल-टाइम डेटा Ěांसफर। 
 XMPP: XML आधाǐरत संदेश िमडलवेयर के िलए संचार 

Ĥोटोकॉल, पǔÞलश-सÞसĐाइब, VoIP, वीǑडयो, फाइल Ěांसफर, 

गेिमंग, èमाट[ िĒड, सोशल नेटवǑकɍ ग मɅ उपयोग। 

The Logical Design of IoT 

IoT िसèटम कȧ लॉǔजकल Ǒडजाइन संèथाओं और ĤǑĐयाओं का अमूत[ 
Ĥितिनिध×व है ǒबना काया[Ûवयन कȧ बारȣǑकयɉ के। यह पहचान, 

सɅिसंग, ǑĐयाकरण, संचार और Ĥबंधन कȧ ¢मताएं देता है। 

IoT को समझने के िलए: 

1. IoT फंÈशनल ÞलॉÈस (Functional Blocks) 

2. IoT कàयुिनकेशन मॉडãस (Communication Models) 

3. IoT कàयुिनकेशन APIs 

IoT फंÈशनल ÞलॉÈस: 

 Ǒडवाइस: सɅिसंग, मॉिनटǐरंग, ǑĐयाकरण और िनयंğण Ĥदान 
करते हɇ। 
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 कàयुिनकेशन: IoT िसèटम के संचार को सभंालता है। 

 

 सेवाएं: Ǒडवाइस मॉिनटǐरंग, िनयंğण, डेटा पǔÞलिशंग और Ǒडवाइस 
खोज कȧ सेवाएं। 

 Ĥबंधन: IoT िसèटम को संचािलत करने के काय[। 
 सुर¢ा: Ĥमाणीकरण (authentication), Ĥािधकरण (authorization), 

संदेश अखंडता और डेटा सुर¢ा। 
 एÜलीकेशन: यूजर को िसèटम िनयंǒğत और मॉिनटर करने का 

इंटरफेस, ǔèथित देखने और डेटा ǒवƲेषण। 

कàयुिनकेशन मॉडãस: 

 ǐरÈवेèट-ǐरèपॉÛस: Èलाइंट सव[र को ǐरÈवेèट भेजता है, सव[र 
जवाब देता है। 

 पǔÞलश-सÞसĐाइब: Ĥकाशक, Ħोकर और उपभोƠा शािमल। 
 पुश-पुल: डेटा उ×पादक Èयू मɅ पुश करते हɇ, उपभोƠा पुल करते 

हɇ। 
 एÈसÈãयूिसव पेयर: ǑƮǑदश, पूण[ डुÜलÈेस, Èलाइंट-सव[र के बीच 

èथायी कनेÈशन। 
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Development Tools used in IoT 

1. आड[यूनो (Arduino): इटािलयन ओपन-सोस[ कंपनी जो िसगंल-
बोड[ माइĐोकंĚोलर बनाती है Ǒडǔजटल Ǒडवाइस बनाने के िलए। 

2. ईǔÈलÜस IoT (Eclipse IoT): सèंथाओं का पाǐरǔèथितकȧतंğ जो 
ओपन-सोस[ पर आधाǐरत IoT फाउंडेशन बनाता है। मानक 
तकनीक के ओपन-सोस[ काया[Ûवयन पर फोकस। 

3. Üलेटफॉम[IO (PlatformIO): Đॉस-Üलेटफॉम[ IoT ǒवकास वातावरण, 

ǒबãड िसèटम, लाइĦेरȣ मैनेजर और IDE के साथ। 
4. IBM वाटसन (IBM Watson): API जो सं£ाना×मक कंÜयूǑटंग 

फȧचस[ को एÜलीकेशन मɅ जोड़ता है, भǒवçय भǒवçयवाणी के 
िलए। 

5. राèपǒबयन (Raspbian): राèपबेरȣ पाई के िलए डेǒबयन आधाǐरत 
यूिनÈस जैसा OS, 2012 मɅ ǒवकिसत। 

6. ओपनSCADA (OpenSCADA): एǔÈलÜस IoT का SCADA 

ĤोजÈेट भाग, Üलेटफॉम[ èवतंğ, सुरǔ¢त, लचीला। संपादन, 

Ǒडबिगंग, ĥंट-एंड, बैक-एंड, लाइĦेरȣ आǑद सपोट[। ǒविभÛन भाषाएं 
और सब-ĤोजेÈÒस जसैे Atlantis, Utgard। 

7. नोड-RED (Node-RED): Node.js पर आधाǐरत सरल Ǻæय टूल, 

Ǒडवाइस, सेवाएं और APIs जोड़ने के िलए। IBM Ʈारा ǒवकिसत, 

यूजर ĥɅ डली इंटरफेस। 
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8. Ǒडवाइस हाइव (Device Hive): ĥȧ ओपन-सोस[ M2M ĥेमवक[ , 
2012 मɅ लॉÛच, Data Art का Alljoyn आधाǐरत, पसंदȣदा IoT ऐप 
डेवलपमɅट Üलेटफॉम[। 

यह सरल संèकरण मूल सामĒी को आसान शÞदɉ मɅ समझाता है 
(मǔुæकल शÞद जैसे "actuating" को "ǑĐया करना", "duplex" को 
"ǑƮǑदश" आǑद), लेǑकन कोई बदलाव नहȣं Ǒकया। अगर और èपƴ 
करने कȧ जǾरत हो, बताएं! 

                                         CHAPTER  2 
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  THINGS AND 
CONNECTIONS 
Control System-  A control system is a system that manages, regulates, and controls 
the behavior of other devices or systems. It uses input from sensors, processes the 
information, and sends commands to actuators to achieve a desired output. 

कंĚोल िसèटम वह Ĥणाली है जो अÛय उपकरणɉ या िसèटम के åयवहार को िनयंǒğत और 
Ĥबंिधत करती है। यह सɅसर से इनपुट लेता है, जानकारȣ Ĥोसेस करता है, और वांिछत 
आउटपुट ĤाƯ करने के िलए एÈÒयूएटर को िनदȶश भेजता है। 

 

🟦 2. Components of a Control System 

1. Sensor (सɅसर) 

Measures physical quantities like temperature, moisture, pressure, etc. 

→ तापमान, नमी, दबाव जैसे मानɉ को मापता है। 

 

2. Controller (कंĚोलर) 

Processes the sensor data and makes decisions. 
Examples: Microcontroller, ESP32, Arduino, Raspberry Pi. 

→ सɅसर के डेटा को Ĥोसेस कर िनण[य लेता है। 

 

3. Actuator (एÈÒयएूटर) 

Carries out the action such as turning ON/OFF motor, opening valve, etc. 

→ कार[वाई करता है, जसैे मोटर चालू/बदं करना। 
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4. Feedback (फȧडबकै) 

Output is measured again and sent back to controller for correction. 

→ आउटपुट को दोबारा मापा जाता है और सुधार के िलए कंĚोलर को भेजा जाता है। 

 

5. Set Point (सेट Üवाइंट) 

Desired output value (example: 25°C in AC). 

→ वांिछत आउटपुट मान (जैस ेAC को 25°C पर सेट करना)। 

 

🟦 3. Types of Control Systems 

 

🔵 A. Open-Loop Control System 

An open-loop system has no feedback. It performs action based on predefined settings. 
Output is not compared with input. 

ओपन-लूप िसèटम मɅ फȧडबैक नहȣं होता। यह पहले स ेतय सेǑटंग के अनुसार काम करता 
है। 
आउटपुट कȧ तुलना इनपुट से नहȣं कȧ जाती। 

 

Examples / उदाहरण: 

 Washing machine (time-based) 
 Microwave oven 
 Electric iron (older models) 
 Street lights using timers 
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Advantages (फायदे): 

 Simple design 
 Low cost 
 Easy maintenance 

Disadvantages (नकुसान): 

 No error correction 
 Less accuracy 
 Output changes with disturbance 

 

 

🔵 B. Closed-Loop (Feedback) Control System 

A closed-loop system uses feedback. 
It continuously compares output with set point and corrects errors automatically. 

ÈलोÏड-लूप िसèटम फȧडबैक का उपयोग करता है। 
यह आउटपुट कȧ तुलना सेट Üवाइंट से करता है और ğुǑटयɉ को èवयं सुधारता है। 

 

Examples / उदाहरण: 

 Air conditioner with thermostat 
 Smart irrigation system 
 Automatic room heater 
 Self-driving cars 

 

Advantages (फायदे): 

 High accuracy 
 Automatic error correction 
 Stable system 

Disadvantages (नकुसान): 

 Complex design 
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 High cost 
 Requires more power 

 

🟦 4. Control Actions / Control Algorithms 

 

1. ON/OFF Control 

Turns device ON or OFF based on threshold. 
Used in simple systems. 

Ġेशहोãड के आधार पर Ǒडवाइस को ON या OFF करता है। 
सरल िसèटम मɅ उपयोग। 

Example: 

 Thermostat (AC, heater) 

 

2. Proportional Control (P Control) 

Output is proportional to error. 
If error increases → control action increases. 

आउटपुट ğुǑट के अनुपात मɅ होता है। 
ğुǑट बढ़े → िनयंğण ǑĐया बढ़े। 

 

3. PID Control (Proportional + Integral + Derivative) 

⭐⭐ Most important in IoT and industry 

PID provides stable and smooth control. 
Used in robots, drones, automotive systems. 

PID िनयंğण ǔèथर और èमूद कंĚोल देता है। 
रोबोट, Ĝोन और ऑटोमोबाइल िसèटम मɅ उपयोग होता है। 
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🟦 5. Block Diagram of Control System 
Input → Controller → Actuator → Output → Feedback → Controller   
 

इनपुट → कंĚोलर → एÈÒयूएटर → आउटपुट → फȧडबैक → कंĚोलर 

 

🟦 6. Applications of Control Systems in IoT 

 Smart home automation 
 Smart agriculture (soil moisture control) 
 Industrial automation 
 Smart healthcare 
 Smart traffic systems 
 Energy management systems 

 

 èमाट[ होम ऑटोमेशन 

 èमाट[ कृǒष (िमÒटȣ नमी िनयंğण) 
 औƭोिगक ऑटोमेशन 

 èमाट[ हेãथकेयर 

 èमाट[ ĚैǑफक िसèटम 

 ऊजा[ Ĥबंधन िसèटम 

 

🟦 7. Advantages of IoT-based Control Systems 

 Automation reduces human effort 

 Improves accuracy 
 Real-time control 
 Remote monitoring 
 Energy efficient 

 

 ऑटोमेशन से मानव Įम कम 

 सटȣकता मɅ सुधार 

 ǐरयल-टाइम कंĚोल 

 दरू से िनगरानी 
 ऊजा[ कȧ बचत 
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🟦 8. Challenges of Control Systems 

 Network failure affects control 
 Security vulnerabilities 
 Sensor noise affects accuracy 
 High cost in advanced systems 

 

 नेटवक[  फेल होने पर कंĚोल Ĥभाǒवत 

 सुर¢ा समèयाएँ 

 सɅसर कȧ ğुǑटयाँ 
 उÛनत िसèटम मɅ अिधक लागत 

 

SUMMARY  

A control system is a system that regulates the behavior of devices using sensors, processors, 
and actuators. It can be open-loop or closed-loop depending on whether feedback is used or 
not. Open-loop systems are simple but less accurate, while closed-loop systems use feedback 
to correct errors and provide accurate control. IoT-based control systems are widely used in 
smart homes, agriculture, industries, and healthcare. They improve automation, accuracy, and 
efficiency but face challenges like network issues and security risks. 

कंĚोल िसèटम वह Ĥणाली है जो सɅसर, Ĥोसेसर और एÈÒयूएटर का उपयोग करके उपकरणɉ 
के åयवहार को िनयंǒğत करती है। इसे फȧडबैक के आधार पर ओपन-लूप और ÈलोÏड-लपू 
मɅ ǒवभाǔजत Ǒकया जाता है। ओपन-लूप िसèटम सरल होते हɇ लेǑकन कम सटȣक होते हɇ, 
जबǑक ÈलोÏड-लूप िसèटम फȧडबैक का उपयोग करके ğुǑटयɉ को सुधारते हɇ और अिधक 
सटȣक िनयंğण देते हɇ। IoT आधाǐरत कंĚोल िसèटम èमाट[ होम, कृǒष, उƭोग और हेãथकेयर 
मɅ उपयोग होते हɇ। ये ऑटोमेशन, सटȣकता और द¢ता को बढ़ाते हɇ, लेǑकन नेटवक[  और 
सुर¢ा जैसी चुनौितयɉ का सामना करते हɇ। 
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M4 - R5 
(IoT) 

Chapter – 3 
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Sensors, Actuators & 
Microcontrollers 
सɅसर, एÈचुएटस[ और माइĐोकंĚोलस[ 

● Sensor – Measuring physical 

quantities in digital world e.g. light sensor, 
moisture sensor, temperature sensor, etc. 

  Actuator – Moving or controlling 

systems e.g. DC motor, different types of 
actuators. 

  Controller – Role of microcontroller as 

gateway to interfacing sensors and 
actuators. 

  Microcontroller vs 
Microprocessor 

  Different types of 
microcontrollers in embedded 
ecosystem 
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Sensor - सɅसर : 
Sensors detect the presence of 
energy, changes in or the 
transfer of energy. 
Sensors detect by receiving a 
signal from a device such as a 
transducer, then responding 
to that signal by converting it into an output 
can easily be read and understood. 

सɅसर ऊजा[ कȧ उपǔèथित, पǐरवत[न या ऊजा[ के 

हèतांतरण का पता लगाते हɇ। 

सɅसर एक ĚांसÔयूसर जैसे उपकरण से िसÊनल ĤाƯ 

करके पता लगाते हɇ, Ǒफर उस िसÊनल को एक 

आउटपुट मɅ पǐरवित[त करके इसका जवाब देते हɇ, 

ǔजसे आसानी से पढ़ा और समझा जा सकता है। 

Examples of Sensors: 
  Temperature Sensor 

  Proximity Sensor 
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  Accelerometer 

  IR Sensor (Infrared Sensor) 

  Moisture Sensor 

  Light Sensor 

Two Basic Groups of 

Sensors – सɅसर के दो बेिसक 

Ĥकार 
Active Sensors: 

The effect of the measured physical quantity 
on the sensor changes the electric 
parameters (resistance, inductance, 
capacitance, frequency); therefore, the 
sensor needs a power supply to function 
properly. 
Example: Radar, GPS, X-Ray, Sonar (Sound 
Navigation and Ranging), etc. 
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सǑĐय सɅसर: 

सɅसर पर मापा गया भौितक माğा का Ĥभाव ǒवƭुत 

मापदंडɉ (रेǔज़èटɅस, इंडÈटɅस, कैपेिसटɅस, ĥȧÈवɅसी) 

को बदलता है, इसिलए सɅसर को सहȣ से काम करने 

के िलए ǒबजली कȧ आपूित[ कȧ आवæयकता होती है। 

1. Passive Sensors: 
The effect of the measured physical quantity 
on the sensor does not change the sensor's 
electrical properties. The sensor does not 
need a power supply. 
Example: Photographic, thermal, electric 
field sensing, chemical, infrared, etc. 

िनǔçĐय सɅसर: 

सɅसर पर मापा गया Ǒकसी भौितक माğा के Ĥभाव से 

सɅसर के ǒवƭुत गुण मɅ पǐरवत[न नहȣं होता है। सɅसर 

को ǒबजली कȧ आपूित[ कȧ आवæयकता नहȣं होती है। 

NOTE: 
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All living organs contain biological sensors 
with functions similar to the mechanical 
devices described. 

For example – light: eyes, smell: nose, 

sound: ears, and so on. 

उदाहरण – Ĥकाश: आँखɅ, गंध: नाक, Úविन: कान, 

आǑद। 

Some Important Sensors 

Temperature Sensor – तापमान सɅसर 

A temperature sensor is a device to measure 
the temperature through an electrical signal. 
It requires a thermocouple or RTD 
(Resistance Temperature Detectors). 

DHT, LM35 

ताप 

मान सɅसर एक उपकरण है; एक ǒवƭुत संकेत के 

माÚयम से तापमान को मापने के िलए इसे थमȾकपल 



DIGITAL RK COMPUTER ACADEMY 
website- www.drkca.in, drkca.com 

Address-Moazzampur Karari, Kaushambi 
Mobile no.-708076746, 6387249072,9026672774                                 

या RTD (रेǔज़èटɅस टेàपरेचर ǑडटेÈटर) कȧ 

आवæयकता होती है। 

Some Types of 
Temperature 

Sensors – कुछ 

तापमान सɅसर: 
1. Thermocouples: 
These are voltage devices that indicate 
temperature by a change in voltage. 
As temperature increases, the output voltage 
of the thermocouple rises. 

ये वोãटेज Ǒडवाइस हɇ जो वोãटेज मɅ बदलाव के sसाथ 

तापमान मापने का संकेत देते हɇ। जैसे हȣ तापमान 

बढ़ता है, थमȾकपल का आउटपुट वोãटेज बढ़ जाता 

है। 
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2. Resistor Temperature Detectors 
(RTD): 
The resistance of the device is directly 
proportional to the temperature increasing in 
a positive direction when the temperature 
rises. 

Ǒडवाइस का रेǔजèटɅस तापमान के सीधे अनपुात मɅ 

होता है — जसेै-जसैे तापमान बढ़ता है, रेǔजèटɅस भी 

बढ़ता है। 

3. Thermostats: 
It is a temperature-sensitive resistor that 
changes its physical resistance with the 
change in temperature. 

यह एक टेàपरेचर-सɅिसǑटव रेिसèटर है जो तापमान मɅ 

पǐरवत[न के साथ अपने रेिसèटɅस को बदलता है। 

4. Semiconductor Sensors: 
They are linear devices where the 
conductivity of the semiconductor increases 
linearly with temperature. 
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They provide a direct temperature reading in 
digital form, especially at low temperatures. 

ये रैǔखक उपकरण हɇ जहां समेीकंडÈटर कȧ चालकता 

तापमान के साथ रैǔखक Ǿप से बढ़ती है। 

यह ǒवशेष Ǿप स ेकम तापमान पर Ǒडǔजटल Ǿप मɅ 

सटȣक तापमान रȣǑडंग Ĥदान करते हɇ। 

5. Infrared Sensors: 
They detect temperature by intercepting a 
portion of emitted infrared energy of the 
object or substance, and sensing its 
intensity. 
Used to measure temperature of solids and 
liquids only (not gases due to transparency). 

ये वèतु या पदाथ[ Ʈारा उ×सǔज[त अवरƠ ऊजा[ के एक 

Ǒहèसे को रोककर तापमान का पता लगाते हɇ। 

इनका उपयोग केवल ठोस और तरल पदाथɟ के तापमान 

को मापने के िलए Ǒकया जाता है — गैसɉ के िलए 

नहȣं। 
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Proximity Sensor – 

िनकटता सɅसर 
A device that detects the presence or 
absence of a nearby object, or properties of 
that object, and converts it into a signal 
which can be easily read by a user. 

एक उपकरण जो Ǒकसी नज़दȣकȧ वèतु या उस वèतु के 

गुणɉ कȧ उपǔèथित या अनुपǔèथित का पता लगाता है, 

और इसे एक िसÊनल मɅ पǐरवित[त करता है ǔजसे 

उपयोगकता[ आसानी स ेपढ़ सकता है। 

Some Types of Proximity 

Sensors – कुछ ĤॉǔÈसिमटȣ 

सɅसर 

1. Inductive Sensors: 
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Used for non-contact detection of metallic 
objects using an electromagnetic field or a 
beam of electromagnetic radiation. 
They can operate at higher speeds than 
mechanical switches and are more reliable 
because of robustness. 

इंडǔÈटव ĤॉǔÈसिमटȣ सɅसर का उपयोग ǒबना संपक[  Ǒकए 

धातु कȧ वèतुओं कȧ उपǔèथित का पता लगाने के िलए 

Ǒकया जाता है। 

ये यांǒğक ǔèवचɉ कȧ तुलना मɅ अिधक गित पर काम 

कर सकते हɇ और मज़बूती के कारण अिधक ǒवƳसनीय 

होते हɇ। 

2. Capacitive Sensors: 
Can detect both metallic and non-metallic 
targets. 
Used to sense very small objects and for 
complex or difficult applications. 

कैपेिसǑटव ĤॉǔÈसिमटȣ सɅसर धातु और गैर-धात ुदोनɉ 

Ĥकार कȧ वèतुओं को पहचान सकते हɇ। 
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इनका उपयोग छोटे ऑÞजेÈÒस का पता लगाने या 

जǑटल पǐरǔèथितयɉ मɅ Ǒकया जाता है। 

 

3. Photoelectric Sensors: 
Made of light-sensitive parts; use a beam of 
light to detect presence or absence of an 
object. 
Ideal for long-distance sensing and non-
metal objects. 

फोटोइलेǔÈĚक सɅसर Ĥकाश-सवंेदनशील भागɉ से बने 

होते हɇ और Ǒकसी वèतु कȧ उपǔèथित या अनुपǔèथित 

का पता लगाने के िलए Ĥकाश कȧ Ǒकरण का उपयोग 

करते हɇ। 

ये लंबी दरूȣ के सɅिसंग या गैर-धातु वèतुओ ंके िलए 

आदश[ होते हɇ 

4. Ultrasonic Sensors: 
An ultrasonic sensor measures the distance 
to an object using ultrasonic sound waves. 
Used for distance and presence detection like 
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radar or sonar. 

अãĚासोिनक सɅसर एक उपकरण है जो Úविन तरंगɉ का 

उपयोग करके Ǒकसी वèतु कȧ दरूȣ मापता है। 

इनका उपयोग वèतु कȧ उपǔèथित या दरूȣ मापने के 

िलए Ǒकया जाता है, जैसे रडार या सोनार। 

Pressure Sensor – Ĥेशर सɅसर

 

A pressure sensor senses pressure and 
converts it into an electrical signal. 
The signal amount depends on the level of 
pressure applied. 

Ĥेशर सɅसर दबाव को महसूस करता है और उसे एक 

ǒवƭुत िसÊनल मɅ बदल देता है। 

िसÊनल कȧ माğा लगाए गए दबाव के èतर पर िनभ[र 

करती है। 
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Such sensors are used in many devices that 
rely on liquid or pressure systems, especially 
in IoT applications. 

ऐसे सɅसर का उपयोग कई उपकरणɉ मɅ Ǒकया जाता है 

जो तरल या दबाव पर आधाǐरत होते हɇ, खासकर IoT 

िसèटम मɅ। 

Water Quality Sensor – वॉटर Èवािलटȣ 

सɅसर 

Used to detect water quality and ion 
monitoring, primarily in water distribution 
systems. 
Water is practically used everywhere — hence 
these sensors are used in many industries. 

जल गुणवƣा सɅसर का उपयोग मुÉय Ǿप से जल 

ǒवतरण Ĥणािलयɉ मɅ पानी कȧ गुणवƣा और आयन 

मॉिनटǐरंग का पता लगाने के िलए Ǒकया जाता है। 

पानी लगभग हर जगह उपयोग होता है, इसिलए इन 

सɅसर का उपयोग कई उƭोगɉ मɅ होता है। 



DIGITAL RK COMPUTER ACADEMY 
website- www.drkca.in, drkca.com 

Address-Moazzampur Karari, Kaushambi 
Mobile no.-708076746, 6387249072,9026672774                                 

 

Some of the Water Quality Sensors 

– कुछ वॉटर Èवािलटȣ सɅसर 

1. Chlorine Residual Sensor: 
Measures chlorine residual in water — widely 
used as a disinfectant because of its 
efficiency. 

यह पानी मɅ Èलोरȣन के अवशेष को मापता है और 

द¢ता के कारण सबसे अिधक उपयोग Ǒकया जाने वाला 

कȧटाणनुाशक सɅसर है। 

 

2. Total Organic Carbon (TOC) 
Sensor: 
Measures organic elements in water. 

यह सɅसर पानी मɅ काब[न आधाǐरत (ऑगȶिनक) त×वɉ 

को मापता है। 

3. Turbidity Sensor: 
Measures suspended solids in water; 
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typically used in rivers, streams, and 
wastewater treatment. 

टǒब[Ǒडटȣ सɅसर पानी मɅ ठोस कणɉ कȧ माğा को मापते 

हɇ। 

इनका उपयोग नǑदयɉ, धाराओं, अपिशƴ जल और 

औƭोिगक अपिशƴ िनगरानी मɅ Ǒकया जाता है। 

4. pH Sensor: 
Used to measure the pH level in water — 
determines whether it is acidic or alkaline. 

इसका उपयोग पानी के pH èतर (अàलीय या ¢ारȣय 

होने कȧ ǔèथित) को मापने के िलए Ǒकया जाता है। 

PH = Potential of Hydrogen 

5. Oxygen-Reduction Potential 
(ORP) Sensor: 
Measures oxidation/reduction reactions 
occurring in the solution. 

ओआरपी सɅसर Ǒकसी घोल मɅ होने वाली 

ऑÈसीकरण/अपचयन ĤितǑĐयाओं के èतर को मापता 

है। 
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Chemical Sensor – केिमकल सɅसर 

Chemical sensors are used in various 
industries. 
Their goal is to indicate changes in liquids or 
to detect air chemical changes. 
They are mainly used for industrial 
environmental monitoring and process 
control. 

कई अलग-अलग उƭोगɉ मɅ रासायिनक सɅसर लगाए 

जाते हɇ। 

इनका उƧेæय तरल मɅ पǐरवत[न का सकेंत देना या वायु 

मɅ रासायिनक पǐरवत[न का पता लगाना होता है। 

रासायिनक सɅसर का मुÉय उपयोग औƭोिगक पया[वरण 

िनगरानी और ĤǑĐया िनयğंण मɅ Ǒकया जाता है। 

Gas Sensor – गैस सɅसर 

Gas sensors are similar to chemical sensors 
but are specifically used to monitor air 
quality and detect the presence of various 
gases. 
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Like chemical sensors, they are used in 
industries such as manufacturing, 
agriculture, and healthcare. 
They help in air quality monitoring, detection 
of toxic or combustible gases, and hazardous 
gas monitoring in coal mines, oil & gas 
industries, chemical labs, etc. 

गैस सɅसर रासायिनक सɅसर के समान होते हɇ, लेǑकन 

इनका उपयोग ǒवशेष Ǿप से हवा कȧ गुणवƣा कȧ 

िनगरानी और ǒविभÛन गैसɉ कȧ उपǔèथित का पता 

लगाने के िलए Ǒकया जाता है। 

इनका उपयोग िनमा[ण, कृǒष और èवाèØय जसैे कई 

उƭोगɉ मɅ Ǒकया जाता है। 

ये सɅसर वाय ुगुणवƣा कȧ िनगरानी, ǒवषैली या 

Ïवलनशील गैसɉ का पता लगाने, कोयला खदानɉ मɅ 
खतरनाक गैसɉ कȧ िनगरानी और तेल-गैस उƭोगɉ मɅ 

भी उपयोग Ǒकए जाते हɇ। 
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Examples of Gas Sensors 

– गैस सɅसर के उदाहरण: 
  Carbon Dioxide Sensor 
  Carbon Monoxide Detector 
  Hydrogen Sensor 
  Air Pollution Sensor 
  Nitrogen Oxide Sensor 
  Oxygen Sensor 
  Ozone Monitor 
  MQ-135 

Smoke Sensor – èमोक सɅसर 

A smoke sensor detects smoke (airborne 
particles and gases) and its level. 
These sensors are widely used in 
manufacturing industries, HVAC systems, 
buildings, and residential infrastructure to 
detect fire and gas incidents. 
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They help protect people working in 
dangerous environments. 

èमोक सɅसर एक ऐसा उपकरण है जो धुएं (हवा मɅ 

मौजूद कणɉ और गैसɉ) का पता लगाता है। 

इनका उपयोग िनमा[ण उƭोग, HVAC िसèटम, 

इमारतɉ और आवासीय ¢ेğɉ मɅ आग और गैस से 

संबंिधत घटनाओं का पता लगाने के िलए Ǒकया जाता 

है।यह खतरनाक वातावरण मɅ काम करने वाले लोगɉ कȧ 

सुर¢ा मɅ मदद करता है। 

Level Sensor – लेवल 

सɅसर 

 

 
A sensor that determines 
the level or amount of 
fluids or liquids in an 
open or closed system is 
called a Level Sensor. 
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They are primarily known for measuring fuel 
levels but are also used in many liquid-
handling businesses. 

लेवल सɅसर एक ऐसा उपकरण है जो Ǒकसी खुले या बंद 

िसèटम मɅ तरल पदाथɟ के èतर या माğा को मापने के 

िलए उपयोग Ǒकया जाता है। 

इÛहɅ आमतौर पर Ƀधन èतर मापने के िलए जाना 

जाता है, लेǑकन इनका उपयोग अÛय तरल पदाथɟ 

वाले उƭोगɉ मɅ भी Ǒकया जाता है। 

Image Sensor – इमेज सɅसर 

Image sensors convert optical images into 
electrical signals for display or digital 
storage. 
They are mainly used in digital cameras, 
medical imaging, night vision devices, 
thermal imaging, radar, sonar, media, and 
biometric/IRIS devices. 

इमेज सɅसर ऐसे उपकरण हɇ जो ऑǔÜटकल छǒवयɉ को 

इलेÈĚॉिनक सकेंतɉ मɅ बदलकर उÛहɅ Ǒडǔजटल Ǿप मɅ 
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Ĥदिश[त या सĒंǑहत करने मɅ मदद करते हɇ। 

इनका उपयोग मुÉय Ǿप स ेǑडǔजटल कैमरा, मेǑडकल 

इमेǔजंग, नाइट ǒवज़न, थम[ल इमेǔजंग, रडार, 

सोनार, मीǑडया हाउस, बायोमेǑĚक और आईǐरस 

उपकरणɉ मɅ Ǒकया जाता है। 

Motion Detection Sensor – मोशन 

ǑडटेÈशन सɅसर 

A motion detector detects physical 
movement in a given area and converts it into 
an electrical signal. 
It can detect motion of objects or human 
beings. 

मोशन ǑडटेÈटर एक इलेÈĚॉिनक उपकरण है जो Ǒकसी 

¢ेğ मɅ भौितक गित का पता लगाता है और उसे ǒवƭुत 

संकेत मɅ पǐरवित[त करता है। 

यह वèतुओ ंया मनुçयɉ कȧ गित का पता लगाने के 

िलए Ĥयोग Ǒकया जाता है। 
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Gyroscope Sensor – जाइरोèकोप सɅसर 

A device used to measure angular rate or 
angular velocity is called a Gyroscope Sensor. 
It measures the speed of rotation around an 
axis and is mainly used in navigation and 
orientation monitoring. 

जाइरोèकोप सɅसर कोणीय वेग या घूण[न दर को मापने 

के िलए Ĥयोग Ǒकया जाता है। 

यह Ǒकसी वèतु कȧ Ǒदशा और गित कȧ िनगरानी करता 

है, और नेǒवगेशन Ĥणािलयɉ मɅ Ĥमुख Ǿप स ेउपयोग 

होता है। 

 

Accelerometer Sensor – एÈसेलेरोमीटर 

सɅसर 

An accelerometer measures vibration or 
acceleration of motion of a structure. 
These sensors are found in many devices like 
smartphones. 
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They are used for vibration detection, tilt 
sensing, and acceleration monitoring. 

एÈसेलेरोमीटर एक उपकरण है जो Ǒकसी सरंचना के 

कंपन या गित के ×वरण को मापता है। 

ये सɅसर लाखɉ उपकरणɉ (जैसे èमाट[फ़ोन) मɅ पाए जाते 

हɇ। 

इनका उपयोग कंपन, झकुाव और गित का पता लगाने 

के िलए Ǒकया जाता है। 

Light Sensor – लाइट सɅसर 

 
A light sensor consists of a 
photodiode with an LED at 
the center. 
When light hits the 
photodiode, it produces a 
voltage that is amplified by a microprocessor. 
By analyzing the voltage, the sensor detects 
light intensity. 
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लाइट सɅसर एक साधारण फोटो डायोड होता है ǔजसके 

कɅ ġ मɅ एक एलईडȣ लगी होती है। 

जब Ĥकाश इस पर पड़ता है, तो यह वोãटेज उ×पÛन 

करता है ǔजसे माइĐो Ĥोसेसर Ʈारा बढ़ाया जाता है। 

फोटो डायोड के वोãटेज èतर को देखकर Ĥकाश का 

पता लगाया जा सकता है। 

Example: LDR (Light Dependent 

Resistor) / Photoresistor 

Moisture Sensor – नमी सɅसर 

The Moisture Sensor is used to measure the 
water content (moisture) of soil. 
When the soil has a shortage of water, the 
module output is at a high level; otherwise, it 
is at a low level. 

नमी सɅसर का उपयोग िमÒटȣ कȧ नमी को मापने के 

िलए Ǒकया जाता है। 

जब िमÒटȣ मɅ पानी कȧ कमी होती है, तो मॉÔयूल का 
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आउटपुट उÍच èतर पर होता है, अÛयथा आउटपुट 

िनàन èतर पर होता है। 

Example: DHT11, DHT22 

Humidity Sensor – आġ[ता सɅसर 

The humidity sensor is a device that senses, 
measures, and reports the relative humidity 
(RH) of air or determines the amount of 
water vapor present in a gas mixture (air) or 
pure gas. 

आġ[ता सɅसर एक ऐसा उपकरण है जो हवा कȧ सापे¢ 

आġ[ता (RH) को मापता है और ǐरपोट[ करता है या 

गैस िमĮण (वायु) या शुƨ गसै मɅ मौजदू जलवाçप कȧ 

माğा िनधा[ǐरत करता है। 

Optical Sensor – ऑǔÜटकल सɅसर 

A sensor that measures the physical quantity 
of light rays and converts it into electrical 
signals that can be easily read by a user or an 
electronic device is called an Optical Sensor. 
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Due to this, they are widely used in 
healthcare, environmental monitoring, 
energy, aerospace, and many other 
industries. 

ऑǔÜटकल सɅसर वह उपकरण है जो Ĥकाश Ǒकरणɉ कȧ 

भौितक माğा को मापता है और उसे ǒवƭुत संकेतɉ मɅ 

पǐरवित[त करता है ǔजÛहɅ उपयोगकता[ या कोई 

इलेÈĚॉिनक यंğ आसानी से पढ़ सकता है। 

इसी कारण इनका उपयोग èवाèØय सेवाओ,ं पया[वरण 

िनगरानी, ऊजा[, एयरोèपेस और कई अÛय उƭोगɉ मɅ 

Ǒकया जाता है। 

Actuator - गत देने वाला 

An actuator is something that actuates or 
moves something. 
An actuator converts energy into motion or 
mechanical energy. 
An actuator requires a control signal and a 
source of energy. 
Actuators are typically used in manufacturing 
or industrial applications and might be used 
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in devices such as motors, pumps, switches, 
and valves. 

एक एÈचुएटर एक ऐसी वèतु है जो Ǒकसी वèतु को 

सǑĐय करता है या गित Ĥदान करता है। 

एक एÈचुएटर ऊजा[ को गित या यांǒğक ऊजा[ मɅ 

पǐरवित[त करता है। 

एÈचुएटर को एक िनयंğण िसÊनल और ऊजा[ İोत कȧ 

आवæयकता होती है। 

एÈचुएटर आमतौर पर ǒविनमा[ण या औƭोिगक 

अनुĤयोगɉ मɅ उपयोग Ǒकए जाते हɇ और इनका उपयोग 

मोटर, पंप, ǔèवच और वाãव जैसे उपकरणɉ मɅ Ǒकया 

जा सकता है। 

 

(Moving or controlling system e.g. 
DC motor) 

िसèटम को èथानांतǐरत करना 
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या िनयǒंğत करना जैसे - 

डȣसी मोटर 
DC motor speed control is one of the most 
useful features of the motor. 
By controlling the speed of the motor, you 
can vary the speed according to 
requirements and get the desired operation. 

डȣसी मोटर गित िनयंğण मोटर कȧ सबसे उपयोगी 

ǒवशेषताओं मɅ से एक है। 

मोटर कȧ गित को िनयंǒğत करके, आप आवæयकता 

अनुसार गित को बदल सकते हɇ और आवæयक 

ऑपरेशन ĤाƯ कर सकते हɇ। 

A DC motor is any of a class of rotary 
electrical motors that converts direct current 
electrical energy into mechanical energy. 
In a practical DC motor, when the conductor 
(armature) is supplied with current, it 
produces its own magnetic flux. 
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The magnetic flux either adds up to or 
cancels out the magnetic flux due to the field 
windings. 
The accumulation of magnetic flux in one 
direction exerts a force on the conductor, 
and therefore, it starts rotating. 

एक डȣसी मोटर रोटरȣ ǒवƭुत मोटर का एक वग[ है जो 

डȣसी ǒवƭुत ऊजा[ को यांǒğक ऊजा[ मɅ पǐरवित[त करता 

है। 

डȣसी मोटर मɅ, जब कंडÈटर (आमȶचर) को करंट Ǒदया 

जाता है, तो यह अपना èवयं का चुंबकȧय ÝलÈस 

उ×पÛन करता है। 

यह ÝलÈस फȧãड वाइंǑडंग Ʈारा उ×पÛन ÝलÈस के 

साथ या तो जड़ुता है या उसे िनरèत करता है। 

एक Ǒदशा मɅ ÝलÈस का सचंय कंडÈटर पर बल लगाता 

है, ǔजससे यह घूमना शुǾ कर देता है। 

Types of Actuators – 

ǒविभÛन Ĥकार के एÈचुएटर 
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1. Electric Actuators – इलेǔÈĚकल 

एÈचुएटर 

An electric actuator may provide actuation 
force/torque in several ways. 
Electromechanical actuators power a motor 
that converts electrical energy into 
mechanical torque. 
This type of actuator is generally powered by 
a motor (DC, AC, or Stepper) that converts 
electrical energy into mechanical motion. 
एक इलेǔÈĚक एÈचुएटर कई तरȣकɉ से बल या टॉक[  

Ĥदान कर सकता है। 

इलेÈĚोमैकेिनकल एÈचुएटर एक मोटर को शǒƠ देते हɇ 

जो ǒवƭुत ऊजा[ को यांǒğक टॉक[  मɅ बदलता है। 

इस Ĥकार के एÈचुएटर आमतौर पर मोटर (डȣसी 

मोटर, एसी मोटर, या èटेपर मोटर) Ʈारा संचािलत 

होते हɇ जो ǒवƭतु ऊजा[ को याǒंğक गित मɅ पǐरवित[त 

करते हɇ। 
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2. Hydraulic Actuators – हाइĜॉिलक 

एÈचुएटर 

A hydraulic actuator consists of a cylinder or 
fluid motor that uses hydraulic power to 
facilitate mechanical operation. 
The motion output can be linear, rotary, or 
oscillatory. 
Because liquids are almost incompressible, a 
hydraulic actuator can exert a considerable 
amount of force. 
These are used to operate tools like balers, 
cranes, excavators, loaders, and presses. 

हाइĜॉिलक एÈचुएटर मɅ एक िसिलंडर या Ýलुइड मोटर 

होता है जो यांǒğक सचंालन को सुगम बनाने के िलए 

हाइĜॉिलक पावर का उपयोग करता है। 

इसकȧ यांǒğक गित रैǔखक, घूण[नशील यादोलनशील हो 

सकती है। 
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3. Pneumatic Actuators – ÛयूमैǑटक 

एÈचुएटर 

A pneumatic actuator uses energy from 
compressed air or vacuum at high pressure to 
produce either linear or rotary motion. 

Example: Used in robotics — sensors that 

function like human fingers using 
compressed air. 

एक वायवीय (ÛयूमैǑटक) एÈचुएटर उÍच दबाव वाली 

संपीǑड़त हवा या वÈैयूम से उ×पÛन ऊजा[ का उपयोग 

रैǔखक या घणूȸ गित उ×पÛन करने के िलए करता है। 

उदाहरण: रोबोǑटÈस मɅ ऐसे सɅसरɉ मɅ उपयोग होता 

है जो संपीǑड़त हवा के माÚयम से मानव उंगिलयɉ कȧ 

तरह काय[ करते हɇ। 

4. Mechanical Actuators – मैकेिनकल 

एÈचुएटर 
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A mechanical actuator converts one type of 
motion (such as rotary) into another (such as 
linear). 

Example: Rack and pinion mechanism. 

Operation is based on structural components 
like gears and rails or pulleys and chains. 

एक यांǒğक (मकेैिनकल) एÈचुएटर एक Ĥकार कȧ गित 

(जैस ेघूणȸ) को दसूरे Ĥकार कȧ गित (जसैे रैǔखक) मɅ 

पǐरवित[त करता है। 

उदाहरण: रैक और ǒपिनयन तंğ। 

इनका संचालन संरचना×मक घटकɉ जैस ेिगयर, रेल, 

पुली और चेन पर आधाǐरत होता है। 

ÈयɉǑक ġव को संपीǑड़त करना लगभग असभंव होता है, 

हाइĜॉिलक एÈचुएटर बहुत अिधक बल लगा सकता है। 

इनका उपयोग बेलर, Đेन, खुदाई मशीन, लोडर और 

Ĥेस जैसे उपकरणɉ को संचािलत करने के िलए Ǒकया 

जाता है। 
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5. Thermal / Magnetic Actuators – 

थम[ल / मÊैनेǑटक एÈचुएटर 

These actuators can be activated by applying 
thermal or magnetic energy. 
They are compact, lightweight, economical, 
and have high power density. 
They use shape memory materials (SMMs) 
such as Shape Memory Alloys (SMAs) or 
Magnetic Shape Memory Alloys (MSMAs). 

इन Ĥकार के एÈचुएटर को थम[ल या चुंबकȧय ऊजा[ 

लागू करके सǑĐय Ǒकया जा सकता है। 

ये आकार मɅ छोटे, हãके, Ǒकफायती और उÍच शǒƠ 

घन×व वाले होते हɇ। 

इनमɅ “शेप मेमोरȣ मटेǐरयल” (SMM) जैसे “शेप मेमोरȣ 

एलॉय” (SMA) या “मैÊनǑेटक शेप मेमोरȣ एलॉय” 

(MSMA) का उपयोग Ǒकया जाता है। 
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Controller or 

Microcontroller – कंĚोलर 

और माइĐोकंĚोलर 
A controller or microcontroller is also known 
as an embedded controller. 
A microcontroller is a semiconductor IC 
(Integrated Circuit) chip consisting of 
multiple functional blocks such as CPU, ROM, 
RAM, EPROM, Timer, Counter & Interrupts 
etc. 
It is essentially a small computer with all 
peripherals inside a single package that can 
be used as an embedded system. 
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एक कंĚोलर या माइĐोकंĚोलर को एàबेडेड कंĚोलर के 

Ǿप मɅ भी जाना जाता है। 

एक माइĐोकंĚोलर एक सेमीकंडÈटर IC (इंटȣĒेटेड 

सǑक[ ट) िचप होता है ǔजसमɅ कई काया[×मक Þलॉक 

होते हɇ, जैसे CPU, ROM, RAM, EPROM, 

Timer, Counter और Interrupts आǑद। 

यह मूलतः एक छोटा कंÜयूटर होता है ǔजसमɅ सभी 

पेǐरफेरãस एक हȣ  

पैकेज मɅ होते हɇ और इसका उपयोग एक एàबेडेड 

िसèटम के Ǿप मɅ Ǒकया जा सकता है। 

Sometimes referred to as an Embedded 
Controller or Microcontroller Unit (MCU), 
microcontrollers are found in vehicles, 
robots, office machines, medical devices, 
mobile radio transceivers, vending machines, 
and home appliances. 

कभी-कभी इसे एàबेडेड कंĚोलर या माइĐोकंĚोलर 

यूिनट (MCU) कहा जाता है। 
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माइĐोकंĚोलर वाहनɉ, रोबोÒस, काया[लय मशीनɉ, 

िचǑक×सा उपकरणɉ, मोबाइल रेǑडयो Ěांसीवर, वɅǑडंग 

मशीनɉ और घरेलू उपकरणɉ मɅ पाए जाते हɇ। 

Role of Microcontroller as Gateway to 
Interfacing Sensors and Actuators 

सɅसर और एÈचुएटस[ के इंटरफेिसंग मɅ माइĐोकंĚोलर 

कȧ भूिमका 

Main Role of the Microcontroller – 

माइĐोकंĚोलर कȧ मुÉय भूिमका 

It satisfies market needs; microcontrollers 
have so many features and are designed to 
meet embedded system requirements. 
That means it performs functions only for its 
embedded system purpose. 

यह बाजार कȧ आवæयकताओ ंको पूरा करता है; 

माइĐोकंĚोलर मɅ कई ǒवशेषताएँ होती हɇ और यह 

एàबेडेड िसèटम कȧ ज़Ǿरतɉ को पूरा करने के िलए 

Ǒडज़ाइन Ǒकया गया है। 
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इसका मतलब है Ǒक यह केवल अपने एàबेडेड िसèटम 

उƧेæय के िलए काय[ करता है। 

  It simplifies the complexity of market 
needs. 

यह बाजार कȧ ज़Ǿरतɉ कȧ जǑटलता को सरल करता है। 

  It acts as a motivational factor for the 
embedded system market. 

यह एàबेडेड िसèटम बाजार के िलए Ĥेरणादायक त×व 

का काय[ करता है। 

  Microcontrollers help to make innovations 
(standard applications). 

माइĐोकंĚोलर नवाचारɉ (मानक अनुĤयोगɉ) को 

ǒवकिसत करने मɅ मदद करते हɇ। 

Power Consumption Factor – ǒबजली 

कȧ खपत का कारक 

Microcontrollers require less energy — this is a 
key factor that satisfies user needs. 

हम जानते हɇ Ǒक माइĐोकंĚोलर को बहुत कम ऊजा[ कȧ 
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आवæयकता होती है, यहȣ कारण है Ǒक यह 

उपयोगकता[ओं कȧ जǾरतɉ को Ĥभावी ढंग से पूरा करता 

है। 

Heart of the Embedded System – 

एàबेडेड िसèटम का ǿदय 

Microcontrollers are the heart of embedded 
systems; they give life to embedded 
applications. 
The invention of microcontrollers brought 
revolutionary changes in embedded 
technology. 

माइĐोकंĚोलर एàबेडेड िसèटम का “Ǒदल” हɇ — ये 

एàबेडेड अनुĤयोगɉ को जीवन देते हɇ। 

माइĐोकंĚोलर के आǒवçकार ने एàबेडेड टेÈनोलॉजी मɅ 

अĤ×यािशत बदलाव Ǒकए। 

Microcontroller vs Microprocessor 

– माइĐोकंĚोलर बनाम माइĐोĤोसेसर 
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Both microprocessors and microcontrollers 
are IC-based electronic devices used in 
modern equipment such as computers, 
laptops, washing machines, air conditioners, 
etc. 
Their primary function is to automate 
processes. 

माइĐोĤोससेर और माइĐोकंĚोलर दोनɉ हȣ इंटȣĒेटेड 

सǑक[ ट (IC) आधाǐरत इलेÈĚॉिनक Ǒडवाइस हɇ ǔजनका 

उपयोग कंÜयटूर, लैपटॉप, वॉिशंग मशीन, एयर 

कंडȣशनर और अÛय उपकरणɉ मɅ Ǒकया जाता है। 

दोनɉ का मुÉय उƧेæय ĤǑĐयाओं का èवचालन 

(Automation) करना है। 

What is a Microprocessor? 
It is a processing device that converts data 
into information based on a set of 
instructions. 
It is a compact electronic chip and the most 
crucial component of a computer or 
computing device. 
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It processes data and produces output based 
on the given instructions. 

यह एक Ĥोसेिसंग Ǒडवाइस है जो िनदȶशɉ के आधार पर 

डेटा को सचूना मɅ पǐरवित[त करता है। 

यह एक बहुत कॉàपैÈट इलेÈĚॉिनक िचप है और 

कंÜयूटर का सबसे मह×वपणू[ घटक है। 

यह िनदȶशɉ के अनुसार डेटा को Ĥोसेस करके सूचना 

उ×पÛन करता है। 

Example: Intel 8085, Intel 8086 

What is a Microcontroller? 
A microcontroller is a compact electronic 
system that contains a processing element, 
small memory (RAM, ROM, EPROM), and I/O 
ports on a single chip. 
Hence, it is like a miniature version of a 
microcomputer. 
It is small, low-cost, and serves as the main 
functional device in appliances like 
microwaves, washing machines, and smart 
refrigerators. 
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माइĐोकंĚोलर एक छोटा इलेÈĚॉिनक िसèटम है ǔजसमɅ 

Ĥोसेिसंग यूिनट, छोटȣ मेमोरȣ (RAM, ROM, 

EPROM) और I/O पोट[ एक हȣ िचप मɅ होते हɇ। 

यह मूल Ǿप से माइĐो कंÜयूटर का छोटा Ǿप है। 

यह कम लागत वाला और छोटा Ǒडवाइस है, ǔजसका 

उपयोग घरेलू और औƭोिगक उपकरणɉ मɅ मुÉय 

िनयंğक के Ǿप मɅ Ǒकया जाता है। 

Microcontroller 

(माइĐोकंĚोलर) 

Microprocessor 

(माइĐोĤोसेसर) 

Acts as the heart of an 
embedded system.  

एàबेडेड िसèटम का ǿदय। 

Acts as the heart of 
a computer system. 

कंÜयूटर िसèटम का 

ǿदय। 

Memory & I/O 
components are 

internal, making the 
circuit less complex. 

Memory & I/O are 
external, making 
the circuit more 

complex. 

Used mainly in washing Used mainly in 
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Microcontroller 

(माइĐोकंĚोलर) 

Microprocessor 

(माइĐोĤोसेसर) 

machines, air 
conditioners, etc. 

personal 
computers. 

More efficient. Less efficient. 

Has more registers. Has fewer registers. 

Can be used with 
compact systems. 

Cannot be used in 
compact systems. 

Embedded System – एàबेडेड िसèटम 

An Embedded System is a combination of 
computer software and hardware, either 
fixed or programmable. 
Example: Fire Alarm — it can sense only 
smoke. 

एàबेडेड िसèटम कंÜयूटर हाड[वेयर और सॉāटवेयर का 

संयोजन होता है जो या तो ǔèथर होता है या ĤोĒाम 

योÊय। 
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उदाहरण: फायर अलाम[ — जो केवल धुआ ंपहचान 

सकता है। 

Types of Microcontrollers in Embedded 
Ecosystem 

Microcontrollers are categorized according to 
Memory, Architecture, Bus Width, and 
Instruction Set. 

माइĐोकंĚोलर को उनकȧ मेमोरȣ, आǑक[ टेÈचर, बस 

चौड़ाई, और िनदȶश सेट के आधार पर वगȸकृत Ǒकया 

गया है। 

According to Bus Width – बस चौड़ाई 

के अनसुार 

The       refers to parallel connections 
between microcontroller components that 
transmit instructions and data. 
Based on bus width, microcontrollers are 
divided into: 
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8-bit, 16-bit, and 32-bit 
microcontrollers. 

“बस” माइĐोकंĚोलर के घटकɉ के बीच समानांतर 

लाइनɉ का समहू है जो िनदȶश और डेटा का संचार 

करती हɇ। 

बस चौड़ाई के आधार पर माइĐोकंĚोलर तीन Ĥकार के 

होते हɇ: 

8-ǒबट, 16-ǒबट, और 32-ǒबट 

माइĐोकंĚोलर। 

According to Bus Width – बस चौड़ाई 

के अनसुार 

The       refers to parallel connections 
between microcontroller components that 
transmit instructions and data. 
Based on bus width, microcontrollers are 
divided into: 
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8-bit, 16-bit, and 32-bit 
microcontrollers. 

“बस” माइĐोकंĚोलर के घटकɉ के बीच समानांतर 

लाइनɉ का समहू है जो िनदȶश और डेटा का संचार 

करती हɇ। 

बस चौड़ाई के आधार पर माइĐोकंĚोलर तीन Ĥकार के 

होते हɇ: 

8-ǒबट, 16-ǒबट, और 32-ǒबट 

माइĐोकंĚोलर।  

According to Memory 

Devices – मेमोरȣ 

Ǒडवाइस के अनुसार 
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Microcontrollers need memory (RAM, ROM, 
EPROM, EEPROM, Flash Memory, etc.) to 
store programs and data. 
Based on the memory configuration, 
microcontrollers are divided into two types: 

माइĐोकंĚोलर को ĤोĒाम और डेटा èटोर करने के िलए 

मेमोरȣ (RAM, ROM, EPROM, EEPROM, Flash 

Memory आǑद) कȧ आवæयकता होती है। 

मेमोरȣ कॉǔÛफ़गरेशन के आधार पर इÛहɅ दो Ĥकारɉ मɅ 

बाँटा गया है: 

1. Embedded Memory 

Microcontroller – एàबेडेड मेमोरȣ 

माइĐोकंĚोलर 

In this type, both data and program memory 
are embedded into the IC itself. 
For example – 8051 microcontroller contains 
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program & data memory, I/O ports, serial 
communication, counters, timers, and 
interrupts. 

इस Ĥकार के माइĐोकंĚोलर मɅ डेटा और ĤोĒाम 

मेमोरȣ दोनɉ IC के अंदर एàबेडेड होती हɇ। 

उदाहरण: 8051 माइĐोकंĚोलर, ǔजसमɅ ĤोĒाम और 

डेटा ममेोरȣ, I/O पोट[, सीǐरयल कàयुिनकेशन, 

काउंटर, टाइमर और इंटरÜÒस — सब एक हȣ िचप मɅ 

होते हɇ। 

2. External Memory 

Microcontroller – बाहरȣ मेमोरȣ 

माइĐोकंĚोलर 

These microcontrollers do not have program 
memory embedded on the chip and require 
an external chip for the same. 
For example – 8031 microcontroller has no 
internal program memory and requires an 
external memory chip. 
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इन माइĐोकंĚोलर मɅ ĤोĒाम मेमोरȣ िचप के अदंर नहȣं 

होती और इसके िलए बाहरȣ मेमोरȣ िचप कȧ 

आवæयकता होती है। 

उदाहरण: 8031 माइĐोकंĚोलर, ǔजसमɅ कोई 

आंतǐरक ĤोĒाम मेमोरȣ नहȣं होती। 

According to Instruction Set – 

इंèĚÈशन सेट के अनसुार 

The instruction set (ISA – Instruction Set 
Architecture) defines how the CPU executes 
commands. 
Based on this, microcontrollers are classified 
into two types: 

इंèĚÈशन सेट (ISA – Instruction Set 

Architecture) यह िनधा[ǐरत करता है Ǒक CPU 

िनदȶशɉ को कैसे िनçपाǑदत करता है। 

इसके आधार पर माइĐोकंĚोलर दो Ĥकार के होते हɇ: 
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1. CISC (Complex Instruction Set 

Computer) – जǑटल िनदȶश सेट कंÜयूटर 

This type of microcontroller’s CPU is designed 
to execute a single complex command that 
performs multiple operations. 
It can execute several steps using a single 
instruction. 

CISC माइĐोकंĚोलर का CPU इस Ĥकार बनाया 

जाता है Ǒक वह एक हȣ जǑटल िनदȶश से कई काय[ कर 

सके। 

यह एक हȣ इंèĚÈशन से कई ऑपरेशन कर सकता है। 

2. RISC (Reduced Instruction Set 

Computer) – सीिमत िनदȶश सेट कंÜयूटर 

This type of microcontroller’s CPU is designed 
to execute smaller and simpler instructions. 
RISC processors are faster and consume less 
power. 
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RISC माइĐोकंĚोलर का CPU छोटे और सरल िनदȶशɉ 

को तेज़ी से िनçपाǑदत करने के िलए बनाया गया है। 

ये Ĥोसेसर तेज़ होते हɇ और कम ऊजा[ कȧ खपत करते 

हɇ। 

According to Architecture – 

आǑक[ टेÈचर के अनसुार 

Microcontrollers are classified into two types 
according to architecture: 

माइĐोकंĚोलर को उनकȧ संरचना के आधार पर दो 

Ĥकारɉ मɅ वगȸकृत Ǒकया गया है: 

. Harvard Architecture 

Microcontroller – हाव[ड[ आǑक[ टेÈचर 

माइĐोकंĚोलर 

It has physically separate memory for 
program (instructions) and data. 
Hence, both can be accessed simultaneously, 
which increases processing speed. 
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Example: Most modern embedded 

controllers. 

इस Ĥकार के माइĐोकंĚोलर मɅ ĤोĒाम (िनदȶश) और 

डेटा के िलए अलग-अलग मेमोरȣ होती है। 

इससे दोनɉ को एक साथ एÈसेस Ǒकया जा सकता है, 

ǔजससे िनçपादन कȧ गित बढ़ जाती है। 

उदाहरण: अिधकांश आधुिनक एàबेडेड कंĚोलर। 

2. Von Neumann (Princeton) 

Architecture Microcontroller – वॉन 

Ûयूमैन (ǒĤंसटन) आǑक[ टेÈचर 

माइĐोकंĚोलर 

It uses a single memory for both program 
and data storage. 
This concept was proposed by John Von 
Neumann (1945) and is widely used in 
computers and laptops. 
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इस आǑक[ टेÈचर मɅ ĤोĒाम और डेटा दोनɉ के िलए एक 

हȣ मेमोरȣ का उपयोग Ǒकया जाता है। 

यह अवधारणा जॉन वॉन Ûयूमैन Ʈारा 1945 मɅ 

Ĥèतुत कȧ गई थी और आज भी कंÜयूटरɉ और लैपटॉप 

मɅ सबसे अिधक उपयोग कȧ जाती है। 

Various Types of Commonly Used 

Microcontrollers – सामाÛयतः उपयोग 

Ǒकए जाने वाले माइĐोकंĚोलर के Ĥकार 

1. 8051 Microcontroller – 8051 

माइĐोकंĚोलर 

Developed by Intel in 1981, it is an 8-bit 
microcontroller having a 40-pin DIP package, 
4KB ROM, 128 bytes RAM, and two 16-bit 
timers. 
It has four parallel 8-bit ports, all 
programmable and addressable. 
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इंटेल Ʈारा 1981 मɅ ǒवकिसत, यह एक 8-ǒबट 

माइĐोकंĚोलर है ǔजसमɅ 40 ǒपन DIP पैकेज, 

4KB ROM, 128 बाइट RAM, और दो 16-ǒबट 

टाइमर होते हɇ। 

इसमɅ चार समानांतर 8-ǒबट पोट[ होते हɇ, जो सभी 

ĤोĒामेबल और एĜेसेबल होते हɇ। 

It is widely used in automobile systems, 
robotics, medical equipment, and industrial 
machines. 

इसका उपयोग åयापक Ǿप स ेऑटोमोबाइल िसèटम, 

रोबोǑटÈस, मेǑडकल उपकरण और औƭोिगक मशीनɉ 

मɅ Ǒकया जाता है। 

2. ARM Microcontrollers – ए.आर.एम. 

माइĐोकंĚोलर 

ARM stands for Advanced RISC Machine. 
It is based on RISC architecture and provides 
high-speed instruction execution. 
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Used in mobile phones, tablets, multimedia 
devices, and wearable electronics. 

ARM का अथ[ है Advanced RISC Machine। 

यह RISC आǑक[ टेÈचर पर आधाǐरत होता है और 

तेज़ िनदȶश िनçपादन कȧ सǒुवधा Ĥदान करता है। 

इसका उपयोग मोबाइल फोन, टैबलेट, मãटȣमीǑडया 

Ǒडवाइसेज़ और ǒवयरेबल इलÈेĚॉिनÈस मɅ Ǒकया जाता 

है। 

It is a 32-bit RISC processor, compact, 
power-efficient, and ideal for embedded 
applications. 

यह एक 32-ǒबट RISC Ĥोसेसर है, जो आकार मɅ 

छोटा, ऊजा[-कुशल और एàबेडेड एÜलीकेशन के िलए 

उपयƠु होता है। 

3. PIC Microcontrollers – पी.आई.सी. 

माइĐोकंĚोलर 
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PIC stands for Peripheral 
Interface Controller. 
It is based on Harvard 
Architecture and made by 
Microchip Technology 

 

. 
It is programmable using Assembly, C, or 
Basic-C language. 

PIC का अथ[ है Peripheral Interface Controller। 

यह हाव[ड[ आǑक[ टेÈचर पर आधाǐरत है और इसे 

Microchip Technology Ʈारा िनिम[त Ǒकया जाता 

है। 

इस ेAssembly, C या Basic-C भाषा मɅ ĤोĒाम 

Ǒकया जा सकता है। 

Used in vehicles, robotics, vending machines, 
office automation, and medical devices. 



DIGITAL RK COMPUTER ACADEMY 
website- www.drkca.in, drkca.com 

Address-Moazzampur Karari, Kaushambi 
Mobile no.-708076746, 6387249072,9026672774                                  

इसका उपयोग वाहनɉ, रोबोǑटÈस, वɅǑडंग मशीनɉ, 

काया[लय èवचालन, और िचǑक×सा उपकरणɉ मɅ 

Ǒकया जाता है। 

 
 

Used in vehicles, robotics, vending machines, 
office automation, and medical devices. 

इसका उपयोग वाहनɉ, रोबोǑटÈस, वɅǑडंग मशीनɉ, 

काया[लय èवचालन, और िचǑक×सा उपकरणɉ मɅ 

4. AVR Microcontrollers – ए.वी.आर. 

माइĐोकंĚोलर 

AVR stands for Alf and Vegard’s RISC 
Processor. 
It was developed by Atmel Corporation and is 
based on a modified Harvard architecture. 
AVR controllers are faster than PIC and 8051 
microcontrollers. 



DIGITAL RK COMPUTER ACADEMY 
website- www.drkca.in, drkca.com 

Address-Moazzampur Karari, Kaushambi 
Mobile no.-708076746, 6387249072,9026672774                                  

AVR का अथ[ है Alf and Vegard’s RISC 

Processor। 

यह Atmel Corporation Ʈारा ǒवकिसत Ǒकया गया 

है और संशोिधत हाव[ड[ आǑक[ टेÈचर पर आधाǐरत है। 

AVR माइĐोकंĚोलर PIC और 8051 माइĐोकंĚोलरɉ 

से तेज़ होते हɇ। 

Examples: ATmega16, ATmega32, 
ATmega64 

उदाहरण: ATmega16, ATmega32, 
ATmega64 

Applications of Microcontrollers – 

माइĐोकंĚोलर के अनĤुयोग 

Microcontrollers are used in: 

 Robotics 

 Home appliances (TV, Washing Machine, 
Microwave Oven) 

 Automobiles 
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 Industrial control systems 

 Communication devices 

माइĐोकंĚोलर का उपयोग िनàन ¢ेğɉ मɅ Ǒकया जाता 

है: 

 रोबोǑटÈस 

 घरेलू उपकरण (टȣवी, वॉिशंग मशीन, माइĐोवेव 

ओवन) 

 ऑटोमोबाइल 

 औƭोिगक िनयंğण Ĥणाली 

Parts of Embedded System – एàबेडेड 

िसèटम के भाग 

An embedded system consists of both 
hardware and software. 
Hardware includes CPU, Memory, 
Input/Output Ports, Timers, Counters, and 
Communication Interfaces. 
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एàबेडेड िसèटम हाड[वेयर और सॉāटवेयर दोनɉ से 

िमलकर बना होता है। 

हाड[वेयर भागɉ मɅ CPU, मेमोरȣ, इनपटु/आउटपुट 

पोट[, टाइमर, काउंटर और कàयुिनकेशन इंटरफेस 

शािमल होते हɇ। 

1. CPU (Central Processing Unit) – 

सɅĚल Ĥोसेिसंग यूिनट 

The CPU is the brain of the embedded 
system. 
It performs all arithmetic and logical 
operations, processes data, and controls 
other units of the system. 
It executes program instructions stored in 
memory. 

CPU एàबेडेड िसèटम का “मǔèतçक” होता है। 

यह सभी गणना×मक और ताǑक[ क ǑĐयाए ँकरता है, 

डेटा Ĥोसेस करता है और िसèटम कȧ अÛय इकाइयɉ को 

िनयंǒğत करता है। 
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यह मेमोरȣ मɅ संĒहȣत ĤोĒाम िनदȶशɉ को िनçपाǑदत 

करता है। 

2. Memory – मेमोरȣ 

Memory is used to store programs and data. 
It is mainly of two types: 

मेमोरȣ का उपयोग ĤोĒाम और डेटा को संĒǑहत करने 

के िलए Ǒकया जाता है। 

इसके दो Ĥमुख Ĥकार होते हɇ: 

a. ROM (Read Only Memory) – 

Used for permanent program storage. 

b. RAM (Random Access Memory) 
– Used for temporary data storage during 
execution. 

a. ROM (रȣड ओनली मेमोरȣ) – èथायी Ǿप 

से ĤोĒाम को èटोर करने के िलए उपयोग कȧ जाती है। 

b. RAM (रɇडम एÈसेस मेमोरȣ) – ĤोĒाम के 
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िनçपादन के दौरान अèथायी डेटा èटोरेज के िलए 

उपयोग होती है। 

3. I/O Ports (Input/Output Ports) – 

इनपुट / आउटपुट पोट[ 

Input ports are used to receive signals from 
sensors or user input devices. 
Output ports are used to send control signals 
to actuators or display devices. 

4. Timers – टाइमर 

Timers are used to generate time delays, 
schedule events, or measure time intervals. 
They help in controlling tasks at fixed 
intervals and synchronize system operations. 

टाइमर का उपयोग समयांतराल उ×पÛन करने, 

घटनाओं को िनधा[ǐरत करने और समय मापने के िलए 

Ǒकया जाता है। 

यह िनǔƱत अतंराल पर कायɟ को िनयǒंğत करने और 
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िसèटम सचंालन को िसंĐनाइज़ करने मɅ मदद करते 

हɇ। 

 

इनपुट पोट[ सɅसर या उपयोगकता[ उपकरणɉ से िसÊनल 

ĤाƯ करने के िलए उपयोग Ǒकए जाते हɇ। 

आउटपुट पोट[ एÈÒयूएटस[ या ǑडèÜले Ǒडवाइस को 

िनयंğण िसÊनल भेजने के िलए उपयोग Ǒकए जाते हɇ। 

5. Counters – काउंटर 

Counters are used to count external events or 
internal pulses within the system. 
They are useful in frequency measurement 
and event counting applications. 

काउंटर का उपयोग िसèटम के अंदर बाहरȣ घटनाओं या 

आंतǐरक पãस कȧ गणना करने के िलए Ǒकया जाता है। 

इनका उपयोग ĥȧÈवɅसी मापन और इवɅट काउंǑटंग जैसे 

अनुĤयोगɉ मɅ Ǒकया जाता है। 
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6. ADC (Analog to Digital 

Converter) – एनालॉग टू Ǒडǔजटल 

कनवट[र 

ADC converts analog signals from sensors 
into digital form which the microcontroller 
can process. 
It is essential in IoT and embedded systems 
where sensors output analog data. 

ADC सɅसर से आने वाले एनालॉग िसÊनल को 

Ǒडǔजटल Ǿप मɅ बदलता है ताǑक माइĐोकंĚोलर उÛहɅ 

Ĥोसेस कर सके। 

यह IoT और एàबेडेड िसèटम मɅ अ×यंत आवæयक 

होता है, ÈयɉǑक सɅसर Ĥायः एनालॉग आउटपुट देते हɇ। 

 7. Communication Interface – 

कàयुिनकेशन इंटरफेस 

Used for data exchange between 
microcontrollers, sensors, and other external 
devices. 
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Common communication protocols include 
UART, SPI, and I²C. 

कàयुिनकेशन इंटरफेस माइĐोकंĚोलर, सɅसर और अÛय 

बाहरȣ उपकरणɉ के बीच डेटा के आदान-Ĥदान के िलए 

उपयोग Ǒकया जाता है। 

सामाÛय संचार Ĥोटोकॉल हɇ — UART, SPI, और 

I²C। 

–
Security and 

Future of IoT Ecosystem
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(IoT पाǐरतंğ कȧ सुर¢ा और 

भǒवçय) 

1. Need of Security in IoT – Why 
Security? 

(IoT मɅ सुर¢ा कȧ आवæयकता Èयɉ है?) 

Every connected device creates opportunities 
for attackers. 

→ Ĥ×येक connected Ǒडवाइस हमलावरɉ के िलए 

अवसर पदैा करता है 

Every connected device creates opportunities 
for attackers. 

कमजोǐरयाँ छोटे उपकरणɉ मɅ भी होती हɇ — जोǔखमɉ 

मɅ शािमल हɇ    

 Data transfer issues (डेटा èथानांतरण 

समèयाएँ) 
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 Unauthorized device access (अनिधकृत 

Ǒडवाइस एÈससे) 

 Malfunctioning devices (Ǒडवाइस का खराब 

होना) 

 Always-on / always-connected devices 

(हमेशा चाल ू/ कनेÈटेड उपकरण) 

 Main challenges in IoT security: 

IoT सुर¢ा कȧ मुÉय चुनौितयाँ : 

 Low-cost device production limits 
security features. 

(कम लागत वाले उपकरणɉ मɅ सीिमत सुर¢ा 
सुǒवधाएँ होती हɇ) 

Increasing number of devices creates more 
attack opportunities. 
(Ǒडवाइसɉ कȧ बढ़ती संÉया से हमलɉ के अवसर बढ़ते 
हɇ) 

2. Privacy for IoT-Enabled Devices 
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(IoT-स¢म उपकरणɉ मɅ गोपनीयता) 

 (a) Secure the IoT Network (IoT 

नेटवक[  को सुरǔ¢त करɅ): 

  Protect IoT devices connected to backend 
systems using traditional endpoint security 
features: 
Antivirus, Anti-malware, Firewalls, 
Intrusion Prevention & Detection Systems. 

 एंटȣवायरस, एटंȣ-मालवेयर, फायरवॉल और घुसपैठ 

रोकथाम/पहचान Ĥणाली का उपयोग करɅ। 

 (b) Authenticate the IoT Devices 

(IoT उपकरणɉ को Ĥमाǔणत करɅ): 

 Allow user authentication via: 
Multiple user management, Two-factor 
authentication, Digital certificates, 
Biometrics. 
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 उपयोगकता[ओं को मãटȣ  -यूज़र Ĥबंधन , दो -कारक 

Ĥमाणीकरण, Ǒडǔजटल Ĥमाणपğ और बायोमेǑĚÈस 

के माÚयम से Ĥमाणीकरण कȧ अनुमित दɅ। 

 Allow user authentication via: 
Multiple user management, Two-factor 
authentication, Digital certificates, 
Biometrics. 

 उपयोगकता[ओं को मãटȣ  -यूज़र Ĥबंधन , दो -कारक 

Ĥमाणीकरण, Ǒडǔजटल Ĥमाणपğ और बायोमेǑĚÈस 

के माÚयम से Ĥमाणीकरण कȧ अनुमित दɅ। 

 (d) Use IoT PKI Security Methods 

(IoT PKI सुर¢ा ǒविधयɉ का उपयोग 

करɅ): 

 Implement Public Key Infrastructure 
(PKI): 
X.509 Certificates, Public/Private key 
generation, Management, Revocation. 
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 पǔÞलक कȧ इंĥाèĚÈचर (PKI) ǒविधयɉ जसैे 

X.509 सǑट[Ǒफकेट और कȧ Ĥबंधन अपनाएँ। 

(e) Use IoT Security Analytics 

(IoT सुर¢ा ǒवƲेषण का उपयोग करɅ): 

 Apply analytics tools capable of detecting 
IoT-specific attacks not seen by 
traditional firewalls. 

 ऐसे सुर¢ा ǒवƲेषण उपकरणɉ का उपयोग करɅ जो 

IoT-ǒविशƴ हमलɉ को पहचान सकɅ । 

(f) Use IoT API Security 

Methods (IoT API सुर¢ा ǒविधयाँ): 

 Secure API communication among 
devices, backend systems, and apps. 

 Ensure only authorized devices and users 
access APIs. 

 केवल अिधकृत Ǒडवाइस और डेवलपस[ को API 

उपयोग कȧ अनुमित दɅ। 
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3. IoT Security for Consumer 
Devices 

(उपभोƠा उपकरणɉ के िलए IoT 

सुर¢ा) 

 IoT security includes four essential 
activities: 

(IoT सुर¢ा मɅ चार मुÉय ǑĐयाए ँहोती हɇ) 

 Identification (पहचान) 

   Devices must have secure, traceable 
identifiers (e.g., serial numbers). 

 Ĥ×येक Ǒडवाइस मɅ सुरǔ¢त पहचान संÉया होनी 
चाǑहए। 

 Authentication (Ĥमाणीकरण) 

   A secure mechanism to establish device–
network connection. 

 नेटवक[  और Ǒडवाइस के बीच सुरǔ¢त कनेÈशन के 
िलए Ĥमाणीकरण आवæयक है। 
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 Authorization (अिधकार Ĥदान 

करना) 

 Controls device behavior based on 
identity and permissions. 

   Ǒडवाइस के उपयोग को उसकȧ पहचान और 
अनुमित के आधार पर िनयंǒğत Ǒकया जाता है। 

 Monitoring (िनगरानी करना) 
 Detect unusual data patterns and 
potential breaches. 

 असामाÛय डेटा पैटन[ और सभंाǒवत सुर¢ा उãलंघन 

कȧ पहचान करɅ। 

 4. Security Levels (सुर¢ा के èतर) 

IoT devices face both active and 
passive attacks. 
(आईओटȣ उपकरण सǑĐय और िनǔçĐय दोनɉ 
Ĥकार के हमलɉ का सामना करते हɇ।) 
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1. Low-level attack (िनàन-èतरȣय 
हमला): 

 Attack attempt fails; no harm done. 
 जब हमला असफल रहता है। 

2. Medium-level attack (मÚयम-
èतरȣय हमला): 

 Attacker listens but doesn’t modify data 

   हमलावर केवल सुनता है, डेटा मɅ पǐरवत[न नहȣं 

करता। 

3. High-level attack (उǄ-ˑरीय हमला): 
 Attacker modifies or alters the integrity 
of data. 

 हमलावर डेटा मɅ बदलाव करता है। 

4. Extremely High-level attack (अȑंत 
उǄ-ˑरीय हमला): 
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 Unauthorized access, illegal operations, 
jamming, or flooding network. 

 अनिधकृत पहँुच, अवधै काय[वाहȣ, या नेटवक[  को 

बािधत करना। 

5. Protecting IoT Devices (IoT उपकरणो ं
की सुरƗा) 

(a) Keep Changing Your Password 
(पासवडŊ बदलते रहŐ): 

 Regularly update passwords on PCs, 
accounts, and devices. 

 समय-समय पर अपने पासवड[ बदलɅ। 

(b) Update Your Device (उपकरण को 
अपडेट रखŐ): 

 Enable automatic updates and install 
security patches. 

 ऑटो-अपडेट चालू करɅ और सरु¢ा पैच èथाǒपत 

करɅ। 
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(c) Reduce Use of Cloud (Ƒाउड का 
उपयोग कम करŐ ): 

 Cloud connectivity may expose data to 
hackers. 

 Èलाउड का कम उपयोग करɅ ताǑक डेटा सुरǔ¢त 

रहे। 

(d) Use Secondary Network (िȪतीय 
नेटवकŊ  का उपयोग करŐ ): 

 Create a separate network for IoT 
devices. 

 IoT उपकरणɉ के िलए अलग Wi-Fi नेटवक[  

बनाएँ। 

6. Botnet (बॉटनेट 

 A Botnet is a network of internet-
connected devices like PCs, servers, 
mobiles, and IoT devices. 

 "Botnet" word = "Robot" + "Network". 
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 बॉटनेट इंटरनेट से जुड़े उपकरणो ंका 
समूह होता है। 

 Common uses: 

 Sending spam emails (èपैम ईमेल भेजना) 

 Fraudulent activities (धोखाधड़ȣ वाले अिभयान) 

 Distributed Denial of Service (DDoS) attacks 
to overload networks. 

 DDoS हमलɉ से नेटवक[  को ठप करना। 

Chapter 4 – Building 
IoT Application 

(IoT एÜलीकेशन का िनमा[ण)

 Introduction to Arduino IDE 

(Arduino IDE का पǐरचय) 
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Arduino was born at the Ivrea Interaction Design 
Institute as an easy tool for fast prototyping, 
aimed at students without a background in 
electronics and programming. Arduino is an open-
source computer hardware and software 
company. 

Arduino boards can read inputs — a light on a 
sensor, a finger on a button, or even a Twitter 
message — and turn it into an output like activating 
a motor, turning on an LED, or publishing 
something online. 
You tell your board what to do by sending a set of 
instructions to the microcontroller using the 
Arduino programming language (based on Wiring) 
and the Arduino IDE (based on Processing). 

Arduino का जÛम Ivrea Interaction Design Institute मɅ हुआ 
था, इसे तेज़ी से Ĥोटोटाइप 
बनाने के िलए एक आसान 
उपकरण के Ǿप मɅ ǒवकिसत 
Ǒकया गया था, ǔजसका उƧेæय 
उन छाğɉ कȧ मदद करना था 
ǔजनकȧ पƵृभूिम इलेÈĚॉिनÈस 
या ĤोĒािमंग मɅ नहȣं 
थी।Arduino एक ओपन-सोस[ 
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कंÜयूटर हाड[वेयर और सॉÝटवेयर कंपनी है। 

Arduino बोड[ इनपुट पढ़ सकता है — जैसे Ǒकसी सɅसर पर 
रोशनी, बटन पर उंगली, या ǔÒवटर संदेश — और उसे आउटपुट 
मɅ बदल सकता है, जैसे मोटर चालू करना, LED जलाना या 
कुछ ऑनलाइन Ĥकािशत करना। 
आप बोड[ को बताते हɇ Ǒक Èया करना है, इसके िलए आप 
Arduino ĤोĒािमगं भाषा (जो Wiring पर आधाǐरत है) और 
Arduino सॉāटवेयर IDE (जो Processing पर आधाǐरत है) का 
उपयोग करते हɇ। 

 What is Arduino IDE? 

(Arduino IDE Ɛा है?) 

Arduino IDE (Integrated Development 
Environment) is open-source software used for 
writing, compiling, and uploading code to 
Arduino boards. 
It acts like a text editor (similar to Notepad) 
with additional features. 
It is cross-platform software available for 
Windows, Linux, and macOS, and supports both 
C and C++ languages. 

Arduino IDE (इंटȣĒेटेड डेवलपमɅट एनवायरनमɅट) एक ओपन-
सोस[ सॉÝटवेयर है ǔजसका उपयोग Arduino बोड[ पर कोड 
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िलखने, कंपाइल करने और अपलोड करने के िलए Ǒकया जाता 
है। 
यह नोटपैड कȧ तरह एक टेÈèट एǑडटर है, लेǑकन इसमɅ 
अितǐरƠ सǒुवधाएँ होती हɇ। 
यह Đॉस-Üलेटफ़ॉम[ सॉÝटवेयर है जो Windows, Linux, और 
macOS सभी पर चलता है और C व C++ भाषाओं को सपोट[ 
करता है। 

 Parts of the Arduino IDE 
Environment 

(Arduino IDE के Ůमुख भाग) 

i. Menu Bar – Contains options for File, Edit, 
Sketch, Tools, and Help. 

ii. Toolbar – Quick-access buttons for Verify, 
Upload, New, Open, Save, and Serial Monitor. 

iii. Text Editor – Area where you write and edit 
your code. 

iv. Output Panel / Console – Shows messages, 
errors, and compilation details. 

1. मेनू बार – इसमɅ File, Edit, Sketch, Tools और Help जैसी 
ǒवकãप होते हɇ। 

2. टूलबार – Verify, Upload, New, Open, Save, और 
Serial Monitor के िलए शॉटŊकट बटन होते हœ। 
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3. टेƜ एिडटर – यहाँ आप कोड िलखते और संपािदत 
करते हœ। 

4. आउटपुट पैनल / कंसोल – इसमŐ संदेश, ũुिटयाँ और 
कंपाइिलंग से संबंिधत िववरण िदखते हœ। 

 LED Programming – एलईडȣ 

ĤोĒािमंग 

Required Components (आवæयक घटक( 

For LED programming, you will need: 

 Arduino board 
 LED 
 Resistor 
 Breadboard 
 Jumper wires 

Once these components are ready, install the 
Arduino IDE software on your computer and 
configure your Arduino board by installing the 
required device driver. 

एलईडȣ ĤोĒािमंग के िलए आपको चाǑहए – 

 एक Arduino बोड[ 
 एक एलईडȣ (LED) 

 एक रेǔजèटर (Resistor) 
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 एक Ħेडबोड[ (Breadboard) 

 जàपर वायर (Jumper Wires) 

जब आपके पास ये सभी घटक हɉ, तब अपने कंÜयूटर मɅ 
Arduino IDE सॉāटवेयर इंèटॉल करɅ और आवæयक िडवाइस 

डŌ ाइवर लगाकर Arduino बोड[ को कॉǔÛफ़गर करɅ। 

 Arduino Board (Arduino बोडŊ) 

The Arduino Uno is a microcontroller board based on the 
ATmega328. 
It includes everything needed to support the microcontroller 
— just connect it to a computer with a USB cable or power 
it using an adapter or battery. 
It is simple and easy to use for repetitive tasks such as 
blinking an LED. 
The word Uno 
means “one” in 
Italian and marks 
the release of 
Arduino IDE 
version 1.0. 

 

 

Arduino Uno एक 
माइĐोकंĚोलर बोड[ 
है जो ATmega328 

पर आधाǐरत है। 
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इसमɅ माइĐोकंĚोलर को सपोट[ करने के िलए आवæयक सभी 
चीजɅ होती हɇ। 
इसे USB केबल से कंÜयूटर से जोड़ा जा सकता है या Ǒफर 
AC-to-DC एडेÜटर या बैटरȣ से पावर दȣ जा सकती है। 
यह सरल कायɟ जैसे LED को ऑन-ऑफ करने के िलए बहुत 
उपयोगी है। 
Uno शÞद इटैिलयन भाषा का है ǔजसका अथ[ “एक” होता है 
— इसे Arduino IDE 1.0 के लॉÛच को दशा[ने के िलए चुना 
गया। 

 

 Breadboard (ŰेडबोडŊ) 
The breadboard is used to make temporary electrical 
connections between components such as resistors, LEDs, 
capacitors, etc., before permanently soldering them. 
It has many small 
sockets (holes) 
arranged in a 
0.1-inch grid. 
Some groups of 
sockets are 
internally 
connected, 
allowing 
components to 
be easily 
inserted and 
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connected without soldering. 

 

Ħेडबोड[ का उपयोग सǑक[ ट के घटकɉ (जैसे रेǔजèटर, एलईडȣ, 
कैपेिसटर आǑद) को अèथायी Ǿप से जोड़ने के िलए Ǒकया 
जाता है ताǑक उÛहɅ èथायी Ǿप से जोड़ने से पहले परȣ¢ण 
Ǒकया जा सके। 
इसमɅ छोटे-छोटे छेद (holes) होते हɇ जो 0.1 इंच कȧ दरूȣ पर 
åयवǔèथत रहते हɇ। 
कुछ सॉकेट आपस मɅ जड़ेु होते हɇ ǔजससे ǒबना सोãडǐरंग के 
सǑक[ ट को आसानी से जोड़ा जा सकता है। 

 LED (लाइट एिमिटंग डायोड) 

An LED (Light Emitting Diode) is a diode that emits light 
when current flows through it. 
It has two pins: 

 Cathode (–): Connects 
to GND (Ground) 

 Anode (+): Connects 
to a digital output pin 
to control the LED 
state 

 

 

एलईडȣ (लाइट एिमǑटंग 
डायोड) एक ऐसा डायोड 
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है जो उस पर ǒवƭुत धारा ĤवाǑहत होने पर Ĥकाश 
उ×सǔज[त करता है। 
इसमɅ दो ǒपन होते हɇ: 

 कैथोड (–): इसे GND (Ēाउंड) से जोड़ा जाता है 

 एनोड (+): इसे Arduino के आउटपुट ǒपन से जोड़ा जाता 
है ǔजससे एलईडȣ को िनयǒंğत Ǒकया जा सके| 

 Resistor (रेǔजèटर) 

A resistor is a passive electronic component used to limit 
current or reduce 
voltage in a 
circuit. 
By dropping 
voltage across it, 
it protects 
components like 
LEDs from 
excessive current. 

 

रेǔजèटर एक 
िनǔçĐय (Passive) इलेÈĚॉिनक घटक है ǔजसका उपयोग 
सǑक[ ट मɅ ĤवाǑहत होने वाली धारा को सीिमत करने या 
वोãटेज घटाने के िलए Ǒकया जाता है। 
यह एलईडȣ जसै ेघटकɉ को अिधक धारा से बचाता है। 
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 Jumper Wires (जàपर 

वायस[) 

Jumper wires are simple wires 
with connector pins at both 
ends. 
They are used to connect two 
points on a breadboard without 
soldering. 

जàपर वायर सामाÛय तार होते हɇ ǔजनके दोनɉ िसरɉ पर 
कनेÈटर ǒपन होती हɇ। 
इनका उपयोग ǒबना सोãडǐरंग Ǒकए Ħेडबोड[ के दो ǒबंदओंु को 
जोड़ने के िलए Ǒकया जाता है। 

  Capacitor (कैपेिसटर) 

In a DC circuit, a capacitor 
charges up to the supply 
voltage and blocks further 
current because its dielectric 
is non-conductive. 
However, in an AC circuit, 
current appears to pass 
through with little or no 
resistance. 

DC सǑक[ ट मɅ कैपेिसटर सÜलाई 
वोãटेज तक चाज[ होकर करंट 
के Ĥवाह को रोक देता है ÈयɉǑक 
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उसका डाइलेǔÈĚक भाग इंसुलेटर होता है। 
लेǑकन AC सǑक[ ट मɅ यह करंट को बहुत कम रोध के साथ 
गुजरने देता है। 

 Writing Code in Sketch (केच मɅ 
कोड िलखना) 

The first new term in Arduino programming is called a 
“Sketch”. 
A Sketch is the program that you upload to the Arduino 
board. 
The Sketch Editor is where you view and edit your code. 
It supports common text editing shortcuts such as: 

 Ctrl + F: Find 
 Ctrl + Z: Undo 
 Ctrl + C: Copy 
 Ctrl + V: Paste 

Arduino ĤोĒािमगं मɅ पहली नई शÞदावली है “Sketch” 

(èकेच)। 
एक èकेच वह ĤोĒाम होता है ǔजसे आप Arduino बोड[ 
पर अपलोड करते हɇ। 
èकेच एǑडटर वह èथान है जहाँ आप अपने कोड को 
िलखते और संपाǑदत करते हɇ। 
यह सामाÛय शॉट[कÒस को सपोट[ करता है, जैसे: 

 Ctrl + F: खोजने के िलए 
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 Ctrl + Z: पूव[वत करने के िलए 

 Ctrl + C: कॉपी करने के िलए 

 Ctrl + V: पèेट करने के िलए 

 Steps to Write an Arduino 
Program 
(Arduino ĤोĒाम िलखने के चरण) 

 

Step 1: Create a New Sketch (नया èकेच बनाना) 

 Select File → New in Arduino IDE. 
Add a block comment at the top of your sketch to 
describe what it does and who wrote it. 

 

Step 2: Maintain Proper Indentation (सहȣ इंडɅटेशन रखɅ ( 

Keep your code properly indented and easy to read. 
This helps in debugging and understanding the flow of the 
program. 
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 अपने कोड मɅ सहȣ इंडɅटेशन रखɅ ताǑक उसे पढ़ना और Ǒडबग 
करना आसान हो। 

Step 3: Define Variables (वैǐरएबल पǐरभाǒषत 

करɅ( 

Variables are used to store data. Each variable has a name, 
type, and value. 

Example:- 

Explanation: 

 
Here, ledPin is an integer variable with value 13, 
representing the digital pin where the LED is connected. 

वैǐरएबल डेटा को संĒहȣत करने के िलए उपयोग Ǒकए जाते 
हɇ। 
ऊपर Ǒदए गए उदाहरण मɅ ledPin एक integer Ĥकार का 
वैǐरएबल है, ǔजसकȧ वैãयू 13 है — यानी LED Ǒडǔजटल ǒपन 
13 से जड़ुȣ है। 
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Step 4: Setup Function (सेटअप फ़ंÈशन( 

The setup() function runs once when the Arduino is 
powered on or reset. 
It is used to initialize variables, define pin modes, and start 
serial communication. 

Example: 

 

setup() फ़ंÈशन केवल एक बार चलता है जब Arduino चालू 
या रȣसेट होता है। 
इसका उपयोग वैǐरएबल सेट करने, ǒपन मोड िनधा[ǐरत करने 
और सीǐरयल कàयुिनकेशन Ĥारंभ करने के िलए Ǒकया जाता 
है। 

Step 5: Loop Function (लूप फ़ंÈशन( 

 
The loop() function runs continuously after 
setup(). 
It contains the main logic of your program. 

Example: 
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loop() फ़ंÈशन setup() के बाद बार-बार चलता रहता है। 

यहȣं पर आपके सǑक[ ट का मुÉय लॉǔजक िलखा जाता है। 
ऊपर Ǒदए गए उदाहरण मɅ LED हर 1 सेकंड मɅ ऑन और 
ऑफ होती है। 

Step 6: User-defined Functions (उपयोगकता[ 

Ʈारा पǐरभाǒषत फ़ंÈशन( 

You can create custom functions outside setup() and loop() 
for specific tasks. 
When called, Arduino executes the code inside them and 
returns to the main program. 

आप अपनी आवæयकता के अनुसार setup() और loop() के 
बाहर खुद के फ़ंÈशन बना सकते हɇ। 
जब इÛहɅ कॉल Ǒकया जाता है, Arduino उनके अदंर िलखा कोड 
चलाता है और Ǒफर मुÉय ĤोĒाम पर लौट आता है। 
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 Compiling and 
Debugging 

(कंपाइिलंग और 

Ǒडबिगंग( 
 Compiling (कंपाइिलंग( 

 
Compiling converts high-level code into machine 
language (binary code) that the processor can 
understand. 
If any syntax or logical error occurs, the IDE 
shows an error message at the bottom. 
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कंपाइिलंग एक ĤǑĐया है ǔजसमɅ हाई  -लेवल कोड को मशीन 

भाषा मɅ बदला जाता है ताǑक Ĥोसेसर उसे समझ सके। 

अगर कोड मɅ कोई गलती )error) हो, तो IDE नीचे एरर 

संदेश Ǒदखाता है। 

 Debugging (Ǒडबिगंग( 

Debugging means finding and fixing errors in 
your program. 
Arduino IDE doesn’t have an in-built debugger, 
but you can use the Serial Monitor to print 
messages for testing and tracking code 
behavior. 
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Ǒडबिगंग का अथ[ है कोड मɅ ğुǑटयाँ ढँूढना और उÛहɅ ठȤक 

करना। 

Arduino IDE मɅ ǒबãट  -इन Ǒडबगर नहȣं होता , लेǑकन आप 

Serial Monitor का उपयोग करके ĤोĒाम के पǐरणामɉ और 

वैǐरएबãस कȧ ǔèथित देख सकते हɇ। 

 Uploading the File to 
Arduino Board 

(Arduino बोड[ पर 
फाइल अपलोड करना) 
Follow these steps to upload your sketch: 

1. Connect your Arduino to the computer using a 
USB cable. 

o The square end of the cable connects to Arduino. 
o The flat end connects to the USB port of your 

computer. 
2. Select the correct board from the menu: 
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o Go to Tools → Board → Arduino Uno (or 
whichever board you are using). 

3. Select the correct serial port: 
o Go to Tools → Port → (COM3 or COM4) 

depending on your system. 
4. Click on the Upload button (the right arrow icon 

on the toolbar) or press Ctrl + U. 

Once uploaded successfully, the message “Done uploading” 
will appear at the bottom of the IDE. 
 

अपना èकेच अपलोड करने के िलए ये चरण अपनाएँ: 

1. USB केबल से Arduino को कंɗूटर से जोड़Ő। 
o केबल का चौकोर िसरा Arduino मɅ लगेगा। 
o सपाट िसरा कंÜयूटर के USB पोट[ मɅ। 

2. सही बोडŊ का चयन करŐ : 
o Tools → Board → Arduino Uno (या जो बोड[ आप 

उपयोग कर रहे हɇ)। 
3. सही सीįरयल पोटŊ  चुनŐ: 

o Tools → Port → (COM3 या COM4) अपने िसèटम 
के अनुसार। 

4. Upload बटन (दाएँ तीर वाला आइकन) पर ǔÈलक करɅ या 
Ctrl + U दबाएँ। 

सफल अपलोड के बाद IDE के नीचे “Done uploading” िलखा 
आएगा। 
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 Designing a Simple 
LED Circuit 
(सरल एलईडȣ सǑक[ ट 
बनाना) 
 

To make the LED blink, open Arduino IDE and follow these 
steps: 

1. Go to File → Examples → Basics → Blink 
2. Select the correct Board and Port. 
3. Click Upload. 

Once uploaded, the LED connected to pin 13 on the Arduino Uno 
will start blinking. 

 

एलईडȣ को ǔÞलकं कराने के िलए Arduino IDE खोलɅ और ये 
कदम अपनाएँ: 

1. जाएँ File → Examples → Basics → Blink 

2. सहȣ Board और Port चुनɅ। 
3. Ǒफर Upload पर ǔÈलक करɅ। 

अपलोड होने के बाद Arduino Uno के pin 13 पर लगी इनǒबãट 
एलईडȣ ǔÞलंक करने लगेगी। 
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 Example: Blink Program (एलईडी İɰंक 
ŮोŤाम) 

 

 

Explanation: 

The LED blinks ON and OFF every second (1000 
milliseconds). 
You can change the blinking speed by changing the delay 
value. 

 

ऊपर Ǒदया गया कोड एलईडȣ को हर 1 सेकंड मɅ ऑन और 
ऑफ करता है। 

अगर आप ǔÞलंक कȧ गित बदलना चाहते हɇ तो delay(1000) 

का मान बदल सकते हɇ। 
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 Libraries in Arduino 

(Arduino मɅ लाइĦेरȣज़) 

Libraries add extra functionality to your Arduino projects 
(e.g., controlling sensors, motors, displays). 
To include a library: 

 Go to Sketch → Include Library → Add .ZIP Library 
Once added, the library appears at the top of your sketch 
with a #include line. 

 

लाइĦेरȣज़ आपके Arduino ĤोजेÈट मɅ अितǐरƠ काय[¢मता 
जोड़ती हɇ (जैसे सɅसर, मोटर, ǑडèÜले आǑद को िनयंǒğत करना)। 
लाइĦेरȣ जोड़ने के िलए: 

जाए ँSketch → Include Library → Add .ZIP Library 

लाइĦेरȣ जोड़ने के बाद आपके èकेच कȧ शǽुआत मɅ #include 

लाइन Ǒदखाई देगी। 

  Role of Serial Monitor 
(सीǐरयल मॉिनटर कȧ 
भूिमका) 

The Serial Monitor is a part of the Arduino IDE. 
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It serves as a link between your computer and the Arduino 
board, allowing you to send and receive data in text form. 
It is useful for debugging and controlling Arduino through 
your computer keyboard. 

To open Serial Monitor: 

 Click on the magnifying glass icon on the top-right 
corner of the IDE, or press Ctrl + Shift + M. 

It opens a separate window showing communication between 
Arduino and your computer. 

सीǐरयल मॉिनटर Arduino IDE का एक मह×वपूण[ Ǒहèसा है। 
यह कंÜयूटर और Arduino बोड[ के बीच संचार का माÚयम है, 

ǔजसके Ʈारा आप टेÈèट के Ǿप मɅ डेटा भेज या ĤाƯ कर 
सकते हɇ। 
यह Ǒडबिगंग और Arduino को कȧबोड[ से िनयंǒğत करने के 
िलए बहुत उपयोगी है। 

Serial Monitor खोलने के िलए: 

IDE के ऊपरȣ दाएँ कोने मɅ आवध[क काचँ (magnifying glass) 

आइकन पर ǔÈलक करɅ या Ctrl + Shift + M दबाए।ँ 

यह एक अलग ǒवंडो खोलता है ǔजसमɅ Arduino और कंÜयूटर 
के बीच डेटा Ěांसफर Ǒदखता है। 

 



DIGITAL RK COMPUTER ACADEMY 
website- www.drkca.in, drkca.com 

Address-Moazzampur Karari, Kaushambi 
Mobile no.-708076746, 6387249072,9026672774                                  

 

 

 

 

 

 

 

 Embedded     
Language Basics 
(एंबेडेड     भाषा के 
मूल िसƨांत( 
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Introduction 
(पǐरचय) 

Embedded C Programming Language, widely used in the 
development of Embedded Systems, is an extension of the C 
Programming Language. It uses the same syntax and 
semantics of C, such as main function, data type declaration, 
variables, loops, functions, and statements. 

 

एंबेडेड C ĤोĒािमगं लɇÊवेज, जो एंबेडेड िसèटàस के ǒवकास मɅ 
åयापक Ǿप से उपयोग कȧ जाती है, C भाषा का एक ǒवèतार 
(extension) है। यह C भाषा कȧ समान संरचना और िनयमɉ 
का पालन करती है जैसे — main function, data type 

declaration, variables, loops, functions, और statements। 

 

 C Language 
Introduction (C 
भाषा का पǐरचय( 
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C is a general-purpose programming language created by 
Dennis Ritchie at Bell Laboratories in 1972. 
Despite being old, it is still one of the most popular 
programming languages. 
C is strongly associated with UNIX, as it was developed to 
write the UNIX operating system. 
 

C एक सामाÛय-उƧेæयीय ĤोĒािमगं भाषा है, ǔजसे 1972 मɅ डेिनस 
ǐरची (Dennis Ritchie) Ʈारा Bell Laboratories मɅ बनाया गया 
था। 
पुरानी होने के बावजदू यह आज भी एक बहुत लोकǒĤय भाषा 
है। 
C का UNIX ऑपरेǑटंग िसèटम से गहरा संबंध है ÈयɉǑक इसे 
UNIX िलखने के िलए हȣ ǒवकिसत Ǒकया गया था। 

 Getting Started 
with C  

(C का उपयोग शǾु 
करना 

To start using C, you need two things: 
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1. A text editor (like Notepad) — to write C code. 
2. A compiler (like GCC) — to translate C code into 

machine language. 

 

C का उपयोग शुǾ करने के िलए आपको दो चीज़ɉ कȧ 
आवæयकता होगी: 

1. एक टेÈèट एǑडटर (जैसे Notepad) — कोड िलखने के 
िलए। 

2. एक कंपाइलर (जैसे GCC) — कोड को मशीन भाषा मɅ 
बदलने के िलए। 

 C IDE 
Installation  
(C IDE èथाǒपत 
करना( 

An IDE (Integrated Development Environment) is used to 
edit and compile code. 
Popular IDEs include Code::Blocks, Eclipse, Sublime Text, 
and Visual Studio. 
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They are free and can be used for both editing and 
debugging C code. 
 

IDE (एकȧकृत ǒवकास वातावरण) का उपयोग कोड संपादन 
और कंपाइल करने के िलए Ǒकया जाता है। 
लोकǒĤय IDEs हɇ — Code::Blocks, Eclipse, Sublime Text, 

और Visual Studio। 
ये सभी िनशुãक हɇ और C कोड को एǑडट व डȣबग दोनɉ के 
िलए उपयोग Ǒकए जा सकते हɇ। 

 Using Sublime 
Text for C 

 (Sublime Text का 
उपयोग C के िलए( 
Steps to Set Up Sublime Text for C Programming: 

1. Download Sublime Text Editor 
2. Download GCC Compiler from 

https://sourceforge.net/projects/gcc-win64/ 
3. Extract GCC and save it in the C drive. 
4. Go to the bin folder of GCC and copy its path. 
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5.  Add the path in: 
Settings → System → About → Advanced System 
Settings → Environment Variables → System Variables 
→ Path → Edit → Add New → Paste Path 

6. n Sublime, go to Tools → Build System → New Build 
System 

7. Paste the following code: 

 

8.Save it and create a new file (e.g., first.c) 

9.Write your first code and press Ctrl + B to compile & run. 
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 C Syntax (C कȧ 

िसंटैÈस) 

 
Explanation (ʩाƥा): 

 #include <stdio.h> → Header file library for 
input/output functions like printf(). 

 main() → The function where program execution 
starts. 

 printf() → Used to print text on the screen. 

 return 0; → Ends the main() function 
successfully. 
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 New Lines in C (C 
मɅ नई लाइन जोड़ना) 

To print a new line, use the \n character. 

Example 1: 

 

Example 2:  
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Comments in C (C 

मɅ ǑटÜपǔणयाँ( 
Comments make the code easier to 
understand. They can be used for explanation 
or to disable code temporarily during testing. 

 

ǑटÜपǔणयाँ )Comments) कोड को समझने मɅ आसान बनाती 

हɇ। 

इनका उपयोग ǒववरण देने या टेǔèटंग के दौरान कोड को 

अèथायी Ǿप से िनǔçĐय करने के िलए Ǒकया जाता है। 

( Single-line 
Comment 

) 
Begins with // 
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Multi-line 
Comment  

(बहु(पǒंƠ ǑटÜपणी- 
Begins with /* and ends with */ 
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 Variables, Data 
Types, Operators 
and 

Expressions(वǐैरएबãस

, डेटा टाइÜस, 

ऑपरेटर और 

अिभåयǒƠयाँ( 
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Variables 

(वैǐरएबãस) 
A variable is a named location in 
memory used to store data. 
It can hold different values during 
program execution. 

Rules for naming variables in C: 

1. It must begin with a letter or underscore (_). 
2. No spaces or special symbols (%, $, # etc.) are 

allowed. 
3. C is case-sensitive → Age and age are 

different. 

 

वैįरएबल  मेमोरȣ का एक नामांǑकत èथान है जहाँ डेटा संĒहȣत 
Ǒकया जाता है। 
ĤोĒाम चलने के दौरान इसकȧ वैãयू बदली जा सकती है। 

वैǐरएबल नाम रखने के िनयम: 
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1. नाम कȧ शǽुआत Ǒकसी अ¢र या अडंरèकोर (_) से होनी 
चाǑहए। 

2. नाम मɅ èपेस या ǒवशेष िचƹ (% $ # आǑद) न हो। 
3. C भाषा case-sensitive है — Age और age अलग-अलग 

माने जाते हɇ। 

Example: 

 

Data Types (डेटा 

टाइÜस) 
Data types define the type and size of 
data a variable can store. 

Type 
Keywor
d 

Descriptio
n 

Size 
(bytes
) 

Exampl
e 
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Type 
Keywor
d 

Descriptio
n 

Size 
(bytes
) 

Exampl
e 

Integer int 
Whole 
numbers 

2 or 4 
int x = 
5; 

Float float 
Decimal 
numbers 

4 
float y 
= 3.14; 

Double double 
Higher 
precision 
decimal 

8 

double 
pi = 
3.1415
9; 

Charact
er 

char 
Single 
character 

1 
char c 
= 'A'; 

डेटा टाइÜस यह िनधा[ǐरत करते हɇ Ǒक वैǐरएबल Ǒकस Ĥकार 

का डेटा रखेगा और Ǒकतनी मेमोरȣ लेगा। 

Ůकार कीवडŊ िववरण 
आकार 

(बाइट्स) 
उदाहरण 
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Ůकार कीवडŊ िववरण 
आकार 

(बाइट्स) 
उदाहरण 

पूणाɍक int पूण[ सÉंया 2 या 4 int x = 5; 

दशमलव float 
दशमलव 
संÉया 

4 
float y = 
3.14; 

डबल double 
उÍच सटȣकता 
वाला दशमलव 

8 
double pi = 
3.14159; 

अ¢र char एकल अ¢र 1 char c = 'A'; 
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Constants and 
Literals  

(कॉनèटɇÒस और 

िलटरेरãस) 
A constant is a fixed value that cannot be 
changed during program execution. 
Types of Constants: 
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Integer constants (e.g., 10, 25, -50) 

Float constants (e.g., 3.14, -0.99) 

Character constants (e.g., 'A', 'b') 

String constants (e.g., "Hello World") 

You can also use #define to create named 
constants: 

 

कॉनèटɇट ऐसे मान हɇ जो ĤोĒाम चलने के दौरान नहȣं 
बदलते। 

कॉनèटɇÒस के Ĥकार: 

 पूणाɍक कॉनèटɇट → 10, 25, -50 

 दशमलव कॉनèटɇट → 3.14, -0.99 

 वण[ कॉनèटɇट → 'A', 'b' 

 ǔèĚंग कॉनèटɇट → "Hello World" 

#define से भी कॉनèटɇट बनाए जा सकते हɇ: 
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➕   Operators 

(ऑपरेटर) 
Operators are symbols used to perform operations on 
variables and values. 

1. Arithmetic Operators (गǔणतीय 
ऑपरेटर): 

Operator Description Example Result 

+ Addition 10 + 5 15 

– Subtraction 10 – 5 5 

* Multiplication 10 * 5 50 

/ Division 10 / 5 2 

% Modulus (Remainder) 10 % 3 1 

2. Relational Operators (संबंध 
ऑपरेटर): 
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Operator Meaning Example 

== Equal to a == b 

!= Not equal to a != b 

> Greater than a > b 

< Less than a < b 

>= Greater than or equal to a >= b 

<= Less than or equal to a <= b 

Logical Operators (ताǑक[ क 
ऑपरेटर): 

Operator Description Example 
&& Logical AND (a > 0 && b > 0) 
   

! Logical NOT !(a > b) 

Expressions (अिभåयǒƠयाँ( 
An expression is a combination of operands 
(variables or constants) and operators that 
produces a value. 

Example: 
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अिभåयǒƠ (Expressions) वǐैरएबãस और ऑपरेटरɉ का ऐसा 
समूह है जो एक मान उ×पÛन करता है। 

उदाहरण: 

 

Assignment Operator (असाइनमɅट 

ऑपरेटर) 

Used to assign values to variables. 

असाइनमɅट ऑपरेटर (=) का उपयोग Ǒकसी वैǐरएबल को मान 
देने के िलए Ǒकया जाता है। 



DIGITAL RK COMPUTER ACADEMY 
website- www.drkca.in, drkca.com 

Address-Moazzampur Karari, Kaushambi 
Mobile no.-708076746, 6387249072,9026672774                                  

 Variables 
in C 
Variables are containers for storing data values, like 
numbers and characters. In C, there are different 
types of variables (defined with different keywords), 
for example: 

 int - stores integers (whole numbers), without 
decimals, such as 123 or -123 

 float - stores floating point numbers, with 
decimals, such as 19.99 or -19.99 

 char - stores single characters, such as 'a' or 'B'. 
Characters are surrounded by single quotes 

वेǐरएबãस डेटा वैãयूज़ को èटोर करने के िलए कंटेनर होते हɇ, 
जैसे नंबर और कैरेÈटर। C मɅ, ǒविभÛन Ĥकार के वेǐरएबãस 
होते हɇ (ǒविभÛन कȧवÔस[ के साथ पǐरभाǒषत), उदाहरण के 
िलए: 

 int - पूण[ सÉंयाएँ (whole numbers) èटोर करता है, ǒबना 
दशमलव के, जैसे 123 या -123 
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 float - ÝलोǑटंग पॉइंट नंबर èटोर करता है, दशमलव के 
साथ, जैसे 19.99 या -19.99 

 char - िसंगल कैरेÈटर èटोर करता है, जैसे 'a' या 'B'। 
कैरेÈटर िसंगल कोÒस मɅ होते हɇ। 

Syntax: 

<type> <variableName> = value; 

Example 1: 

int myNum = 15; 

Example 2: 

// Declare a variable 

int myNum; 

// Assign a value to the variable 

myNum = 15; 

## Format Specifiers in C: 

Format specifiers are used together with the 
printf() function to tell the compiler what type of 
data the variable is storing. It is basically a 
placeholder for the variable value. A format 
specifier starts with a percentage sign %, followed 
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by a character. For example, to output the value of 
an int variable, use the format specifier %d 
surrounded by double quotes (""), inside the 
printf() function: 

 

ĤाǾप ǒविनदȶशक का उपयोग printf() फ़ंÈशन के साथ Ǒकया 

जाता है ताǑक कंपाइलर को यह बताया जा सके Ǒक चर Ǒकस 

Ĥकार के डेटा को संĒहȣत कर रहा है। यह मूल Ǿप से चर 

मान के िलए एक Üलेस होãडर है। एक ĤाǾप ǒविनदȶशक 

Ĥितशत िचƹ % से शुǾ होता है, उसके बाद एक वण[ होता है। 

उदाहरण के िलए, int चर के मान को आउटपुट करने के िलए, 

printf() फ़ंÈशन के अंदर डबल कोÒस ("") से िघरे ĤाǾप 

ǒविनदȶशक %d का उपयोग करɅ: 

### Example: 

// Create variables int myNum = 15; // Integer (whole 
number) float myFloatNum = 5.99; // Floating point 
number char myLetter = 'D'; // Character 

// Print variables printf("%d\n", myNum); printf("%f\n", 
myFloatNum); printf("%c\n", myLetter); ` 
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Declare Multiple 
Variables 

int x = 5, y = 6, z = 50;printf("%d", x + y + z); 

 

 Identifiers 
- 

 
Identifiers are names given to program elements, such 
as variables, arrays, functions, structures, unions and 
labels etc. An identifier can be composed only of 
uppercase, lowercase letters, underscore and digits, but 
should start only with an alphabet or an underscore. 
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आइडɅǑटफायर ĤोĒाम एिलमɅÒस को Ǒदए गए नाम हɇ, जैसे 
वेǐरएबल, ऐरे, फंÈशन, èĚÈचर, यूिनयन और लेबल आǑद। एक 
आइडɅǑटफायर केवल अपरकेस, लोअरकेस अ¢र, अंडरèकोर और 
अंकɉ से बन सकता है, लेǑकन केवल एक अãफाबेट या 
अंडरèकोर से शुǾ होना चाǑहए। 

 Valid identifiers: total, sum, average, x, y, mark_1, 
x1 

Note: Underscore character is usually used as a link 
between two words in long identifiers.  

नोट: अंडरèकोर कैरेÈटर आमतौर पर लंबे आइडɅǑटफायर मɅ दो 
शÞदɉ के बीच एक िलंक के Ǿप मɅ उपयोग Ǒकया जाता है| 

 Built-in Data 
Types –  

ǒबãटइन डेटा टाइप- 
Data types are the definition you use to assign the type 
to the variable that determines what value it is going to 
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store and manipulate. Whenever you declare a variable 
it requires a data type to be declared with. Every data 
type comes with a certain size and range when declared, 
assigns that size and range to the variable automatically. 

डेटा टाइप वह पǐरभाषा है ǔजसका उपयोग आप वेǐरएबल के 
Ĥकार को असाइन करने के िलए करते हɇ जो यह िनधा[ǐरत 
करता है Ǒक वह Ǒकस वैãयू को èटोर और मैिनपुलेट करने 
वाला है। जब भी आप एक वेǐरएबल को ǑडÈलेयर करते हɇ तो 
इसके साथ एक डेटा टाइप कȧ आवæयकता होती है। हर डेटा 
टाइप एक िनǔƱत आकार और सीमा के साथ आता है जब 
ǑडÈलेयर Ǒकया जाता है, उसका आकार और सीमा को 
वेǐरएबल को èवचािलत Ǿप से असाइन करता है। 

 

Format 
Specifier 

Data 
Type 

Size Description 

%d or %i int 
2 or 4 
bytes 

whole 
numbers 

%f float 4 bytes 
6-7 decimal 
digits 

%lf double 8 bytes 
15 decimal 
digits 
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Format 
Specifier 

Data 
Type 

Size Description 

%c char 1 byte 
single 
character 

%s strings  
Used for 
strings 

 

Example: 
 

// Create variables 
int myNum = 5;           // Integer 
(whole number) 
float myFloatNum = 5.99; // Floating 
point number 
double myNum = 19.99;    // double 
char myLetter = 'D';     // Character 
char myText[] = "Hello"; // String 
 
// Print variables 
printf("%d\n", myNum); 
printf("%f\n", myFloatNum); 
printf("%c\n", myLetter); 
printf("%s", myText); 
` 
 

## C Decimal Precision (C दशमलव पǐरशुƨता) 
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If you want to remove the extra zeros 
(set decimal precision), you can use a 
dot (.) followed by a number that 
specifies how many digits that should be 
shown after the decimal point: 
 

यǑद आप अितǐरƠ शÛूयɉ को हटाना चाहते हɇ (दशमलव पǐरशुƨता 
िनधा[ǐरत करना), तो आप एक ǒबंद ु(.) के बाद एक सÉंया का 
उपयोग कर सकते हɇ जो िनǑद[ƴ करता है Ǒक दशमलव ǒबंद ुके 
बाद Ǒकतने अकं Ǒदखाए जाने चाǑहए: 
 

`float myFloatNum = 3.5;` 
 
`printf("%f\n", myFloatNum);` // Default 
will show 6 digits after the decimal 
point 
`printf("%.1f\n", myFloatNum);` // Only 
show 1 digit 
`printf("%.2f\n", myFloatNum);` // Only 
show 2 digits 
`printf("%.4f", myFloatNum);` // Only 
show 4 digits 
 
## The sizeof Operator 
 

#include <stdio.h> int main() { int myInt; float 
myFloat; double myDouble; char myChar; 

 

printf("%lu\n", sizeof(myInt)); 
printf("%lu\n", sizeof(myFloat)); 
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printf("%lu\n", sizeof(myDouble)); 
printf("%lu\n", sizeof(myChar)); 
return 0; 

} 
 
--- 

 
# Constants and Literals 
 
## What are Constants? 
If you don't want others (or yourself) to change existing 
variable values, you can use the const keyword. This 
will declare the variable as "constant", which means 
unchangeable and read-only: 
 

यǑद आप नहȣं चाहते Ǒक दसूरɉ (या आप èवयं) मौजूदा वǐेरएबल 
मानɉ को बदलɅ, तो आप const कȧवड[ का उपयोग कर सकते हɇ। यह 
वेǐरएबल को "ǔèथर" के Ǿप मɅ घोǒषत करेगा, ǔजसका अथ[ है 
अपǐरवत[नीय और केवल पढ़ने के िलए: 
 

### Example 1: 
 

`const int myNum = 15;` // myNum will 
always be 15 
`myNum = 10;` // error: assignment of 
read-only variable 'myNum' 
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### Example 2: 
 
`const int minutesPerHour;` 
`minutesPerHour = 60;` // error 
 
## What are Literals? 
 

Literals can be defined as data that is given in a variable 
or constant. For example 9, -1.5, "Abhinav", 
‘DigitalRK' are literals. Literals are fixed numeric or 
non-numeric values. 
 

िलटरãस को एक डेटा के Ǿप मɅ पǐरभाǒषत Ǒकया जा सकता है 
जो एक वेǐरएबल या काèंटɅट मɅ Ǒदया जाता है। उदाहरण के िलए 
9, -1.5, "Abhinav", ‘DigitalRK ' सभी िलटरãस हɇ। िलटरãस 
ǑफÈèड Ûयूमेǐरक या नॉन-Ûयूमेǐरक वैãयूज़ होते हɇ। 
 
### Example: 
 

In the following example myNum is called Identifiers, 
int is data type and 5 is Literals 
 
िनàनिलǔखत उदाहरण मɅ myNum को आइडɅǑटफायर कहा जाता है, 
int डेटा Ĥकार है और 5 िलटरãस है 
 

`int myNum = 5;` 
 

Operators in C 
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Operators are used to perform operations on variables 
and values. C divides the operators into the following 
groups: 
 
ऑपरेटर का उपयोग चर और मान पर संचालन करने के िलए Ǒकया 
जाता है। C ऑपरेटर को िनàनिलǔखत समूहɉ मɅ ǒवभाǔजत करता है: 

 Arithmetic operators 
 Assignment operators 
 Comparison operators or Relational 
Operators 

 Logical operators 
 Bitwise operators 

(Arithmetic 
operators) –  
अ YथमेǑटक ऑपरेटस[ 
The Arithmetical operators are the operators which help 
you perform the arithmetical operation in your program. 
Example: Addition, Subtraction, Divide and Multiply 
etc are the Arithmetic operators… 
अथ[मǑेटक ऑपरेटर वे ऑपरेटर होते हɇ जो आपके ĤोĒाम मɅ 
अथ[मǑेटक ऑपरेशन करने मɅ आपकȧ सहायता करते हɇ। उदाहरण : 
जोड़, घटाना, ǒवभाजन और गुणा आǑद अथ[मǑेटक ऑपरेटर होते हɇ। 
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Types of 
Arithmetic 
Operators in C 
The C Arithmetic Operators are of two types based on 
the number of operands they work. These are as 
follows: 
सी अंकगणतीय ऑपरेटर ऑपरेÖड कȧ संÉया के आधार पर दो Ĥकार 
के होते हɇ। ये इस Ĥकार हɇ: 
1. Binary Arithmetic Operators 
2. Unary Arithmetic Operators 

 

1. Binary Arithmetic 
Operators in C 
The C binary arithmetic operators operate or work on 
two operands. 
सी बाइनरȣ अंकगणतीय ऑपरेटर दो ऑपरेÖड पर काय[ करते हɇ। 
Example :- 



DIGITAL RK COMPUTER ACADEMY 
website- www.drkca.in, drkca.com 

Address-Moazzampur Karari, Kaushambi 
Mobile no.-708076746, 6387249072,9026672774                                  

 
 

2. Unary Arithmetic 
Operators in C 
The unary arithmetic operators operate or work with a 
single operand. 
एकल अंकगणतीय ऑपरेटर एकल ऑपरेÖड के साथ काय[ करते हɇ। 

Increment Operator in C 
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The ‘++’ operator is used to increment the value of an 
integer. It can be used in two ways: 
‘++’ ऑपरेटर का उपयोग Ǒकसी पणूाɍक के मान को बढ़ाने के िलए 
Ǒकया जाता है। इसका उपयोग दो तरȣक़ɉ से Ǒकया जा सकता है: 

1. Pre-increment  

 

2. Post-increment 

 

Decrement Operator in 
C 
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The ‘--‘ operator is used to decrement the value of an 
integer. Just like the increment operator, the decrement 
operator can also be used in two ways: 

‘--‘ ऑपरेटर का उपयोग Ǒकसी पणूाɍक के मान को घटाने के िलए 

Ǒकया जाता है। इÛĐȧमɅट ऑपरेटर कȧ तरह हȣ, ǑडĐȧमɅट ऑपरेटर का 

भी दो तरȣक़ɉ से उपयोग Ǒकया जा सकता है: 

1. Pre-Decrement 

 

2. Post-Decrement 

 

 

 

Assignment Operators 
An assignment operator assigns a value to a variable 

based on the value of another expression: 
असाइनमɅट ऑपरेटर Ǒकसी अÛय अिभåयǒƠ के मान के आधार पर 

Ǒकसी चर को मान िनǑद[ƴ करता है: 
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Example :- 

 

Relational (Comparison) 
Operators in C 
The relational operators in C are used for the 
comparison of the two operands. All these operators are 
binary operators that return true or false values as the 

result of comparison. 
C मɅ ǐरलेशनल ऑपरेटर का उपयोग दो ऑपरेÖड कȧ तुलना के िलए 

Ǒकया जाता है। ये सभी ऑपरेटर बाइनरȣ ऑपरेटर हɇ जो तुलना के 

पǐरणामèवǾप स×य या अस×य मान लौटाते हɇ। 

Example :- 
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Note: Here, 0 means false and 1 means true. 

User Input 

To get user input, you can use the scanf() function: 
उपयोगकता[ इनपुट ĤाƯ करने के िलए, आप scanf() फ़ंÈशन का 

उपयोग कर सकते हɇ: 
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 Conditional 
Statements and 

Loops 

कंडȣशनल èटेटमɅट और 

लूÜस 
You are aware that C language expression statements 
and repetitive statements are used. These statements are 
used to assign values and to execute repetitive tasks. A 
programming language will be incomplete if it does not 
have a decision making statement. These decision 
making statements are also called conditional, 
execution and selection statements. 

आप जानते हɇ Ǒक C भाषा मɅ एÈसĤेशन èटेटमɅट और दोहराव वाले 

èटेटमɅÒस का उपयोग Ǒकया जाता है। ये èटेटमɅÒस वैãयू को असाइन 

करने और दोहराए जाने वाले काय[ को िनçपाǑदत करने के िलए 
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उपयोग Ǒकए जाते हɇ। ĤोĒािमंग भाषा इनकàÜलीट होगी अगर इसमɅ 

िनण[य लनेे के èटेटमɅट नहȣं हɉगे। इन िनण[य लेने वाल ेèटेटमɅÒस को 

कंडȣशनल, एǔÈसÈयूशन और सेलेÈशन èटेटमɅट भी कहा जाता है। 

Conditional Statements –  

कंडȣशनल èटेटमɅट 
In any programming language, there is a need to perform 
different tasks based on the condition, that means if the 
condition will be true then the block of code will be executed 
else not. For this kind of thing we are facilitated to use various 
conditional statements to place conditions. 

Ǒकसी भी ĤोĒािमंग लɇÊवेज मɅ कंडȣशन के आधार पर अलग-अलग 

टाèक परफॉम[ करने कȧ ज़Ǿरत होती है, यानी अगर कंडȣशन सहȣ 

होगी तो कोड के Þलॉक को एǔÈसÈयूट Ǒकया जाएगा वरना नहȣं। इस 

तरह कȧ चीज़ के िलए हमɅ ǒविभÛन सशत[ बयानɉ का उपयोग करने 

कȧ सुǒवधा दȣ जाती है। 

Type of Statements 
 if Statement 

 if and else Statement 

 else if Statement 
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 Switch Statement 

The if Statement 

यǑद कोई शत[ स×य है तो िनçपाǑदत Ǒकए जाने वाल ेC कोड के 

Þलॉक को िनǑद[ƴ करने के िलए if कथन का उपयोग करɅ। 
Use the if statement to specify a block of C code to be 
executed if a condition is true. 

Example :- 

 
We can also test variables: 

Example :- 

 

The else Statement 

यǑद शत[ गलत है तो िनçपाǑदत Ǒकए जाने वाल ेकोड के Þलॉक को 

िनǑद[ƴ करने के िलए अÛय (else) कथन का उपयोग करɅ। 
Use the else statement to specify a block of code to be 
executed if the condition is false. 

Syntax :- 
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Example :- 
Check whether an integer is odd or even 

 

The else if Statement 

यǑद पहली शत[ गलत है तो नई शत[ िनǑद[ƴ करने के िलए अÛयथा यǑद (else 

if) कथन का उपयोग करɅ। 

Use the else if statement to specify a new condition if the first 

condition is false. 

Syntax :- 
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Example :- 

 

ShortHand If...Else (Ternary 
Operator) 
There is also a short-hand if else, which is known as the 
ternary operator because it consists of three operands. It can 
be used to replace multiple lines of code with a single line. It 
is often used to replace simple if else statements. 
एक शॉट[-हɇड if else भी है, ǔजस ेटन[रȣ ऑपरेटर के Ǿप मɅ जाना जाता है 

ÈयɉǑक इसमɅ तीन ऑपरेÖड होते हɇ। इसका उपयोग कोड कȧ कई पंǒƠयɉ को 

एक पǒंƠ स ेबदलने के िलए Ǒकया जा सकता है। इसका उपयोग अÈसर सरल 

if else कथनɉ को बदलने के िलए Ǒकया जाता है। 

Example :- 

 
Switch Statement 
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Instead of writing many if..else statements, you can use the 
switch statement. The switch statement selects one of many 
code blocks to be executed. 
कई if..else कथन िलखने के बजाय, आप ǔèवच कथन का उपयोग कर 

सकते हɇ। ǔèवच कथन िनçपाǑदत Ǒकए जाने वाल ेकई कोड Þलॉकɉ मɅ स ेएक 

का चयन करता है। 

Syntax :- 

 
 

Example :- 
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 Loops in C 
जब तक एक िनǑद[ƴ ǔèथित पूरȣ हो जाती है, Loops कोड के एक Þलॉक को 

िनçपाǑदत कर सकते हɇ। Loops उपयोगी होते हɇ ÈयɉǑक वे समय बचाते हɇ, 
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ğुǑटया ँकम करत ेहɇ और कोड को अिधक पठनीय बनाते हɇ। 

Loops can execute a block of code as long as a specified 
condition is reached. Loops are handy because they save time, 
reduce errors, and they make code more readable. 

 

Type of loop in C 
 While loop 

 Do while loop 

 For loop 

 Nested loop 

 Infinite loop 

While Loop in C 

जब तक िनǑद[ƴ ǔèथित true है, while लूप कोड के एक Þलॉक के माÚयम 

स ेलूप करता है: 

The while loop loops through a block of code as long as a 
specified condition is true: 

Syntax :- 

 

Example 1 :- 
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Example 2 :- 

 

Note: 
Do not forget to increase the variable used in the condition 
(i++), otherwise the loop will never end! 
कंडȣशन (i++) मɅ ĤयुƠ वेǐरएबल को बढ़ाना न भलूɅ, अÛयथा लूप कभी 

ख×म नहȣ ंहोगा! 

The Do/While Loop 
The do/while loop is a variant of the while loop. This loop 
will execute the code block once, before checking if the 
condition is true, then it will repeat the loop as long as the 
condition is true. 
do/while लूप, while लूप का एक Ĥकार है। यह लूप एक बार कोड Þलॉक 

को िनçपाǑदत करेगा, यह जांचने स ेपहल ेǑक Èया ǔèथित स×य है, उसके 

बाद यह लूप को तब तक दोहराएगा जब तक Ǒक ǔèथित स×य है। 

Syntax :- 
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Example :- 

 

Break and Continue in While Loop 

आप while लूप मɅ break और continue का भी उपयोग कर सकते हɇ: 
You can also use break and continue in while loops. 

Break Example :- 

 

Continue Example :- 
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For Loop in C 

When you know exactly how many times you want to loop 
through a block of code, use the for loop instead of a while 
loop. 
जब आपको पता हो Ǒक आपको कोड के Ǒकसी Þलॉक को Ǒकतनी बार लूप 

करना है, तो while लूप के èथान पर for लूप का उपयोग करɅ। 

Syntax :- 

 

Example 1 :- 
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Example 2 :- 

 

Break and Continue in For Loop 

Break :- 
You have already seen the break statement used in the switch 
statement. It was used to "jump out" of a switch statement. 
The break statement can also be used to jump out of a loop. 
आपने पहल ेहȣ switch èटेटमɅट मɅ इèतेमाल Ǒकए गए break èटेटमɅट को 

देखा है। इसका इèतेमाल switch èटेटमɅट से "jump out" करने के िलए 

Ǒकया जाता था। break èटेटमɅट का इèतेमाल लूप से बाहर िनकलने के िलए 

भी Ǒकया जा सकता है। 

Example :- 

 

Continue :- 
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यǑद कोई continue ǔèथित होती है, तो जारȣ कथन एक iteration को तोड़ 

देता है और अगल ेiteration के साथ जारȣ रहता है। 

The continue statement breaks one iteration (in the loop) if a 
specified condition occurs, and continues with the next 
iteration. 

Example :- 

 

Nested Loops - नेːेड लूɛ 

It is also possible to place a loop inside another loop. This is 
called a nested loop. The "inner loop" will be executed one 
time for each iteration of the "outer loop". 
एक लूप को दसूरे लूप के अंदर रखना भी संभव है। इसे नेèटेड लूप कहा जाता 

है। "आंतǐरक लपू" को "बाहरȣ लूप" कȧ Ĥ×येक पुनरावǒृƣ के िलए एक बार 

िनçपाǑदत Ǒकया जाएगा। 

Syntax :- 
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Example 1 :- 

 

Example 2 :- 

  

 

 

Example 3 :- 
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Infinite Loops - इनिफनाइट लूप 

An infinite loop is a looping construct that does not terminate 
the loop and executes it forever. It is also called an indefinite 
loop or endless loop. It either has continuous output or no 
output. 
एक अनंत लपू वह संरचना है जो कभी समाƯ नहȣं होती और लपू को हमेशा के 

िलए चलाती रहती है। इसे अिनǔƱतकालीन लूप या अंतहȣन लूप भी कहा जाता 

है। 

Example 1 :- 

 

Example 2 :- 
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(Arrays) सारिणयाँ :- 
Arrays are used to store multiple values in a single variable, 
instead of declaring separate variables for each value. To 
create an array, define the data type (like int) and specify the 
name of the array followed by square brackets []. 
Arrays का उपयोग एक हȣ वेǐरएबल मɅ कई मानɉ को सĒंहȣत करने के िलए 

Ǒकया जाता है। 

Example :- 

 

Set Array Size :- 
Another common way to create arrays is to specify the size 
and add elements later. 

 

 

Change an Array Element :- 
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Loop through an Array :- 
You can loop through array elements with the for loop. 

 

Functions in C 

फ़ंÈशन कोड का एक Þलॉक है जो केवल तभी रन करता है जब इसे कॉल 

Ǒकया जाता है। 

आप Ǒकसी फ़ंÈशन मɅ डेटा, ǔजस ेparameters के Ǿप मɅ जाना जाता है, 

पास कर सकते हɇ। 

फ़ंÈशÛस का उपयोग कुछ काय[ करन ेके िलए Ǒकया जाता है, और वे कोड का 

पुनः उपयोग करने के िलए मह×वपणू[ हɇ: कोड को एक बार पǐरभाǒषत करɅ, 

और इस ेकई बार उपयोग करɅ। 

A function is a block of code which only runs when it is 
called. 
You can pass data, known as parameters, into a function. 
Functions are used to perform certain actions, and they are 
important for reusing code: Define the code once, and use it 
many times. 

 

Predefined Functions 

For example, main() is a function, which is used to execute 
code, and printf() is a function; used to output/print text to the 
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screen. 

उदाहरण के िलए, main() एक फ़ंÈशन है, ǔजसका उपयोग कोड 

िनçपाǑदत करन ेके िलए Ǒकया जाता है, और printf() एक फ़ंÈशन है; 

ǔजसका उपयोग èĐȧन पर टेÈèट आउटपुट/ǒĤंट करन ेके िलए Ǒकया जाता है: 

Example :- 

 

User Defined Function 

To create (often referred to as declare) your own function, 
specify the name of the function, followed by parentheses () 
and curly brackets {}: 
अपना èवय ंका फ़ंÈशन बनाने (ǔजस ेअÈसर घोǒषत करना कहा जाता है) के 

िलए, फ़ंÈशन का नाम िनǑद[ƴ करɅ, उसके बाद कोƵक () और घुमावदार 

कोƵक {} लगाएं। 

Syntax :- 

 

Return Type 

The void keyword indicates that the function should not return 
a value. If you want the function to return a value, you can use 
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a data type (such as int or float) instead of void, and use the 
return keyword inside the function. 
void कȧवड[ यह संकेत देता है Ǒक फ़ंÈशन को कोई मान नहȣ ंलौटाना चाǑहए। 

यǑद आप चाहते हɇ Ǒक फ़ंÈशन कोई मान लौटाए, तो आप void के बजाय 

डेटा Ĥकार (जैस ेint या float) का उपयोग कर सकते हɇ, और फ़ंÈशन के 

अंदर return का उपयोग कर सकते हɇ। 

 

Using void Type 

Example 1 :- 

 

Example 2 :- 
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Example 3 :- 

 

Return Values 

Example 1 :- 
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Example 2 :- 

 

Standard Library of C Functions in Arduino 
IDE 

The Arduino IDE provides access to a large group of standard 
C libraries through the use of the #include directive. This 
gives programmers access to pre-made functions, as well as 
libraries written specifically for Arduino. 
Arduino IDE #include िनदȶश के उपयोग से मानक C पèुतकालयɉ के 

एक बड़े समहू तक पहँुच Ĥदान करता है। 

void setup() Function 

In Arduino, the void setup() function is used to initialize 
variables, set pin modes, and start using libraries at the 
beginning of a program. 
Arduino मɅ, void setup() फ़ंÈशन का उपयोग वǐेरएबãस को Ĥारंभ 

करने, ǒपन मोड सेट करने और लाइĦरेȣज़ शुǾ करन ेके िलए Ǒकया जाता है। 

Example :- 
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pinMode() Function 

The pinMode() function is used to configure a specific pin to 
behave either as an input or an output. 

pinMode() फ़ंÈशन का उपयोग Ǒकसी ǒपन को इनपुट या आउटपुट 

के Ǿप मɅ सेट करने के िलए Ǒकया जाता है। 

Syntax :- 

 

void loop() Function 

In Arduino, the void loop() function is a required part of every 
sketch that contains the main code. It runs repeatedly until the 
Arduino is powered off or reset. 

Arduino मɅ, void loop() फ़ंÈशन हर èकेच का आवæयक 

Ǒहèसा होता है जो तब तक चलता है जब तक Arduino बंद या 

रȣसेट नहȣं हो जाता। 

Example :- 
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digitalWrite() Function 

The digitalWrite() function is used to write a HIGH or LOW 
value to a digital pin. 
digitalWrite() फ़ंÈशन का उपयोग Ǒडǔजटल ǒपन पर HIGH या 

LOW मान िलखन ेके िलए Ǒकया जाता है। 

Syntax :- 

 

digitalRead() Function 

Reads the value from a specified digital pin, to check either 
HIGH or LOW. 

उÍच या िनàन कȧ जाँच करने के िलए िनǑद[ƴ Ǒडǔजटल ǒपन स ेमान 

पढ़ता है। 

Syntax :- 

digitalRead(pin); 
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analogRead() Function 

By using the analogRead() function, we can read the 

status of any sensor applied to one of the pins. 

analogRead() फ़ंÈशन का उपयोग करके, हम Ǒकसी सɅसर कȧ 

ǔèथित पढ़ सकते हɇ। 

Syntax :- 

analogRead(pin); 

 

delay() Function 

Pauses the program for the specified amount of time (in 
milliseconds). There are 1000 milliseconds in one second. 

ĤोĒाम को िनधा[ǐरत समय (िमलीसेकंड मɅ) के िलए रोक देता है। 

Syntax :- 

delay(ms); 

 

Communication Functions - कʄूिनकेशन 

फ़ंƕन 
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The Arduino's primary communication method allows it to 
send and receive data with a computer or other devices via a 
serial connection. 
Arduino कȧ Ĥाथिमक संचार ǒविध इसे कंÜयूटर या अÛय उपकरणɉ 

के साथ सीǐरयल कनेÈशन के माÚयम से डेटा भेजने और ĤाƯ करने 

कȧ अनुमित देती है। 

Serial Communication 

Used for communication between the Arduino board and a 
computer or other devices. All Arduino boards have at least 
one serial port (UART/USART). 

Arduino बोड[ और कंÜयूटर या अÛय उपकरणɉ के बीच संचार के 

िलए उपयोग Ǒकया जाता है। 

USART = Universal Synchronous Asynchronous Receiver 

Transmitter 

UART = Universal Asynchronous Receiver/Transmitter 

Serial.begin() Function 

Everything begins with the Serial.begin() function. This 
function in the setup() routine is executed only once, that is, 
when the Arduino is starting. 

सब कुछ Serial.begin() स ेशुǾ होता है। यह केवल एक बार 

चलता है जब Arduino शǾु होता है। 

Example :- 
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Serial.print() and Serial.println() 

Both print data to the serial port as human-readable ASCII 
text. The println() version also adds a carriage return and a 
new line. 
दोनɉ डेटा को सीǐरयल पोट[ पर ASCII टेÈèट के Ǿप मɅ ǒĤंट करते 

हɇ। println() नया लाइन जोड़ता है। 

Example :- 

 

 

Chapter 5 – Security and 

Future of IoT Ecosystem 
( IoT पाǐरǔèथितकȧ तंğ कȧ सुर¢ा और भǒवçय) 

🔹 Need of Security in IoT – Why Security? 
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 IoT मɅ सुर¢ा कȧ आवæयकता – Èयɉ ज़Ǿरȣ है सुर¢ा? 

Every connected device creates opportunities for 
attackers. These vulnerabilities are broad, even 
for a single small device. The risks include 
data transfer, device access, malfunctioning 
devices, and always-on/always-connected devices. 

हर कनेÈटेड Ǒडवाइस हमलावरɉ के िलए एक अवसर बनाता है। ये 

कमजोǐरयाँ åयापक होती हɇ, यहाँ तक Ǒक एक छोटे उपकरण के 

िलए भी। जोǔखमɉ मɅ डेटा Ěांसफर, Ǒडवाइस एÈसेस, Ǒडवाइस खराब 

होना और हमेशा चालू/कनेÈटेड रहना शािमल हɇ। 

The main challenge is the limitation of 
security in low-cost devices and the growing 
number of devices creating more attack 
opportunities. 
मÉुय चुनौती कम लागत वाले उपकरणɉ कȧ सुर¢ा सीमाएँ और 

उपकरणɉ कȧ बढ़ती संÉया है जो हमलɉ के अिधक अवसर पैदा करती 

है। 

🔹 Privacy for IoT Enabled Devices 

 IoT स¢म उपकरणɉ मɅ गोपनीयता 

1. Secure the IoT Network 
Protect the IoT network by using antivirus, 
anti-malware, firewalls, and intrusion 
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detection systems. 
IoT नेटवक[  को सुरǔ¢त रखɅ — एंटȣवायरस, एंटȣ-मालवेयर, 

फायरवॉल, और घुसपैठ रोकथाम िसèटम का उपयोग करɅ। 

2. Authenticate the IoT Devices 
Use two-factor authentication, digital 
certificates, and biometrics. 

IoT Ǒडवाइस को Ĥमाǔणत करɅ — दो-कारक Ĥमाणीकरण, 

Ǒडǔजटल Ĥमाणपğ और बायोमेǑĚÈस का उपयोग करɅ। 

3. Use IoT Data Encryption 
Encrypt data at rest and in transit using 
cryptographic algorithms. 
IoT डेटा एǔÛĐÜशन का उपयोग करɅ — ǔèथर और Ěांǔजट डेटा 

को एǔÛĐÜट करɅ। 

4. Use IoT PKI Security Methods 
Use X.509 digital certificates and 
public/private key management. 
IoT PKI सुर¢ा ǒविधयɉ का उपयोग करɅ — X.509 Ǒडǔजटल 

Ĥमाणपğ और साव[जिनक/िनजी कंुजी Ĥबंधन लागू करɅ। 

5. Use IoT Security Analytics 
Use tools that can detect IoT-specific 
attacks that traditional firewalls can’t. 
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IoT सुर¢ा एनािलǑटÈस का उपयोग करɅ — ऐसे टूãस का 

उपयोग करɅ जो IoT-ǒविशƴ हमलɉ का पता लगा सकɅ । 

6. Use IoT API Security Methods 

Secure data movement between devices 
and systems using REST-based APIs. 
IoT API सुर¢ा ǒविधयɉ का उपयोग करɅ — केवल अिधकृत 

Ǒडवाइस और ऐÜस को API तक पहँुचने दɅ। 

 

🔹 IoT Security for Consumer Devices 

 उपभोƠा उपकरणɉ के िलए IoT सुर¢ा 

IoT security requires Identification, 
Authentication, Authorization, and Monitoring. 
IoT सुर¢ा के िलए पहचान, Ĥमाणीकरण, Ĥािधकरण, और िनगरानी 

आवæयक हɇ। 

1. Identification – पहचान 
Devices must have secure identifiers like serial 
numbers. 

उपकरणɉ के पास सुरǔ¢त पहचानकता[ होने चाǑहए जसैे सीǐरयल 

नंबर। 

2. Authentication – Ĥमाणीकरण 
Establish a trusted connection between devices 
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and networks. 

उपकरण और नेटवक[  के बीच एक ǒवƳसनीय कनेÈशन èथाǒपत 

करɅ। 

3. Authorization – Ĥािधकरण 
Define what actions each device is allowed to 
perform. 

Ĥ×येक Ǒडवाइस को अनुमित ĤाƯ कायɟ को पǐरभाǒषत करɅ। 

4. Monitoring – िनगरानी 
Detect unusual data patterns to prevent 
breaches. 

असामाÛय डेटा पैटन[ कȧ पहचान करɅ और सुर¢ा उãलंघन रोकɅ । 

 

🔹 Security Levels – सुर¢ा èतर 

1. Low-Level Attack – िनàन èतर का हमला 
Attack attempt fails. 

हमला करने का Ĥयास ǒवफल हो जाता है। 

2. Medium-Level Attack – मÚयम èतर का हमला 
Attacker only listens but doesn’t change data. 

हमलावर केवल सुनता है, डेटा नहȣं बदलता। 
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3. High-Level Attack – उÍच èतर का हमला 
Attacker modifies or corrupts data. 

हमलावर डेटा मɅ बदलाव करता है या उस ेħƴ करता है। 

4. Extremely High-Level Attack – अ×यिधक उÍच 

èतर का हमला 
Unauthorized access, illegal operation, or DDoS 
attack. 

अनिधकृत Ĥवेश, अवैध काय[ या DDoS हमला। 

 චඡ Protecting IoT Devices – IoT उपकरणɉ कȧ 

सुर¢ा 

1. Keep Changing Your Password – पासवड[ बदलते रहɅ 

Regularly change passwords for all devices. 
सभी उपकरणɉ के पासवड[ समय-समय पर बदलɅ। 

2. Update Your Device – अपने उपकरण अपडेट रखɅ 

Enable automatic updates and install 
security patches. 

ऑटो अपडेट स¢म करɅ और सुर¢ा पैच इंèटॉल करɅ। 

3. Reduce Use of Cloud – Èलाउड का उपयोग कम करɅ 

Avoid unnecessary cloud storage to prevent 
hacking. 
हैǑकंग स ेबचने के िलए Èलाउड का कम उपयोग करɅ। 



DIGITAL RK COMPUTER ACADEMY 
website- www.drkca.in, drkca.com 

Address-Moazzampur Karari, Kaushambi 
Mobile no.-708076746, 6387249072,9026672774                                  

4. Use Secondary Network – अलग नेटवक[  का उपयोग करɅ 

Use a separate Wi-Fi for IoT devices. 

IoT उपकरणɉ के िलए अलग वाई-फाई नेटवक[  का उपयोग 

करɅ। 

 

🔹 Botnet – बॉटनेट 

A Botnet is a network of Internet-connected devices 
(computers, servers, mobiles, IoT) used for spam, 
fraud, or DDoS attacks. 

बॉटनेट इंटरनेट से जुड़े उपकरणɉ (कंÜयूटर, सव[र, मोबाइल, IoT) 

का समूह होता है, ǔजसका उपयोग èपैम, धोखाधड़ȣ या DDoS 

हमलɉ के िलए Ǒकया जाता है। 

The term comes from Robot + Network. 

यह शÞद Robot और Network से िमलकर बना है। 

Future in IoT Ecosystem – IoT ईकोिसèटम का 

भǒवçय 

The future of IoT has the potential to be 
limitless. The IoT is considered the future of the 
Internet. In future, the IoT will completely change 
our living styles and business models. It will allow 
people and devices to communicate anytime, 
anywhere, using any network or service. 
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IoT का भǒवçय असीिमत संभावनाओं से भरा हुआ है। इसे इंटरनेट 

का भǒवçय माना जाता है। भǒवçय मɅ IoT हमारȣ जीवनशैली और 

åयवसाय मॉडल को पूरȣ तरह बदल देगा। यह लोगɉ और उपकरणɉ 

को Ǒकसी भी समय, कहȣं भी, Ǒकसी भी नेटवक[  या सेवा का 

उपयोग करते हुए संवाद करने कȧ अनुमित देगा। 

The main goal of IoT is to create a superior 
world for human beings. 

IoT का मुÉय उƧेæय मानवɉ के िलए एक बेहतर दिुनया बनाना है। 

 

🔹 Key Advantages of Future IoT Ecosystem –  

भǒवçय के IoT पाǐरǔèथितकȧ तंğ के लाभ 

1. Artificial Intelligence will become smarter 

than ever (AI पहले से óयादा èमाट[ हो जाएगा) 
In the IoT environment, devices like smart 
lights, coffee makers, and home hubs collect 
user data and analyze habits for better 
business decisions. 

IoT वातावरण मɅ, घरेलू उपकरण जैसे लाइǑटंग िसèटम, 

कॉफȧ मेकर, èमाट[ होम हब उपयोगकता[ कȧ आदतɉ और पैटन[ 

का डेटा एकğ करते हɇ, ǔजसे बेहतर åयावसाियक िनण[यɉ के 

िलए ǒवƲेǒषत Ǒकया जाता है। 
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2. High-speed Internet will push the growth 

further (हाई-èपीड इंटरनेट ǒवकास को बढ़ावा देगा) 

Companies will launch high-speed data 
transmission technologies that will make networks 
faster and improve IoT performance. 

कंपिनयाँ हाई-èपीड डेटा Ěांसिमशन तकनीकɅ  लाएँगी, ǔजससे 

नेटवक[  और तेज़ हɉगे और IoT का Ĥदश[न बेहतर होगा। 

3. Security concerns will increase (सुर¢ा िचंताएँ 

बढ़Ʌगी) 

As the number of IoT devices increases, so 
will the risk of security and privacy issues. 

IoT उपकरणɉ कȧ संÉया बढ़ने से, सुर¢ा और गोपनीयता 

संबंधी िचंताएँ भी बढ़Ʌगी। 

4. Cities will become smarter (शहर और èमाट[ 

बनɅगे) 
IoT will enable smart cities to automate data 
collection from cameras, kiosks, and parking 
systems, saving time and money. 

IoT के माÚयम से èमाट[ शहरɉ मɅ कैमरा, पाǑकɍ ग èटेशन, 

और अÛय सɅसर से डेटा èवचािलत Ǿप से एकğ Ǒकया जा 

सकेगा। 
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🔹 Need of Powerful Core for Building Secure 

Algorithms – सुरǔ¢त एãगोǐरƬ के िनमा[ण के िलए 

शǒƠशाली कोर कȧ आवæयकता 

To protect user privacy and prevent IoT data 
breaches, encryption and key management must be 
used. 

उपयोगकता[ कȧ गोपनीयता कȧ सुर¢ा के िलए, मानक ǑĐÜटोĒाǑफक 

एãगोǐरƬ और एǔÛĐÜशन तकनीकɉ का उपयोग आवæयक है। 

Encrypt data both at rest and during transfer. 

डेटा को èटोरेज और Ěांसफर दोनɉ समय पर एǔÛĐÜट करɅ। 

 

🔹 What is Cryptography – ǑĐÜटोĒाफȧ Èया है? 

Cryptography is the technique of securing information 
through the use of codes, allowing only authorized 
persons to access it. 

ǑĐÜटोĒाफȧ एक तकनीक है ǔजसमɅ कोड का उपयोग कर सूचना को 

सुरǔ¢त बनाया जाता है, ताǑक केवल अिधकृत åयǒƠ हȣ इसे समझ 

सके। 

 

🔹 Types of Cryptography – ǑĐÜटोĒाफȧ के 

Ĥकार 
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1. Symmetric Key Cryptography – समिमत कंुजी 

ǑĐÜटोĒाफȧ 
Both sender and receiver use the same key to 
encrypt and decrypt data. 

भेजने वाला और ĤाƯकता[ दोनɉ एक हȣ कंुजी का उपयोग करते 

हɇ। 

Examples: DES (Data Encryption Standard) 
and AES (Advanced Encryption Standard). 

2. Asymmetric Key Cryptography – असमिमत कंुजी 

ǑĐÜटोĒाफȧ 
Uses two keys: a public key for encryption 
and a private key for decryption. 
Even if the public key is known, only the 
private key holder can decrypt it. 

उदाहरण: RSA (Rivest–Shamir–Adleman) Algorithm. 

🔹 Examples for New Trends – IoT मɅ नई 

तकनीकȧ Ĥवǒृƣयाँ (AI, ML Integration) 

Artificial Intelligence (AI) and Machine Learning (ML) 
are software techniques that make computers 
intelligent — they can analyze data and make 
decisions like humans. 
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AI और ML ऐसी तकनीकɅ  हɇ जो कंÜयूटर को इंसानɉ जैसी बुǒƨमƣा 

देती हɇ। 

 

🔹 Subsets of Artificial Intelligence – कृǒğम 

बǒुƨमƣा के उपसमूह 

1. Machine Learning (मशीन लिनɍग): 
Computer programs automatically learn from data 
without human help. 

कंÜयूटर ĤोĒाम èवयं सीख सकते हɇ ǒबना Ǒकसी मानव सहायता 

के। 

2. Deep Learning (डȣप लिनɍग): 
Learns from large amounts of unstructured data 
(like text, images, videos). 

बड़ȣ माğा के डेटा से सीखने कȧ ¢मता रखता है। 

3. Neural Networks (Ûयूरल नेटवक[ ): 
Computer systems inspired by the human brain; 
made up of interconnected layers called neurons. 

मानव मǔèतçक कȧ तरह काय[ करने वाले एãगोǐरƬ का समूह। 

4. Natural Language Processing (Ĥाकृितक भाषा संसाधन): 
Machines understand, interpret, and respond to 
human language. 

मशीनɅ मानव भाषा को पढ़ती और समझती हɇ। 
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5. Computer Vision (कंÜयूटर ǒवज़न): 
Computers analyze and understand images to 
make decisions. 

कंÜयूटर छǒवयɉ को पहचानने और समझने मɅ स¢म होते हɇ। 

 

🔹 Machine Learning (ML) – मशीन लिनɍग 

Machine Learning is a subset of AI that allows 
systems to improve automatically through data and 
experience. 

मशीन लिनɍग AI कȧ शाखा है जो िसèटम को डेटा और अनुभव से 

खुद सीखने मɅ स¢म बनाती है। 
It builds models using training data to make 
predictions or decisions. 

यह Ĥिश¢ण डेटा के आधार पर भǒवçयवाǔणयाँ और िनण[य लतेी है। 

The term Machine Learning was coined in 1959 by 
Arthur Samuel (IBM). 

 मशीन लिनɍग” शÞद कȧ शुǽआत 1959 मɅ आथ[र सैमुअल (IBM) 

ने कȧ थी। 

 

🔹 Difference between AI and ML – AI और मशीन 

लिनɍग मɅ अंतर 
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Artificial Intelligence 
(AI) 

Machine Learning 
(ML) 

Enables a machine to 
simulate human behavior. 

Allows a machine to learn 
from data automatically. 

एआई मशीन को मानव åयवहार कȧ 

नकल करने कȧ ¢मता देता है। 

एमएल मशीन को डेटा से èवतः 

सीखने कȧ ¢मता देता है। 

Goal: Build smart systems 
like humans. 

Goal: Learn from data to 
produce accurate results. 

उƧेæय: इंसानɉ जैसी èमाट[ िसèटम 

बनाना। 

उƧेæय: डेटा से सीखकर सटȣक 

पǐरणाम देना। 

AI performs any human-like 
task. 

ML performs specific tasks 
through training. 

एआई Ǒकसी भी इंसानी काय[ को कर 

सकता है। 

एमएल ǒवशेष कायɟ के िलए 

Ĥिशǔ¢त होता है। 

Includes ML and Deep 
Learning. 

Deep Learning is a part 
of ML. 

एआई मɅ एमएल और डȣप लिनɍग दोनɉ 

शािमल हɇ। 
डȣप लिनɍग एमएल का उपभाग है। 

Broad scope and applications. 
Limited scope compared to 
AI. 
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Artificial Intelligence 
(AI) 

Machine Learning 
(ML) 

एआई का दायरा बहुत åयापक है। एमएल का दायरा सीिमत है। 

Examples: Siri, Alexa, chatbots, 
expert systems, humanoid 
robots. 

Examples: Google search, 
recommender systems, 
Facebook tagging. 

 

 

 


